PeopleSoft HCM 9.2: Payroll Interface

April 2021
## Contents

### Preface: Preface
- Understanding the PeopleSoft Online Help and PeopleBooks
- Hosted PeopleSoft Online Help
- Locally Installed Help
- Downloadable PeopleBook PDF Files
- Common Help Documentation
- Field and Control Definitions
- Typographical Conventions
- ISO Country and Currency Codes
- Region and Industry Identifiers
- Translations and Embedded Help
- Using and Managing the PeopleSoft Online Help
- Related Links for PeopleSoft HCM
- Follow Us

### Chapter 1: Getting Started with PeopleSoft Payroll Interface
- PeopleSoft Payroll Interface Overview
- PeopleSoft Payroll Interface Business Processes
- PeopleSoft Payroll Interface Integrations
- PeopleSoft Payroll Interface Implementation

### Chapter 2: Understanding PeopleSoft Payroll Interface
- Interface Definitions
- Data Exchanges
- Sample Data Definitions
- Implementation Steps
- Implementation Tasks
  - Preliminary Tasks
  - Implementation Team
  - Gap/Fit Analysis

### Chapter 3: Understanding PeopleSoft Payroll Interface Processing
- Deduction Processing
- Calculate Deductions Process Flow
- DED_LINE and DED_CALC Tables
- Deduction Processing and Multiple Jobs
- Export Processing
  - Export Process Flow
  - Export Process Details
  - PI_PARTIC and PI_PARTIC_EXPT Tables
  - PI_EXTIO and PI_PARTIC_EXTBL Tables
  - Export Processing and Multiple Jobs
- Import Processing
  - Import Process Flow
  - Import Tables
  - Export and Import Testing
  - Testing Exports and Imports
  - Successful Exports
### Contents

Unsuccessful Exports.................................................................................................................. 45
Detecting Errors........................................................................................................................ 46
Table Management.................................................................................................................. 48

**Chapter 4: Setting Up Earnings Data** ................................................................................. 53

Understanding Earnings.......................................................................................................... 53
Setting Up Earnings Codes and Earnings Programs................................................................. 53
  Pages Used to Set Up Earnings Codes and Earnings Programs........................................ 53
Understanding Earnings Codes and Earnings Programs......................................................... 54
Earnings Table - General Page................................................................................................. 54
Earnings Program Table Page................................................................................................. 54
Setting Up and Maintaining Additional Pay.......................................................................... 55
  Page Used to Set Up and Maintain Additional Pay............................................................ 55
Understanding Additional Pay............................................................................................... 55
Additional Pay Page............................................................................................................... 55

**Chapter 5: Setting Up Deduction Data** ............................................................................. 59

Understanding Deductions...................................................................................................... 59
Setting Up the Deduction Table.............................................................................................. 59
  Pages Used to Set Up the Deduction Table....................................................................... 59
Understanding the Deduction Table...................................................................................... 59
Deduction Table - Setup Page................................................................................................. 60
Deduction Table - Tax Class Page......................................................................................... 61
Deduction Table - Process Page............................................................................................ 63
Deduction Table - Schedule Page......................................................................................... 64
Viewing Benefit Deductions.................................................................................................... 65
  Pages Used to View Benefit Deductions.......................................................................... 65
Understanding Benefit Deductions....................................................................................... 65
Benefit Program Page............................................................................................................ 66
Assign to Benefit Program Page............................................................................................. 66
Setting Up and Maintaining General Deductions................................................................. 67
  Pages Used to Set Up and Maintain General Deductions.................................................. 67
Understanding General Deductions..................................................................................... 68
Deduction Table - Setup Page................................................................................................. 68
General Deduction Table Page.............................................................................................. 69
General Deduction Page........................................................................................................ 71
Overriding General Deductions Page.................................................................................... 72

**Chapter 6: Setting Up Tax Data** ......................................................................................... 73

Understanding Tax Data.......................................................................................................... 73
Setting Up Tax Location Data................................................................................................. 74
(CAN) (USA) Setting Up Company Tax Data........................................................................ 74
(CAN) (USA) Setting Up and Maintaining Tax Distribution Data.......................................... 74
  Pages Used to Set Up and Maintain Tax Distribution Data (USA and CAN)........................ 74
Update Tax Distribution Page................................................................................................. 75
Update Tax Distribution Page................................................................................................. 75
(USA) Setting Up and Maintaining U.S. Employee Tax Data............................................... 76
  Pages Used to Set Up and Maintain U.S. Employee Tax Data............................................. 76
Federal Tax Data Page........................................................................................................... 76
State Tax Data Page............................................................................................................... 82
Local Tax Data Page.............................................................................................................. 88
(CAN) Setting Up and Maintaining Canadian Employee Tax Data...................................... 90
  Pages Used to Set Up and Maintain Canadian Employee Tax Data.................................... 90
Canadian Income Tax Data Page........................................................................................... 90
Preface

Understanding the PeopleSoft Online Help and PeopleBooks

The PeopleSoft Online Help is a website that enables you to view all help content for PeopleSoft applications and PeopleTools. The help provides standard navigation and full-text searching, as well as context-sensitive online help for PeopleSoft users.

Hosted PeopleSoft Online Help

You can access the hosted PeopleSoft Online Help on the Oracle Help Center. The hosted PeopleSoft Online Help is updated on a regular schedule, ensuring that you have access to the most current documentation. This reduces the need to view separate documentation posts for application maintenance on My Oracle Support. The hosted PeopleSoft Online Help is available in English only.

To configure the context-sensitive help for your PeopleSoft applications to use the Oracle Help Center, see Configuring Context-Sensitive Help Using the Hosted Online Help Website.

Locally Installed Help

If you're setting up an on-premise PeopleSoft environment, and your organization has firewall restrictions that prevent you from using the hosted PeopleSoft Online Help, you can install the online help locally. See Configuring Context-Sensitive Help Using a Locally Installed Online Help Website.

Downloadable PeopleBook PDF Files

You can access downloadable PDF versions of the help content in the traditional PeopleBook format on the Oracle Help Center. The content in the PeopleBook PDFs is the same as the content in the PeopleSoft Online Help, but it has a different structure and it does not include the interactive navigation features that are available in the online help.

Common Help Documentation

Common help documentation contains information that applies to multiple applications. The two main types of common help are:

• Application Fundamentals
• Using PeopleSoft Applications

Most product families provide a set of application fundamentals help topics that discuss essential information about the setup and design of your system. This information applies to many or all applications in the PeopleSoft product family. Whether you are implementing a single application, some combination of applications within the product family, or the entire product family, you should be familiar with the contents of the appropriate application fundamentals help. They provide the starting points for fundamental implementation tasks.
In addition, the *PeopleTools: Applications User's Guide* introduces you to the various elements of the PeopleSoft Pure Internet Architecture. It also explains how to use the navigational hierarchy, components, and pages to perform basic functions as you navigate through the system. While your application or implementation may differ, the topics in this user’s guide provide general information about using PeopleSoft applications.

**Field and Control Definitions**

PeopleSoft documentation includes definitions for most fields and controls that appear on application pages. These definitions describe how to use a field or control, where populated values come from, the effects of selecting certain values, and so on. If a field or control is not defined, then it either requires no additional explanation or is documented in a common elements section earlier in the documentation. For example, the Date field rarely requires additional explanation and may not be defined in the documentation for some pages.

**Typographical Conventions**

The following table describes the typographical conventions that are used in the online help.

<table>
<thead>
<tr>
<th>Typographical Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key+Key</td>
<td>Indicates a key combination action. For example, a plus sign (+) between keys means that you must hold down the first key while you press the second key. For Alt+W, hold down the Alt key while you press the W key.</td>
</tr>
<tr>
<td>. . . (ellipses)</td>
<td>Indicate that the preceding item or series can be repeated any number of times in PeopleCode syntax.</td>
</tr>
<tr>
<td>{ } (curly braces)</td>
<td>Indicate a choice between two options in PeopleCode syntax. Options are separated by a pipe (</td>
</tr>
<tr>
<td>[ ] (square brackets)</td>
<td>Indicate optional items in PeopleCode syntax.</td>
</tr>
<tr>
<td>&amp; (ampersand)</td>
<td>When placed before a parameter in PeopleCode syntax, an ampersand indicates that the parameter is an already instantiated object. Ampersands also precede all PeopleCode variables.</td>
</tr>
<tr>
<td>⇒</td>
<td>This continuation character has been inserted at the end of a line of code that has been wrapped at the page margin. The code should be viewed or entered as a single, continuous line of code without the continuation character.</td>
</tr>
</tbody>
</table>

**ISO Country and Currency Codes**

PeopleSoft Online Help topics use International Organization for Standardization (ISO) country and currency codes to identify country-specific information and monetary amounts.

ISO country codes may appear as country identifiers, and ISO currency codes may appear as currency identifiers in your PeopleSoft documentation. Reference to an ISO country code in your documentation
does not imply that your application includes every ISO country code. The following example is a country-specific heading: "(FRA) Hiring an Employee."

The PeopleSoft Currency Code table (CURRENCY_CD_TBL) contains sample currency code data. The Currency Code table is based on ISO Standard 4217, "Codes for the representation of currencies," and also relies on ISO country codes in the Country table (COUNTRY_TBL). The navigation to the pages where you maintain currency code and country information depends on which PeopleSoft applications you are using. To access the pages for maintaining the Currency Code and Country tables, consult the online help for your applications for more information.

Region and Industry Identifiers

Information that applies only to a specific region or industry is preceded by a standard identifier in parentheses. This identifier typically appears at the beginning of a section heading, but it may also appear at the beginning of a note or other text.

Example of a region-specific heading: "(Latin America) Setting Up Depreciation"

Region Identifiers

Regions are identified by the region name. The following region identifiers may appear in the PeopleSoft Online Help:

- Asia Pacific
- Europe
- Latin America
- North America

Industry Identifiers

Industries are identified by the industry name or by an abbreviation for that industry. The following industry identifiers may appear in the PeopleSoft Online Help:

- USF (U.S. Federal)
- E&G (Education and Government)

Translations and Embedded Help

PeopleSoft 9.2 software applications include translated embedded help. With the 9.2 release, PeopleSoft aligns with the other Oracle applications by focusing our translation efforts on embedded help. We are not planning to translate our traditional online help and PeopleBooks documentation. Instead we offer very direct translated help at crucial spots within our application through our embedded help widgets. Additionally, we have a one-to-one mapping of application and help translations, meaning that the software and embedded help translation footprint is identical—something we were never able to accomplish in the past.
Using and Managing the PeopleSoft Online Help

Select About This Help in the left navigation panel on any page in the PeopleSoft Online Help to see information on the following topics:

- Using the PeopleSoft Online Help
- Managing Hosted online help
- Managing locally installed PeopleSoft Online Help

Related Links for PeopleSoft HCM

Oracle Help Center

PeopleSoft Information Portal

My Oracle Support

PeopleSoft Training from Oracle University

PeopleSoft Video Feature Overviews on YouTube

PeopleSoft Business Process Maps (Microsoft Visio format)

PeopleSoft Spotlight Series

Contact Us

Send your suggestions to psoft-infodev_us@oracle.com. Please include the applications update image or PeopleTools release that you’re using.

Follow Us

YouTube

Twitter@PeopleSoft_Info.

PeopleSoft Blogs

LinkedIn
PeopleSoft Payroll Interface Overview

PeopleSoft Payroll Interface is a table-driven, generic export and import engine that enables you to exchange data between PeopleSoft HCM and a third-party payroll system. With Payroll Interface you maintain employee data in PeopleSoft HCM while using the third-party payroll system to perform the payroll processing functions. Data is exchanged between the two systems using the Payroll Interface Export and Import processes.

This diagram illustrates PeopleSoft Payroll Interface:

**Image: Payroll Interface**

This diagram illustrates PeopleSoft Payroll Interface.

PeopleSoft Payroll Interface Business Processes

PeopleSoft Payroll Interface provides these business processes:

- Maintain payroll data.
- Run (calculate and confirm) deductions.
- Run exports and imports (exchange data).

We discuss these business processes in the business process topics in this product documentation.

PeopleSoft Payroll Interface Integrations

PeopleSoft Payroll Interface integrates with these PeopleSoft applications:
**Image: Payroll Interface integrations**

This diagram illustrates the PeopleSoft applications with which Payroll Interface integrates.

![Diagram of PeopleSoft applications integrating with Payroll Interface](image)

We discuss integration considerations in the implementation topics in this product documentation.

Supplemental information about third-party application integrations is located on the My Oracle Support website.

---

**PeopleSoft Payroll Interface Implementation**

PeopleSoft Setup Manager enables you to generate a list of setup tasks for your organization based on the features that you are implementing. The setup tasks include the components that you must set up, listed in the order in which you must enter data into the component tables, and links to the corresponding product documentation.

**Other Sources of Information**

In the planning phase of your implementation, take advantage of all PeopleSoft sources of information, including the installation documentation, table-loading sequences, data models, and business process maps.

Refer to the *PeopleSoft HCM 9.2 - Reorganization of Component Interface Permissions* (Doc ID 2342162.1) MOS posting for a list of system-delivered CIs and their usage, the mapping of CIs and associated permission lists, and the mapping of CI permission lists and user roles.

See:

- Application Fundamentals
- *PeopleTools: Setup Manager*
Chapter 2

Understanding PeopleSoft Payroll Interface

Interface Definitions

Payroll Interface is a table-driven export and import engine that enables you to exchange data between PeopleSoft HCM and a third-party payroll system. Data exchanges are set up through the export and import interface definitions, which enable you to download data from or upload data to database tables:

- The export interface definition retrieves, formats, and downloads payroll-related data from various PeopleSoft HCM tables. The Export process writes the data to either a flat file or a database table.

- The import interface definition uploads the processed payroll results into seven Payroll Interface import tables located in PeopleSoft HCM. The Import process reads data only from ASCII files.

Export Interface Definition

The export interface definition includes the payroll setup and the interface definition. The payroll setup identifies the payroll-related data (earnings, deductions, taxes, and so forth) and determines the pay schedules (the pay groups and pay calendars that determine which employees are processed during the export run). The interface definition determines the data mapping between the PeopleSoft HCM system and the third-party payroll system, defines the SQL retrievals and any additional COBOL processing, and specifies the export file format.

This diagram illustrates the export framework:
Import Interface Definition

The import interface definition is simpler—and more limited—than the export interface definition. The interface definition is set up such that the Import process can locate the import file and then load the processed payroll data into the seven Payroll Interface import tables. You do not need to set up any type of scheduling; the Import process can be run as soon as the import file is made available.

Note: The Import process does not perform data auditing or reverse translations. Depending on your implementation, you may want to write a custom Structured Query Report (SQR) program that performs these functions as well as loads the data into the seven import tables.

This diagram illustrates the import framework:
Data Exchanges

Payroll Interface enables you to maintain employee data in PeopleSoft HCM while using the third-party payroll system to perform the payroll processing functions. With Payroll Interface, data exchanges between the two systems are performed in four phases:

1. (Optional) Run the Calculate Deductions and Deduction Confirmation processes to calculate and confirm pay period deductions.

2. Run the Export process to retrieve and write the pay (and deduction) data from PeopleSoft HCM to an export file or table.

3. Make the export file or table available to the third-party payroll vendor. The third-party vendor uses the appropriate software solution to load the data into the third-party payroll system, to perform the payroll processing functions, and to write the processed payroll results to one or more import files.

4. (Optional) Run the Import process to read the import file and load the processed payroll data back into PeopleSoft HCM.

This diagram illustrates the Payroll Interface Deduction, Export, and Import processes:
This diagram illustrates the Payroll Interface Deduction, Export, and Import processes.

**Deduction Process**

You have the option of maintaining employee deduction information in PeopleSoft HCM using the PeopleSoft HR Manage Base Benefits business process. If you maintain deductions, you must run the Calculate Deductions and Deduction Confirmation processes before you run the Export process. The deduction processes calculate and confirm per pay period benefit and general deduction amounts.

*Note:* If you do not maintain deductions (that is, if the third-party payroll system manages all deduction information) then you do not need to run the Calculate Deductions or Deduction Confirmation processes.

**Export Process**

The Export process exports employee-level personal, job, salary, deduction, and tax information that the third-party payroll system needs to produce paychecks each pay period. Payroll Interface can export data from any PeopleSoft HCM table that includes the PeopleSoft EmplID field as a key field. Data is exported to either a flat file or a database table.

Payroll Interface does not perform any payroll calculations. The third-party payroll system performs the tax calculations, earnings calculations, gross-to-net calculations, and year-end processing. You use Payroll Interface to track and export changes that occur, during a pay period, to static employee payroll-related data. The data is considered static because it rarely changes, for example, a person's job code, pay rate, tax status, number of dependents, or benefit plan (which can be changed only during an open enrollment period).
Warning! Payroll Interface is designed to export changes to static employee payroll-related data; for example, job codes, benefit deductions, or wages - information that does not change that often during the course of a year. Dynamic or transactional pay data, such as monthly commission payments or time and labor calculations, must be set up and maintained by the third-party payroll system.

Import Process

You have the option of importing the payroll results produced by the third-party payroll system back into PeopleSoft HCM. The Import process loads payroll check, earnings, deduction, and tax data into seven Payroll Interface import tables. Once loaded, the data can be viewed online or by running reports. Data is imported only from ASCII files.

Note: Further processing or technical configuration may be required to check the validity of the imported data or to ensure that the data can be accessed in a secure manner.

Sample Data Definitions

PeopleSoft delivers sample data definitions for use with Payroll Interface. You can often more easily begin an implementation by cloning (copying) one of the sample data definitions.

The export sample data definitions are logical (LOG), physical (PHY), comma-separated value (CSV), and National Finance Center (NFC) for the federal government. The import sample data definitions are check detail (DETI) and check balance (BALI). Corresponding system IDs, configuration IDs, and file IDs are set up for most of these definitions.

Warning! Do not assume that the sample data is complete or that it will function in a production environment without further modification.

Related Links

Cloning an Interface Definition
Working with Interface Definitions

Implementation Steps

To set up, test, and install a payroll interface, follow these steps. As you perform the tasks outlined here, document everything; this will help you to troubleshoot any problems that arise.

<table>
<thead>
<tr>
<th>Step</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Assemble an implementation team and perform the gap/fit analysis.</td>
<td>See Implementation Tasks.</td>
</tr>
<tr>
<td>2. Set up the PeopleSoft HCM core and foundation table components.</td>
<td>See Application Fundamentals</td>
</tr>
<tr>
<td><strong>Step</strong></td>
<td><strong>Tasks</strong></td>
</tr>
<tr>
<td>----------</td>
<td>-----------</td>
</tr>
<tr>
<td>3. (optional) Set up PeopleSoft HR Manage Base Benefits.</td>
<td>See PeopleSoft Human Resources Manage Base Benefits.</td>
</tr>
<tr>
<td><strong>Note:</strong> Perform this step only if you maintain benefit deductions.</td>
<td></td>
</tr>
<tr>
<td>4. Set up export (or import) interface.</td>
<td>Perform these tasks:</td>
</tr>
<tr>
<td><strong>Note:</strong> The import interface is usually set up and tested after you have set up and tested the export interface.</td>
<td>• Set up the payroll data and schedules.</td>
</tr>
<tr>
<td></td>
<td>See: Understanding Earnings, Understanding Deductions, Understanding Tax Data, Understanding Payroll Schedules.</td>
</tr>
<tr>
<td></td>
<td>• (optional) Clone an existing interface definition.</td>
</tr>
<tr>
<td></td>
<td>See Understanding the Cloning Process.</td>
</tr>
<tr>
<td></td>
<td>• Set up the export (or import) interface definition.</td>
</tr>
<tr>
<td></td>
<td>See: Understanding the Control Tables, Working with Interface Definitions.</td>
</tr>
<tr>
<td>5. Test the export (or import) interface.</td>
<td>Using the sample data or a copy of the live system, perform these tasks:</td>
</tr>
<tr>
<td></td>
<td>• (optional) Run the Calculate Deductions and Deduction Confirmation processes until error free.</td>
</tr>
<tr>
<td></td>
<td>See Understanding Deduction Processing.</td>
</tr>
<tr>
<td></td>
<td>• Run the Export (or Import) process until error free.</td>
</tr>
<tr>
<td></td>
<td>See Understanding Data Exchanges.</td>
</tr>
<tr>
<td>6. Install the export (or import) interface.</td>
<td>Using the live system:</td>
</tr>
<tr>
<td></td>
<td>• Install the export (or import) interface.</td>
</tr>
<tr>
<td></td>
<td>• Run the Calculate Deductions and Deduction Confirmation processes, the Export process, and the Import process (whichever apply).</td>
</tr>
<tr>
<td></td>
<td>• Train users to set up and maintain payroll data.</td>
</tr>
<tr>
<td></td>
<td>• Train users to run the Calculate Deductions and Confirmation processes, the Export process, or the Import process (which ever apply).</td>
</tr>
</tbody>
</table>
Implementation Tasks

This topic discusses:

- Preliminary tasks.
- Implementation team.
- Gap/fit analysis.

Preliminary Tasks

Implementing a payroll interface requires a thorough understanding of PeopleSoft HCM and the requirements of the third-party payroll system. To ensure a smooth implementation, you should:

- Secure full executive sponsorship.
  
  You need cooperation from multiple departments, such as payroll, human resources, finance, and information services.

- Set aside sufficient time and resources.
  
  Implementing a payroll interface requires design, planning, development, implementation, and testing. While strong project management is especially critical for global implementations with multiple companies, all implementations require a firm hand with scheduling and details.

- Attend Payroll Interface training.

  Implementing a payroll interface requires both functional and technical expertise. Practice first by using the delivered sample data to understand how Payroll Interface works. Then, create your own definitions and output file using the delivered demo data as the model. Finally, copy a "live" database — don't use the actual live database — from your organization. Configure it and test run the Payroll Interface Calculate Deductions and Confirmation processes and the Export and Import processes using your organization's actual data.

- Apply any software updates or fixes.

  Contact My Oracle Support for any applicable patches that have been posted since the general release.

- Obtain the vendor documentation.

  Obtain a complete set of documentation from the third-party payroll vendor. The payroll interface that you set up is based on the data, formatting, and processing requirements of the third-party payroll system.

Implementation Team

Recommended team members for a payroll interface implementation include:

- Payroll interface lead.
The lead is responsible for the payroll interface setup and configuration, and for the initial export/import of data. The lead must understand Payroll Interface as well as the third-party payroll system. Keep the backup lead informed during the entire implementation process.

- Payroll functional lead.
  The lead is the recipient of the exported payroll data file. The lead should know about payroll codes, employee payroll data, and the steps involved in processing payroll. The lead needs to understand the third-party payroll system capabilities, if not its technical details.

- Database administrator (DBA) technical lead.
  The lead manages PeopleSoft table maintenance, technical configurations, SQL, PeopleTools, the Application Engine, COBOL, and PeopleCode.

- HCM functional lead.
  The lead must understand PeopleSoft HCM data and the transactions and business processes involving a payroll interface, including benefits and deduction calculations.

- HCM project lead.
  The lead manages a payroll interface implementation and ongoing maintenance. Sometimes another team member takes on these duties.

**Gap/Fit Analysis**

The gap/fit analysis is the most important step in the implementation process. This is where you identify exactly what needs to be set up in the export interface definition (and to a lesser extent, the import interface definition).

**Conduct a Functional Analysis**

Analyze your functional requirements:

- Establish data ownership.
  Establish who owns the data, typically either the human resources or the payroll department.

- Identify business processes, transactions, and data flow.
  Create a flow chart that shows data movement in different situations, such as for new hires, transfers, and pay rate changes.

- Determine common data elements.
  Determine common elements and relationships between the existing employee data and the requirements of the third-party application. Identify field mapping and translation requirements.

**Conduct a Technical Analysis**

Analyze your technical requirements:

- Identify the PeopleSoft tables and fields.
Identify the tables and fields containing employee-level payroll-related data to be exported. Depending on the data requirements of the third-party payroll system, you may need to create additional views.

- Identify the third-party payroll system fields.

  Identify the third-party payroll system fields that will receive the data that is exported from PeopleSoft HCM. Understand the third-party payroll system import specifications. Refer to the vendor documentation or use the third-party payroll system's technical support for assistance.

- Identify data gaps.

  Identify and isolate any gaps between PeopleSoft HCM and the third-party payroll system. Isolate requirements as early as possible. Any gaps will have to be bridged using special processes, routines, calculations, or conditional logic.

**Obtain the Vendor Documentation**

It is critical that you obtain the vendor documentation for the third-party payroll system. The vendor documentation contains the requirements for the third-party payroll system and will guide you in setting up the export or import interface definition.

Work with the third-party vendor to answer the following types of questions:

- What file format is required for import (for example, comma-delimited or a physical sequence)? Is there a choice on the type of fields exported? Which type of file is recommended for personal data?

- What's the required file layout? For example, should there be a header record using field names or field name codes followed by the value? Also, should there be a trailer record?

- Can you accept a flat file of employee data each pay period? (That is, a full export instead of just changes.)

- What are file naming conventions? Where should export files be placed?

- Do earnings and personal data need to be in separate files?

- Are any fields effective-dated?

- What is the unique key field or combination of fields that identifies an employee? For example, payroll ID or national ID (SSN).

- What fields are mandatory? Are fields different for new hires or changes to existing data? Do any fields need to be paired or grouped together?

- What is the maximum number of fields per output record?

- Can new hires and changes be in the same file?

- Are there user-defined lists, such as cost center lists, that have to be pre-loaded with PeopleSoft HCM values? (For each user-defined list, you need the third-party payroll provider's values to set up correct data mappings.)

- Are there reports that validate the payroll interface export file, for example, a report that identifies changes to the system?
• Who prepares the export file from the third-party payroll system?

• How do you set up a test database with the third-party payroll software? (You should run test imports into the third-party system, but you do not want to touch the production database.)

**Perform the Data Mapping**

Data mapping between PeopleSoft HCM and the third-party payroll system is a vital implementation step. Base your data mapping on the information gathered during the functional and technical analyses. Data mapping requires two considerations:

• PeopleSoft field locations must match up with third-party payroll system field locations.

  For example, if your third-party payroll system receives data for hire status in the 30th position of a physical export file, then you must configure Payroll Interface to place this data in the 30th position of your export file.

• Data values must be translated accurately.

  For example, the hire-status value for active employees is maintained in PeopleSoft HCM as *Active*. In the third-party payroll system, the same data might be maintained using the value *A*. To map the PeopleSoft data to the third-party payroll system, you would need to construct your file export process to write a value of *A* to the export file every time it sees a value of *Active* in the PeopleSoft data (because the value of *Active* means nothing to the third-party payroll system).

To map values between PeopleSoft HCM and the third-party payroll system, use translate values. See **Setting Up the Field Definition Table**.

---

**Note: (USF) Every effort is made to ensue that the National Finance Center (NFC) sample data that is delivered with Payroll Interface conforms to NFC requirements. However, you should always check the data mapping in the delivered export configuration for accuracy.**

This graphic shows a spreadsheet you can use as a starting point to facilitate data mapping:
Chapter 2 Understanding PeopleSoft Payroll Interface

Image: Spreadsheet to facilitate data mapping

This graphic shows a spreadsheet you can use as a starting point to facilitate data mapping.

<table>
<thead>
<tr>
<th>Spreadsheet Column Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Third-party field name</td>
</tr>
<tr>
<td>Third-party field values</td>
</tr>
<tr>
<td>Third-party field format</td>
</tr>
<tr>
<td>Payroll Interface field name</td>
</tr>
<tr>
<td>Length</td>
</tr>
<tr>
<td>Description</td>
</tr>
<tr>
<td>PeopleSoft record (table) field name</td>
</tr>
<tr>
<td>PeopleSoft/Third-party translate values</td>
</tr>
<tr>
<td>Payroll Interface field format</td>
</tr>
<tr>
<td>Comments</td>
</tr>
<tr>
<td>Third-party requirements</td>
</tr>
</tbody>
</table>

Note: Use the Payroll Interface field name to set up the interface file definition when you define the export/import file layouts.

Assess Employee Actions

Payroll Interface uses the PeopleSoft employee ID (EmpIID) to track and export changes that occur to employee payroll-related data. The PeopleSoft employee ID must be mapped to the third-party payroll system employee ID. Analyze your human resources, benefits, and payroll transactions; make sure you understand the relationships between these transactions and the requirements of the third-party payroll system.

This table lists the types of questions to ask during the analysis:

<table>
<thead>
<tr>
<th>Action</th>
<th>Questions</th>
</tr>
</thead>
</table>
| Hires  | • What ID do you use for payroll?
<p>|        | • How do you assign employee IDs? |
|        | • How does the payroll system identify new hires? |
|        | • Are there special requirements for a new-hire transaction? |
|        | • What are the minimum required data fields? |</p>
<table>
<thead>
<tr>
<th>Action</th>
<th>Questions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rehires</td>
<td>• How are rehires processed?</td>
</tr>
<tr>
<td></td>
<td>• Is the same payroll ID used over and over again?</td>
</tr>
<tr>
<td></td>
<td>• How does the payroll system set up a rehire? Are preexisting or new IDs used?</td>
</tr>
<tr>
<td></td>
<td>• What impact might existing rehire procedures have on Payroll Interface?</td>
</tr>
<tr>
<td>Terminations</td>
<td>• How does the payroll system handle terminations?</td>
</tr>
<tr>
<td></td>
<td>• Do you need to send over a special code?</td>
</tr>
<tr>
<td></td>
<td>• Do you need to zero out compensation values?</td>
</tr>
<tr>
<td></td>
<td>• Do you need to zero out date fields? Do you need to send any stop transactions?</td>
</tr>
<tr>
<td>Employee ID Changes</td>
<td>Do you need a procedure to translate the third-party payroll system employee ID to the PeopleSoft EmplID?</td>
</tr>
</tbody>
</table>
Chapter 3

Understanding PeopleSoft Payroll Interface Processing

Deduction Processing

This topic discusses:

- Calculate Deductions process flow.
- DED_LINE and DED_CALC tables.
- Deduction processing and multiple jobs.

Calculate Deductions Process Flow

This diagram illustrates the Calculate Deductions process flow:

Image: Payroll Interface Calculate Deductions process flow

This diagram illustrates the Calculate Deductions process flow.

Deduction processing occurs in the following way:

1. To start the Calculate Deductions process, enter a pay run ID and other parameters using the Calculate Deductions (RUNCTL_DED_CALC) component, Calculate Deductions page.
2. PSPDCRUN reads the pay run ID and calls PSPDCCAL.
3. PSPDCCAL calls the COBOL routines required to process deductions.
4. PSPDCCAL calls PSPDCEMP, which in turn creates the CHECK array.
5. PSPDCCAL calls PSPDARRY, which in turn creates the DARRY array.
6. PSPDCCAL calls PSPUPDED, which populates the DED_LINE and DED_CALC tables.

**PSPDCCAL calls PSPDCEMP**

The PSPDCEMP COBOL routine:
- Selects the jobs and benefit programs to be processed by PSPDARRY.
- Stores the EMPL_RCD and BEN_RCD that might exist for the EMPLID in the CHECK array.

**PSPDCCAL calls PSPDARRY**

The PSPDARRY COBOL routine:
- Uses the CHECK array to select and calculate the deduction values that should be taken from an employee's check.
- Stores the calculated deduction values in the DARRY array.

**PSPDCCAL calls PSPUPDED**

The PSPUPDED COBOL routine writes the results of the Calculate Deductions process to the DED_LINE and DED_CALC tables.

---

**Note:** The EMPLID/EMPL_RCD key field combinations for an employee are determined using the CHECK and DARRY arrays.

---

**DED_LINE and DED_CALC Tables**

Payroll Interface stores the results of the Calculate Deductions and Deduction Confirmation processes in three tables: DED_CALC, DED_LINE, and DED_MESSAGE.

This diagram illustrates the parent-child relationship between the DED_LINE and DED_CALC tables:

**Image:** Parent-child relationship between the DED_LINE and DED_CALC tables

This diagram illustrates the parent-child relationship between the DED_LINE and DED_CALC tables.
DED_LINE Table
The DED_LINE table stores the EMPLID and EMPL_RCD key fields that are required to identify and process an employee. The value of the PAY_LINE_STATUS field indicates whether the process finished successfully or failed. You can view the results using the Review Deductions (DED_CALCULATIONS) component.

Possible PAY_LINE_STATUS values are:
- Calculated (C): Deductions were calculated; no errors occurred
- Confirmed (F): Deductions were confirmed; no errors occurred.
- Error (E): An error occurred.
- Updated by user (U): An error occurred.
- Pay in progress (P): An error occurred.

DED_CALC Table
The DED_CALC table stores the EMPLID and EMPL_RCD key fields that are required to identify an employee as well as the results of the Calculate Deductions process, including the deduction codes and amounts for each. You can view results using the Review Deductions component.

DED_MESSAGE Table
The DED_MESSAGE table stores the EMPLID and EMPL_RCD key fields that are required to identify an employee and is populated only if an error occurs during the Calculate Deductions or Deduction Confirmation process. You can view the error messages using the Review Error Messages (DED_MESSAGE) component.

Deduction Processing and Multiple Jobs
To calculate deductions for an employee with multiple jobs, the following criteria is used:
- An employee with multiple jobs can have different benefit programs for each job.
- If an employee has multiple jobs, some of which use the same benefit program, one of the jobs must be selected as the primary job.
- If an employee has multiple jobs, all of which use different benefit programs, each job is selected as the primary job.
- Deductions are calculated only for primary jobs.

This table shows possible job and benefit program combinations for three employees:

<table>
<thead>
<tr>
<th>EMPLID</th>
<th>EMPL_RCD</th>
<th>Benefit Program</th>
<th>Benefit Record Number</th>
<th>Primary Benefit Job</th>
</tr>
</thead>
<tbody>
<tr>
<td>8412</td>
<td>0</td>
<td>BAS</td>
<td>0</td>
<td>Y</td>
</tr>
<tr>
<td>8412</td>
<td>1</td>
<td>FLX</td>
<td>1</td>
<td>Y</td>
</tr>
</tbody>
</table>
Benefit deductions use key fields EMPLID and EMPL_RCD. General deductions use key fields EMPLID and COMPANY (but not EMPL_RCD). Because the key fields are not the same, benefit deductions and general deductions are processed differently. The following tables show the deduction results for the employee whose EMPLID is 8421.

**CHECK Array:**

<table>
<thead>
<tr>
<th>EMPLID</th>
<th>Benefit Program</th>
<th>BEN_RCD</th>
</tr>
</thead>
<tbody>
<tr>
<td>8421</td>
<td>BAS</td>
<td>0</td>
</tr>
<tr>
<td>8421</td>
<td>FLX</td>
<td>1</td>
</tr>
</tbody>
</table>

**DARRY Array:**

<table>
<thead>
<tr>
<th>Benefit Plan</th>
<th>Benefit Program</th>
<th>BEN_RCD</th>
</tr>
</thead>
<tbody>
<tr>
<td>20 Life</td>
<td>BAS</td>
<td>0</td>
</tr>
<tr>
<td>00 (general)</td>
<td>none</td>
<td>999</td>
</tr>
<tr>
<td>20 LifeX</td>
<td>FLX</td>
<td>1</td>
</tr>
</tbody>
</table>

**DED_CALC table results:**

<table>
<thead>
<tr>
<th>Company</th>
<th>Pay Group</th>
<th>Pay End Date</th>
<th>EMPLID</th>
<th>EMPL_RCD</th>
<th>Plan Type</th>
<th>Benefit Plan</th>
</tr>
</thead>
<tbody>
<tr>
<td>PST</td>
<td>WK1</td>
<td>07/03/00</td>
<td>8412</td>
<td>0</td>
<td>20</td>
<td>LIFE</td>
</tr>
<tr>
<td>PST</td>
<td>WK1</td>
<td>07/03/00</td>
<td>8412</td>
<td>0</td>
<td>00</td>
<td>none</td>
</tr>
<tr>
<td>PST</td>
<td>FLX</td>
<td>07/03/00</td>
<td>8412</td>
<td>1</td>
<td>20</td>
<td>LIFEX</td>
</tr>
</tbody>
</table>

**Benefit Deductions**

In the preceding example, Payroll Interface treats each EMPLID/EMPL_RCD key field combination as a separate row of information; each job is treated as a separate check. The EMPLID and all multiple jobs will be run through the deduction calculation process. Although a separate row is created for each
multiple job in the payroll interface, all of the employee's multiple job deductions are processed at the same time.

**General Deductions**

In the preceding example, general deductions should be taken against only one of the jobs. However, because general deductions do not include the EMPL_RCD key field, you must manually select the EMPL_RCD using the Payroll Options (PAYROLL_DATA) component, Payroll Options 2 page, Deduction Calc Record field. The Deduction Calc Record (Deduction Calculation Record) field appears for employees who have:

- Multiple jobs in the same company.
- Different benefit programs for each job.
- General deductions.

**Related Links**

[Export Processing and Multiple Jobs](#)
Export processing occurs in the following way:

1. To start the Export process, use the Import/Export Payroll Data (PI_RUNCTL_PNL) component, Import/Export Payroll Data run control page to enter the pay run ID, payroll interface run number, and other parameters.

2. PI_INRUN reads the pay run ID and run number and calls PIPINRUN.

3. PIPINRUN calls PIPCMPAR (which in turn calls other subroutines). PIPCMPAR selects, compares, and exports data to tables PI_PARTIC and PI_PARTIC_EXPT.

4. PIPINRUN calls PIXPORT (which in turn calls other subroutines). PIXPORT reads table PI_PARTIC_EXPT, transfers the changed data to temporary table PI_EXTIO or PI_PARTIC_EXTBL.

5. PIPINRUN returns control to PI_INRUN.

6. PI_INRUN calls PI_EXTFL.

7. If exporting to a file, PI_EXTFL reads the data in PI_EXTIO and creates the export file. If exporting to a table, PI_EXTFL reads the data in PI_PARTIC_EXTBL and creates the export table.

**Export Process Details**

The Export process includes three phases — select, compare, and export:

- During the select phase, payroll data is retrieved from the PeopleSoft HCM tables.
- During the compare phase, the selected data is compared against the data from the previous export run.
The comparison phase identifies any data changes that have occurred since the last export.

- During the export phase, the data is exported to either a flat file or a table.

A full-records export performs the select and export phases; all data is exported. A changes-only export performs the select, compare, and export phases; only data that has changed is exported.

**PI_INRUN calls PIPINRUN**

Export processing is based on the pay run ID and run number. For each pay run ID, PIPINRUN retrieves the company and pay group from the pay calendars. The company and pay group are used to verify the payroll interface definitions and to select the employees who will be processed.

**PIPINRUN calls PIPCMPAR**

First, PIPCMPAR verifies the payroll interface setup for the selected configuration ID:

1. Using the company and pay group, PIPCMPAR obtains the configuration ID from the Pay Group table.

   Using the configuration ID, it retrieves the file definitions and the system ID from the Configuration table.

   a. For the selected system ID, PIPCMPAR verifies all records and fields in PS Tables table.

   b. For the selected system ID, PIPCMPAR verifies all fields in the Field Definition table.

   c. PIPCMPAR verifies that all the parameters defined in the Definition table are valid.

2. Using the company and pay group, PIPCMPAR selects from the Job table all employees (with status values defined in the System table) with a matching company and pay group.

Second, PIPCMPAR performs the actual export process. The export process differs for full-records exports and changes-only exports.

1. For a full-records export, PIPCMPAR does the following for each selected employee in the pay group:

   a. For each table defined in PS Tables, retrieves rows based on the where clause definition (as well as instance IDs, process IDs, and other information that is set up in the interface).

   b. **Exports** the results to tables PI_PARTIC and PI_PARTIC_EXPT in the format specified in the Definition table (LOG, PHY, CSV, and so on).

   **Note:** For full-records exports, all values are considered new, and therefore, changed. Flags in the PI_PARTIC and PI_PARTIC_EXPT tables are initialized to Y and 1.

2. Changes-only export, PIPCMPAR, does the following for each selected employee in the pay group:

   a. For each table defined in PS Tables, retrieves rows based on the where clause definition (as well as instance IDs, process IDs, and other information that is set up in the interface).

   b. **Compares** the value of each field (and row, if designated) to the value that was sent in the last export (the previous run number).
c. *Exports* the results to table PI_PARTIC and PI_PARTIC_EXPT in the format specified in the Definition table (LOG, PHY, CSV).

---

**Note:** For changes-only exports, flags in the PI_PARTIC and PI_PARTIC_EXPT tables are set to Y and 1 if values change or to N and 0 if values do not change.

---

**PIPINRUN calls PIPXPORT**

PIPXPORT reads table PI_PARTIC_EXPT and writes the changed data to temporary table PI_EXTIO or PI_PARTIC_EXTBL.

**Note:** If no changes occurred, table PI_EXTIO or PI_PARTIC_EXTBL is empty at the end of the export process.

---

**PI_INRUN calls PI_EXTFL**

When the export processing is finished, control returns to the Application Engine. PI_INRUN calls PI_EXTFL to create the export file.

PI_EXTFL does the following:

1. For each row of data in table PI_EXTIO:
   - Writes a line to the export file defined in the File Handle table for the file definition. The data is written in the character set defined on the PI System table (LOG, PHY, CSV, and so on).
2. Deletes the contents of table PI_EXTIO.
3. Deletes the run control record.

**PI_PARTIC and PI_PARTIC_EXPT Tables**

When a full-records or changes-only export is processed, flags are set in the PI_PARTIC and PI_PARTIC_EXPT tables. The values of these flags determine which data is written to the export file (or table).

This diagram illustrates the parent-child relationship between the PI_PARTIC and PI_PARTIC_EXPT tables:

**Image: Parent-child relationship between the PI_PARTIC and PI_PARTIC_EXPT tables**

This diagram illustrates the parent-child relationship between the PI_PARTIC and PI_PARTIC_EXPT tables.

---

The PI_PARTIC table contains one row of data for every employee and for every process. It contains high-level information that determines which employees are processed during the comparison phase. Two
key fields in this table are EMPLID and PI_RUN_NUM. The PI_RUN_NUM is very important when doing a reprocess run. A critical field on the PI_PARTIC table is PI_CHANGE_IND. If an employee has had a data change since the last Export process, the PI_CHANGE_IND flag is set to Y.

The PI_PARTIC_EXPT table contains the historical (changed) data for the comparison phase. New rows are inserted into this table during each Export process run. Every field that will be sent to the third-party payroll system is in this table. In front of each data element on the PI_PARTIC_EXPT table is a change flag. If the field has changed since the last process, this flag is set to 1; otherwise, it is set to 0. If the field belongs to a group, the data element is prefixed with 2.

Within the PI_PARTIC_EXPT table, the Export Row column is a 250-byte character representation of employee-level data. This data field is the result of information that is set up using the Definition Table (INTRFC_DEFINITION) component. If there is more than 250 bytes of data, another row is inserted into the table and the EXPORT_SEQ is incremented. The export row is positional and is based on the order of the fields that are set up using the Definition Table component. This is very important for maintenance during live processing.

**PI_PARTIC Table**

If values change, PI_CHANGE_IND is set to Y.

Possible run status indicators for a successful export run are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI_PARTIC_STATUS</td>
<td>• Compared (C). Process is complete.</td>
</tr>
<tr>
<td></td>
<td>• Compare Error (E). An error occurred.</td>
</tr>
<tr>
<td></td>
<td>• In Progress (P). Process is running.</td>
</tr>
<tr>
<td>Note:</td>
<td>When the process finishes, the flag should be set to C or E. If the flag is set to P, then an error has occurred.</td>
</tr>
<tr>
<td>PI_CHANGE_IND</td>
<td>• Change (Y). Data has changed since the previous export.</td>
</tr>
<tr>
<td></td>
<td>• Process Change (P). Data has changed and caused a process to occur.</td>
</tr>
<tr>
<td></td>
<td>• No Change (N). No data has changed.</td>
</tr>
<tr>
<td>Note:</td>
<td>Some data changes trigger a process; for example, if an employee is terminated, a stop transaction for deductions may be issued.</td>
</tr>
</tbody>
</table>
### Field Value

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI_CHANGE_TYPE</td>
<td>• New Hire (N). The employee is a new hire. All data is sent to PI_PARTIC_EXPT.</td>
</tr>
<tr>
<td></td>
<td>• Data (D). Data changed.</td>
</tr>
<tr>
<td></td>
<td>• Process (P). Data has changed and caused a process to occur.</td>
</tr>
<tr>
<td></td>
<td>• Reactive Pay (R). The employee has been rehired.</td>
</tr>
<tr>
<td></td>
<td>• Terminated Pay (T). The employee has been terminated.</td>
</tr>
<tr>
<td></td>
<td>• Blank. No data changed. No data was sent to PI_PARTIC_EXPT.</td>
</tr>
</tbody>
</table>

### PI_PARTIC_EXPT Table

If values change, PI_CHANGE_IND is set to Y and the byte-length field flags that are attached to each field value are set to 0, 1, or 2. All exported data is written to EXPORT_ROW, a 250-character field. If the export file is defined at a length greater than 252 characters, then data is loaded into additional EXPORT_ROW fields and the EXPORT_SEQ sequence field is incremented.

Possible run status indicators for a successful export run are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI_CHANGE_IND</td>
<td>• Change (Y). Data has changed. Data fields with a 1 flag will be exported.</td>
</tr>
<tr>
<td></td>
<td>• Process change (P). Data has changed and caused a process to occur.</td>
</tr>
<tr>
<td></td>
<td>• No change (N or blank). No data fields will be exported.</td>
</tr>
<tr>
<td>EXPORT_ROW</td>
<td>• Zero (0). No change.</td>
</tr>
<tr>
<td></td>
<td>• One (1). Change.</td>
</tr>
<tr>
<td></td>
<td>• Two (2). Change in a group field.</td>
</tr>
</tbody>
</table>

### Example 1

Assume the following for the employee with EmplID KUI001:

- Full-records export, run number 1.
- Data values for salary, union dues, savings bond, and vehicle allowance.
PI_PARTIC table—This is a full-records export and all data values are considered changed. PI_CHANGE_IND is set to Y.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMPL_ID</td>
<td>KUI001</td>
</tr>
<tr>
<td>PI_RUN_NUM</td>
<td>1</td>
</tr>
<tr>
<td>PI_CHANGE_IND</td>
<td>Y</td>
</tr>
</tbody>
</table>

PI_PARTIC_EXPT table—PI_CHANGE_IND is set to Y and the byte-length field flag is set to 1 for all data values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMPL_ID</td>
<td>KUI001</td>
</tr>
<tr>
<td>PI_RUN_NUM</td>
<td>1</td>
</tr>
<tr>
<td>PI_CHANGE_IND</td>
<td>Y</td>
</tr>
</tbody>
</table>

|EXPORT_ROW     | 11500 110 1100 115 |

Export file—All data values are written to the export file (or table).

<table>
<thead>
<tr>
<th>Employee (EMPLID)</th>
<th>Salary</th>
<th>U-DUES</th>
<th>SV-BND</th>
<th>VEH</th>
</tr>
</thead>
<tbody>
<tr>
<td>KUI001</td>
<td>1500</td>
<td>10</td>
<td>100</td>
<td>15</td>
</tr>
</tbody>
</table>

**Example 2**

Assume the following for the employee with EmplID KUI001:
- Changes-only export, run number 2.
- Data values for salary and savings bond have changed.

<table>
<thead>
<tr>
<th>Export</th>
<th>Run Num</th>
<th>Salary</th>
<th>U-Dues</th>
<th>SV-BND</th>
<th>VEH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-records</td>
<td>1</td>
<td>1500</td>
<td>10</td>
<td>100</td>
<td>15</td>
</tr>
<tr>
<td>Changes-only</td>
<td>2</td>
<td>1800</td>
<td>10</td>
<td>150</td>
<td>15</td>
</tr>
</tbody>
</table>

PI_PARTIC table—PI_CHANGE_IND is set to Y.
PI_PARTIC_EXPT table—PI_CHANGE_IND is set to Y and the byte-length field flag is set to 1 for data values that have changed and to 0 for data values that have not changed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMPL_ID</td>
<td>KUI001</td>
</tr>
<tr>
<td>PI_RUN_NUM</td>
<td>2</td>
</tr>
<tr>
<td>PI_CHANGE_IND</td>
<td>Y</td>
</tr>
</tbody>
</table>

Export file—Changed data values are written to the export file (or table).

<table>
<thead>
<tr>
<th>Employee (EMPLID)</th>
<th>Salary</th>
<th>U-DUES</th>
<th>SV-BND</th>
<th>VEH</th>
</tr>
</thead>
<tbody>
<tr>
<td>KUI001</td>
<td>1800</td>
<td>10</td>
<td>150</td>
<td></td>
</tr>
</tbody>
</table>

**Example 3**

Assume the following for the employee with EMPLID KUI001:

- Changes-only export, run number 3.
- No data values have changed.

<table>
<thead>
<tr>
<th>Export</th>
<th>Run Num</th>
<th>Salary</th>
<th>U-Dues</th>
<th>SV-BND</th>
<th>VEH</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-records</td>
<td>1</td>
<td>1500</td>
<td>10</td>
<td>100</td>
<td>15</td>
</tr>
<tr>
<td>Changes-only</td>
<td>2</td>
<td>1800</td>
<td>10</td>
<td>150</td>
<td>15</td>
</tr>
<tr>
<td>Changes-only</td>
<td>3</td>
<td>1800</td>
<td>10</td>
<td>150</td>
<td>15</td>
</tr>
</tbody>
</table>

PI_PARTIC table—PI_CHANGE_IND is set to N.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMPL_ID</td>
<td>KUI001</td>
</tr>
</tbody>
</table>
Chapter 3 Understanding PeopleSoft Payroll Interface Processing

### Field Values

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI_RUN_NUM</td>
<td>3</td>
</tr>
<tr>
<td>PI_CHANGE_IND</td>
<td>N</td>
</tr>
</tbody>
</table>

PI_PARTIC_EXPT table — PI_CHANGE_IND is set to N and the byte-length field flag is set to 0 for all field values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMPL_ID</td>
<td>KUI001</td>
</tr>
<tr>
<td>PI_RUN_NUM</td>
<td>3</td>
</tr>
<tr>
<td>PI_CHANGE_IND</td>
<td>N</td>
</tr>
<tr>
<td>EXPORT_ROW</td>
<td>01800 010 0150 015</td>
</tr>
</tbody>
</table>

Export file — No data values have changed; no data is written to the export file (or table).

<table>
<thead>
<tr>
<th>Employee (EMPLID)</th>
<th>Salary</th>
<th>U-DUES</th>
<th>SV-BND</th>
<th>VEH</th>
</tr>
</thead>
<tbody>
<tr>
<td>KUI001</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### PI_EXTIO and PI_PARTIC_EXTBL Tables

The Export process can write data to either an export file or an export table.

This diagram illustrates exporting data to either a file or table:

**Image: Exporting data to either a file or table from the PI_EXTIO and PI_PARTIC_EXTBL tables**

This diagram illustrates exporting data to either a file or table.

**PI_EXTIO Table**

In the PI_EXTIO table, the REC_DATA_PARTIAL field should contain the exact contents of the external file. However, if the record length of the external file exceeds 252 bytes, then the rows in PI_EXTIO are split and the RECDATA_SEQ_NO field is incremented.
**PI_PARTIC_EXTBL Table**

In the PI_PARTIC_EXTBL table, a row for each changed field is written and the SEQ_NUM field is incremented by 1 unless the field has a group ID assigned to it. For fields with group IDs, the same SEQ_NUM is applied to all fields in the group. For the sequence numbering logic to work properly, you must set up grouped fields correctly. For example, the DED group ID can be used to pair the Deduction Code and Deduction Amount fields. These two fields must adjoin each other on the record; fields without the DED group ID cannot be positioned between them.

See Setting Up the Definition Table.

**Export Processing and Multiple Jobs**

To export data for an employee with multiple jobs, the following criteria is used:

- An export record is created for each job that is set up with a Payroll Interface company/pay group.
- All records that use the employee record number in the key send the appropriate data for that record number.
- All records that do not contain the employee record number in the key (for example, personal data) send the same information that applies to all export records.
- All of the employee's jobs are exported, whether the jobs are from the same or different pay groups or the same or different companies.
- When a concurrent job is added or terminated, it is processed the same way that a single job is added or terminated.

If you define unique IDs by combining the PeopleSoft EMPLID and record (job) number, you create separate employees in the third-party payroll system for each job.

If you use multiple jobs in PeopleSoft HCM, but only want to export a single job through Payroll Interface, you might instead identify a particular job record number for all employees, then create an instance ID attached to the record-mapped-to job, to include only that specific job record number.

**Payroll System IDs**

You can add another key besides the PeopleSoft EMPLID, the national ID, and the payroll interface employee ID. You can use a view, the multiple national ID field on the personal data pages, or the Payroll Interface existing translation logic. The approach that you choose depends on the third-party payroll requirements.

If you need a single check, create a view to combine the values into one amount for each deduction code. Payroll Interface treats each employee ID or employee record number as a separate row of information. Each job is treated as a separate check. This gives you tremendous flexibility when mapping information to the third-party payroll system.

**Related Links**

Deduction Processing and Multiple Jobs
Import Processing

This topic discusses:

- Import process flow.
- Import tables.

Import Process Flow

This diagram illustrates the Import process flow:

**Image: Payroll Interface Import Process flow**

This diagram illustrates the Import process flow.

Import processing occurs in the following way:

1. To start the Import process, enter a pay run ID, run number, and other parameters using the Import/Export Payroll Data component, Import/Export Payroll Data run control page.

2. PI_INRUN reads the run control record and calls PI_EXTFL.

3. PI_EXTFL loads the import file into table PI_EXTIO and returns control to PI_INRUN.

4. PI_INRUN calls PIPINRUN.

5. PIPINRUN calls PIPMPORT (which in turn calls other subroutines).

6. PIPMPORT reads the PI_EXTIO table and loads the data into seven import tables.

7. PIPINRUN returns control to PI_INRUN.

8. PI_INRUN deletes the PI_EXTIO table and the run control.
Import Tables

Payroll Interface uses seven import tables to store the payroll results that are generated by the third-party payroll system. The import tables include many user-defined fields. You do not need to map data to all of these fields, but you do need to map to a few, such as check number and gross wages. The import tables are:

- PI_CHECK
- PI_EARN_DETAIL
- PI_DED_DETAIL
- PI_TAX_DETAIL
- PI_EARN_BAL
- PI_DED_BAL
- PI_TAX_BAL

**Note:** After the Import process is run, further processing or technical configuration may be required to check the validity of the data or to ensure that employee-level data can be accessed in a secure manner.

To import numeric and signed numeric fields, the data value in the import file must not contain any spaces. For example, to import a numeric field with a length of 10, decimal length of 2, display decimal enabled, and a value of 10.22, the value in the data file must equal 0000010.22 (leading zeros), and not bbbbb10.22 (where b represents a blank space).

Payroll Interface does not perform reverse translations (mappings). The data loaded into the import tables resides in the third-party payroll system's format. For example, suppose you select the **Using Interface Employee Table** option for the System Table (SYSTEM_TABLE) component, Interface System Table 1 page, Convert field. During the Export process, the PeopleSoft EMPLID is translated to the third-party payroll system employee ID, and the third-party payroll system employee ID is written to the export file or table. During the Import process, however, no reverse translation takes place. The third-party payroll system employee ID is loaded into the Payroll Interface import tables.

**Note:** If you select the **Using Interface Employee Table** option, the data in the Payroll Interface import tables can be joined to other PeopleSoft EMPLID-keyed tables through the PI_EMPLID_TBL table. This table includes the EMPLID, EMPL_RCD, and PI_EMPLID fields.

Related Links

- Setting Up the System Table

Export and Import Testing

This topic discusses:

- Testing exports and imports.
- Successful exports.
• Unsuccessful exports.
• Detecting errors.

Testing Exports and Imports

To test export and import interface definitions, run the Payroll Interface Export and Import processes until no errors occur and the data results are correct. Import interface definitions are usually set up and tested after the export interface definition is verified.

Testing Exports

To test an export interface definition the first time:
1. Delete the contents of the Payroll Interface tables shown below.
2. (optional) Run the Calculate Deductions and Confirmation processes.
3. Run a full-records Export process.
   Use the Pay Run ID prior to the pay run that is to be used for production.
4. When the Export process completes, check for errors.

Delete the content of these tables before running the Export process the first time:
• PI_RUNCTL
• PI_RUN_TBL
• PI_RUN_PYGRP
• PI_PARTIC
• PI_PARTIC_EXPT
• PI_EXTIO
• PI_PARTIC_EXTBL
• PI_MESSAGE
• DED_LINE
• DED_CALC
• DED_MESSAGE

Testing Imports

To test the import interface definition the first time:
1. Delete the contents of the Payroll Interface tables shown in the succeeding table.
2. Obtain a copy of the import file that is produced by the third-party payroll system.
3. Run the Import process.
Use the pay run ID for the associated Export process.

4. When the Import process finishes, check for errors.

Delete the content of these tables before running the Import process the first time:

- PI_RUNCTL
- PI_RUN_TBL
- PI_RUN_PYGRP
- PI_MESSAGE
- PI_EXTIO
- PI_CHECK
- PI_EARN_DETAIL
- PI_DED_DETAIL
- PI_TAX_DETAIL
- PI_EARN_BAL
- PI_DED_BAL
- PI_TAX_BAL

**Related Links**

Table Management

**Successful Exports**

You can identify a successful export run in the following ways:

- Changes that occurred during the pay period to PeopleSoft HCM mapped-data elements are exported and written to a file or table.

- The compare process identifies correct changes.

- The implementation of additional processing logic (beyond the delivered supported application functionality) works correctly, including:
  - Modifying the delivered Payroll Interface COBOL, for example, creating a new process ID.
  - Processing files using Application Engine, Structured Query Report (SQR), or other programming languages, for example, reformatting a record layout.
  - Writing PeopleCode, for example, to force a new set of export records given a specific job action (that is, rehire or transfer).
  - Creating new views, incorporating any American National Standards Institute (ANSI) SQL statement. For example, join the Department table with Job to extract department GL expense.
codes or managers, develop specific WHERE clauses, and perform Logic/Arithmetic/SQL functions.

- The contents of the export file (or table) are imported into the third-party payroll system and the data elements and transactions have been processed accurately per the third-party payroll system's import processing requirements. These types of transactions involve updating, inserting, or deleting employee data.

Unsuccessful Exports

For debugging purposes, sometimes it may be useful to run the PIPINRUN process directly. First, use the Import/Export Payroll Data component, Import/Export Payroll Data run control page to enter and save the Run Control ID and Pay Run ID. Then, instead of submitting the request to the process scheduler using the RUN button, run PIPINRUN at the command line of the process server or any connected computer with fully compiled current COBOL. During the run, PIPINRUN calls PIPCMPAR and PIPXPORT, the results are written to the PI_EXTIO table, and then processing stops. To rerun the PIPINRUN process, the contents of the PI_EXTIO table as well as the PI_RUNCTL table must be deleted.

Example 1

Export Result: PI_PARTIC and PI_PARTIC_EXPT are both empty.

If the failure of the export is not obvious, for example, the process terminates or a Payroll Interface error message such as MISSING RUN CONTROL is displayed, then analyze the employees. The Pay Run ID determines the pay calendar's company and pay group. PIPCMPAR selects against JOB.COMPANY and JOB.PAYGROUP to retrieve the appropriate employees. The DMS statement used in PIPCMPAR.DMS to select these employees performs an insert into PI_PARTIC. Therefore, if PI_PARTIC is empty, it is because the PIPCMPAR SQL that is trying to select employees and do the insert failed.

Most likely, an interface error message is in PI_MESSAGE stating that there were no records to export. However, to determine why no employees were selected, you will need to analyze the pay run ID, the associated pay calendar, the Pay Group table, and the corresponding employee job records.

Example 2

Export Result: PI_PARTIC is loaded and PI_PARTIC_EXPT is empty.

If the PI_PARTIC table is loaded, then the Export process select phase was successful (which means that the pay run ID, the pay calendar, the Pay Group table, and the Job records were set up correctly). If the process did not end, but the PI_PARTIC_EXPT table is empty, then the Export process compare phase was not successful. Do an inquiry on the interface messages (PI_MESSAGE) to determine why the process failed. When all of the issues are fixed, you should be able to reprocess the export.

Example 3

Export Result: PI_PARTIC is loaded, PI_PARTIC_EXPT is loaded, PI_EXTIO is loaded (when it should be empty) and no export file is created.

If PI_EXTIO is loaded, the Export process select, compare, and export phases finished successfully. However, the Application Engine's file I/O process that writes the contents of PI_EXTIO to the export file (and then deletes PI_EXTIO) did not finish successfully. Make sure the file IDs and file handles are set up correctly. If they are, then analyze the Application Engine programs PI_INRUN and PI_EXTFL.
Note: This does not apply if you are exporting data to a table.

Example 4

Export Result: PI_PARTIC is loaded, PI_PARTIC_EXPT is loaded, PI_EXTIO is empty, and no export file is created.

This scenario could mean that the Export process was successful and no changes exist. It also could mean that the Export process was successful and the external file was created, but the file is not located where you expected it.

If known data changes have occurred and the file cannot be found, then evaluate the PSPSEQIO COBOL program for issues surrounding the insert into the PI_EXTIO table. It would be helpful to run the COBOL process separately to insure that PI_EXTIO is being loaded at the end of the compare and export phases. At that point, the analysis should shift to the Application Engine's write to the external file.

Note: This does not apply if you are exporting data to a table.

Related Links
Understanding Data Exchanges

Detecting Errors

To determine whether an error has occurred after running the Calculate Deductions or Deduction Confirmation processes, first refer to the Review Deductions and Review Error Messages components.

See Reviewing Deductions.

To determine whether an error has occurred after running the Export or Import processes, first refer to the Error Messages (PI_MESSAGES) component and various reporting components.

See Reviewing Exports or Imports.

Error Messages

If the explanation in the Error Message component is not clear, you can use the message number to determine where in the COBOL routine the problem occurred. For example, suppose message 004030 returns the following information:

The Dedcalc process was not confirmed. This data is not available until the confirm is processed. The message data below identifies 2 field values. 1. Company 2. Paygroup.

To locate the problem:

1. Search for 004030 in PSCPYMSG.CBL to determine the corresponding 88 level name for MSGID.

   In this case, it is MSGID-DEDCALC-NOT-CONFIRMED.

2. Using a search tool, do a search against PI*.CBL to look for all the occurrences of MSGID-DEDCALC-NOT-CONFIRMED.
The result is in PIPINRUN.CBL, paragraph MM100-CONFIRM-DEDCALC.

The location of the error in the COBOL routine may point to a SQL statement or array search that may give additional clues to the problem.

**Error: Dynamic SQL Failure Due to Invalid PS Table Setup**

If you use PeopleSoft Application Designer to change any of the tables or fields that are set up in the PS Tables (PS_TABLES) component, you must make sure that these changes are reflected in the PS Tables component as well. If you do not, the Export process will end when attempting to run the dynamically created SQL statement. If it is not obvious which table or field is causing the error, you can run the Export process from a DOS prompt.

To run PIPINRUN from the DOS prompt:

1. From the DOS prompt, run PIPINRUN with the SQL Trace turned on.
2. At the SQL Trace prompt, enter 191.

   A trace file is written to C:\TEMP\PS\<dbname>\COBSQL_. The SQL causing the process to end should be toward the end of the trace file with a SQL statement name such as SJOB, S_GENL_DEDUCTION, and so on.
3. Copy the SQL to the database's SQL Inquiry tool and run it using the parameters listed below the statement in the trace file.

   The SQL Inquiry tool should point to the problem field.

See *PeopleTools: Application Designer Developer's Guide*

**Error: Maximum Number of Export Records Exceeded for EMPLID**

PIEXPT-COUNT-MAX represents the maximum number of records that can be generated for an EMPLID. During the Export process, this maximum number can be reached when you are processing files that comprise a high number of rows in PS_JOB.

PIEXPT-COUNT-MAX is set to 200 by default. If you want to increase this number, you need to modify to the COBOL in two places:

- In PICIEXPT.CBL, insert the desired number where you see 200 in bold.

  `88 PIEXPT-COUNT-MAX VALUE 200`

- In PIPIEXPT.CBL, insert the desired number where you see 200 in bold.

  `02 PIEXPT-DATA OCCURS 200`

Be sure to recompile the programs when you are done.

You may encounter similar error messages for "Maximum number of export records exceeded." Again, just follow the code line through and increase the 88 VALUE and the corresponding OCCURS values.
Table Management

Payroll Interface is a table-driven export and import engine. As you set up and maintain an interface definition, you may need to work directly with various Payroll Interface tables.

*Note:* If using PeopleSoft Data Mover to run DELETE, IMPORT, and EXPORT scripts, use the internal name for the table, for example, PI_PARTIC. If using Microsoft SQL Query Analyzer or some other non-PeopleSoft tool to run SQL statements, use the external name for the table, for example PS_PI_PARTIC.

See *PeopleTools: Data Management*

**Managing the Process Tables**

Occasionally, you may want to delete the data in the Payroll Interface process tables to free disk space, reduce processing times, or send a full record export file to the third-party payroll system.

*Warning!* PeopleSoft does not support a specific purge strategy. Back up tables before you run the SQL DELETE statement.

To purge the process tables, follow these general guidelines:

1. Stop all data input into the PeopleSoft system.
2. Run the normal daily process (usually a changes-only export run).
3. Delete the data in the selected process tables.
4. Run the normal daily process again (the system will return by default to a full-records export run).

You should delete the data in the tables whenever changes are made to the export file definition (for example, changing field characteristics such as increasing or decreasing field sizes or edit masks or adding or deleting fields from the interface definition).

The PI_PARTIC and PI_PARTIC_EXPT tables can get very large. You should monitor the size of these tables on a regular basis to ensure that Payroll Interface functions properly. You may want to archive historical data in these tables.

The PI_RUN_TBL tables contains the PI_RUN_NUM field. If you purge this table, the PI run number is reset to 1. If you do not want to reset run number, do not purge the PI_RUN_TBL or the PI_RUN_PYGRP tables. When you run the Export process, the run number will be incremented to the next number.

*Warning!* Do not purge the PIEMPLID_TBL if you have mapped the PeopleSoft EMPLID to the third-party payroll system employee ID.

The Payroll Interface process tables include:

- AERUNCONTROL
- PI_RUNCTL
- PI_RUNCTL_AE
• PI_RUNCTL_SID
• PI_RUN_TBL
• PI_RUN_PYGRP
• PI_PRESELECT
• PI_EMPLID_TBL
• PI_PARTIC
• PI_PARTIC_EXPT
• PI_EXTIO
• PI_PARTIC_EXTBL
• PI_MESSAGE
• DED_CALC
• DED_LINE
• DED_MESSAGE

Managing the Control Tables

Occasionally, you may want to transfer the Payroll Interface control tables (also referred to as the setup tables) from one database to another for example, when you move from a test environment to a production environment.

Warning! Never copy the process tables (PI_PARTIC, PI_PARTIC_EXPT, and so on) from a test environment to a production environment. These tables are automatically populated in the production environment.

To export tables, run this script:

• SET LOG C:\TEMP\PI_EXPORT.LOG
• SET OUTPUT C:\TEMP\PI_TABLES.DAT
• EXPORT PI_SYSTEM_TBL
• EXPORT PI_SYSTEM_STAT
• EXPORT PI_SYSTEM_LANG
• EXPORT PI_PS_RECORD
• EXPORT PI_PSREC_FLD
• EXPORT PI_PS_REC_LANG
• EXPORT PI_INSTANCE_TBL
• EXPORT PI_INST_VALUE
• EXPORT PI_INSTANC_LANG
• EXPORT PI_PROCESS_TBL
• EXPORT PI_PROCESS_VAL
• EXPORT PI_PROC_TB_LANG
• EXPORT PI_PROC_VA_LANG
• EXPORT PI_FIELD_TBL
• EXPORT PI_FIELD_XLAT
• EXPORT PI_FIELD_LANG
• EXPORT PI_GROUP_TBL
• EXPORT PI_GROUP_LANG
• EXPORT PI_DEFN_FILE
• EXPORT PI_DEFN_RECORD
• EXPORT PI_DEFN_FIELD
• EXPORT PI_DEFN_F_LANG
• EXPORT PI_DEFN_R_LANG
• EXPORT PI_CONFIG_TBL
• EXPORT PI_CONFIG_FILE
• EXPORT PI_CONFIG_LANG
• EXPORT FILE_HANDLE_LNG
• EXPORT FILE_HANDLE_TBL

To import tables, run this script:

• SET LOG C:\TEMP\PI_IMPORT.LOG
• SET INPUT C:\TEMP\PI_TABLES.DAT
• REPLACE_ALL *
• SET LOG C:\TEMP\PI_IMPORT.LOG
• SET INPUT C:\TEMP\PI_TABLES.DAT
• IMPORT * IGNORE_DUPS

REPLACE_ALL *;—Deletes all data from the PeopleSoft table and replaces it with the data in your import file.
IMPORT * IGNORE_DUPS;—Leaves all data in the PeopleSoft table and loads only new rows of data. It will not replace any data already in the table. So if you have a row that exists in both the source table and the target table, no action is taken at all, even if some of the fields on that row have changed.
Chapter 4

Setting Up Earnings Data

Understanding Earnings

Payroll Interface does not calculate earnings. You use Payroll Interface to track and export changes to earnings data that occur during a pay period. The third-party payroll system performs the earnings calculations and the gross-to-net calculations.

Payroll Interface recognizes two earnings categories, regular earnings and additional pay. Regular earnings refers to the employee earnings that are entered on the Job Data component, for example, regular or overtime pay. Additional pay refers to employee earnings that are entered on the Additional Pay component and represents earnings that an employee is paid on a regular basis in addition to regular earnings, for example, a vehicle allowance.

Two earnings components are included with Payroll Interface, the Earnings Table (EARNINGS_TABLE) component and the Earnings Program Table (EARNS_PROGRAM_TBL) component:

- The primary purpose of the earnings components is to enable you to set up the earnings codes and earnings program that are required on the Pay Group Table component, Calc Parameters (calculation parameters) page.
- A secondary purpose of the earnings components is to enable you to set up earnings codes for additional pay and to add these codes to the earnings program.

Related Links
Understanding Payroll Schedules

Setting Up Earnings Codes and Earnings Programs

To set up earnings codes and earnings programs, use the Earnings Table (EARNINGS_TABLE) and Earnings Program Table (EARNS_PROGRAM_TBL) components in PeopleSoft Payroll for North America.

Pages Used to Set Up Earnings Codes and Earnings Programs

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earnings Table - General Page</td>
<td>EARNINGS_TABLE1</td>
<td>Set up earnings codes. The Payment Type, Effect on FLSA, and Eligible for Retro Pay group boxes are not used by Payroll Interface.</td>
</tr>
<tr>
<td>Earnings Program Table Page</td>
<td>EARNS_PROGRAM_TBL</td>
<td>Set up the earnings program.</td>
</tr>
</tbody>
</table>
Understanding Earnings Codes and Earnings Programs

An earnings code defines a type of earnings, for example, maternity leave. You set up earnings codes for regular earnings as well as additional pay. To satisfy the requirements of the Pay Group Table component, Calc Parameters page, you must set up default earnings codes for regular, overtime, and holiday pay.

An earnings program defines a set of earning codes that is valid for one or more pay groups and the employees who belong to those pay groups. To satisfy the requirements of the Pay Group Table component, Calc Parameters page, you must set up a default earnings program that includes the default earnings codes for regular, overtime, and holiday pay.

Related Links
"Establishing Earnings Codes" (PeopleSoft HCM 9.2: Payroll for North America)
"Establishing Earnings Programs" (PeopleSoft HCM 9.2: Payroll for North America)

Earnings Table - General Page

Use the Earnings Table - General page (EARNINGS_TABLE1) to set up earnings codes.

Navigation

Set Up HCM > Product Related > Payroll Interface > Earnings > Earnings Table > General
Set Up HCM > Product Related > Payroll for North America > Compensation and Earnings > Earnings Table > General

See the "Earnings Table - General Page" (PeopleSoft HCM 9.2: Payroll for North America) in the Payroll for North America product documentation.

The Payment Type, Effect on FLSA, and Eligible for Retro Pay group boxes are not used by Payroll Interface.

Note: To set up the earnings codes that are required for the Pay Group Table component, use only the General page (ignore the Taxes, Calculation, and Special Processes pages). To set up earnings codes for additional pay, use the General page and, if necessary, the Taxes, Calculation, and Special Process pages.

Earnings Program Table Page

Use the Earnings Program Table page (EARN_PROGRAM_TBL) to set up the earnings program.

Navigation

Set Up HCM > Product Related > Payroll Interface > Earnings > Earnings Program Table > Earnings Program Table
Set Up HCM > Product Related > Payroll for North America > Compensation and Earnings > Earnings Program Table > Earnings Program Table

See the "Earnings Program Table Page" (PeopleSoft HCM 9.2: Payroll for North America) in the Payroll for North America product documentation.
Setting Up and Maintaining Additional Pay

To set up and maintain additional pay, use the Additional Pay (ADDITIONAL_PAY) component.

Page Used to Set Up and Maintain Additional Pay

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Pay Page</td>
<td>ADDITIONAL_PAY1</td>
<td>Set up and assign additional pay earnings to an employee.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify a different department to charge for the additional pay.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Change employee tax data for additional pay.</td>
</tr>
</tbody>
</table>

Understanding Additional Pay

Additional pay refers to earnings that an employee is paid on a regular basis in addition to regular earnings, for example, a vehicle allowance, variable compensation, or benefit credits. (Do not confuse additional pay with one-time payments, such as overtime or an expense reimbursement.)

To set up and maintain additional pay:

1. Use the Earnings Table component to set up an earnings code for the additional pay.
2. Use the Earnings Program Table component to add the earnings code to the earnings program.
3. Use the Additional Pay component to set up and assign the additional pay to an employee.

Additional Pay Page

Use the Additional Pay page (ADDITIONAL_PAY1) to set up and assign additional pay earnings to an employee.

Navigation

Payroll Interface > Update Payroll Information > Additional Pay > Additional Pay
Image: Additional Pay page (1 of 3)

This example illustrates the fields and controls on the Additional Pay page (1 of 3).

Image: Additional Pay page (2 of 3)

This example illustrates the fields and controls on the Additional Pay page (2 of 3).
Image: Additional Pay page (3 of 3)

This example illustrates the fields and controls on the Additional Pay page (3 of 3).

Specify a different department to charge for the additional pay. Change employee tax data for additional pay.

**Addl Seq Nbr** (additional sequence number)  
Select 1 unless there are multiple additional pay records.

**Earnings, Hours, and Hourly Rate**  
Select to indicate whether additional pay is hours multiplied by an hourly rate or a fixed amount, but not both.

If an hourly rate is indicated, but the field is left blank, information is automatically populated from the employee's job record.

**Goal Amount**  
Select to have your payroll system stop issuing this additional pay when the amount has been reached.

**Applies to Pay Periods**  
Select the appropriate options to indicate the pay periods in which this additional pay should be identified in your payroll system.

For example, if an employee were paid twice a month, but received a monthly car allowance, you would select either *First* or *Second*, but not both.

**Job Data Override**  
Use the Job Data Override group box to change the department that is charged for the additional pay.

**Position, Business Unit, Department, Job Code, Combination Code, and GL Pay Type**  
Enter data in any of these fields to override the default value.

**Addl Shift** (additional pay shift)  
Select *Use Job* to use the shift that is specified on the employee's Job record.
Tax Information

Use the Tax Information group box to modify the employee's state and local tax data.

**State**
Select to enter the state that the employee worked in, if different from the employee's regular pay. This field is validated against the employee's state and local tax data.

**Locality**
Select to enter the locality that the employee worked in, if different from the employee's regular pay. This field is validated against the employee's state and local tax data.
Chapter 5

Setting Up Deduction Data

Understanding Deductions

Payroll Interface recognizes two types of deductions: benefit deductions and general (non-benefit) deductions. Benefit deductions are deductions that are associated with benefit programs, and include deductions for health plans, life insurance plans, and other benefit plans. General deductions are deductions that typically are not associated with benefits, and include deductions such as parking fees, and union dues.

You can set up and maintain deductions using Payroll Interface and the Manage Base Benefits business process in PeopleSoft HR; or, alternatively, you can have the third-party payroll system manage deductions.

Note: To simplify data entry, conversion, and maintenance issues, you may want to have the third-party payroll system manage deductions. Certain types of deductions, such as garnishments, are highly confidential and are almost always maintained in the third-party payroll system.

Related Links
PeopleSoft Human Resources Manage Base Benefits

Setting Up the Deduction Table

To set up the Deduction Table, use the Deduction Table (DEDUCTION_TABLE) component.

Pages Used to Set Up the Deduction Table

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deduction Table - Setup Page</td>
<td>DEDUCTION_TABLE1</td>
<td>Set up deduction parameters.</td>
</tr>
<tr>
<td>Deduction Table - Tax Class Page</td>
<td>DEDUCTION_TABLE2</td>
<td>Set up deduction tax classifications.</td>
</tr>
<tr>
<td>Deduction Table - Process Page</td>
<td>DEDUCTION_TABLE4</td>
<td>Set up deduction processing.</td>
</tr>
<tr>
<td>Deduction Table - Schedule Page</td>
<td>DEDUCTION_TABLE5</td>
<td>Set up deduction schedules.</td>
</tr>
</tbody>
</table>

Understanding the Deduction Table

The Deduction Table component enables you to select a plan type, enter a deduction code, and set up the deduction processing rules that enable you to specify processing details such as deduction priorities, deduction tax classifications, deduction pay period schedules, and other special payroll process indicators.
Whether you are setting up a benefit deduction or a general deduction, you begin with the Deduction Table component. For example:

- To set up a medical deduction, you would (1) use the Deduction Table component to select a plan type (Medical), enter a deduction code, and set up the deduction processing rules and (2) use components in the Manage Base Benefits business process to set up the benefit plans, benefit programs, and other deduction calculation parameters.

- To set up a 50.00 USD general deduction for parking, you would (1) use the Deduction Table component to select a plan type (General Deduction), enter a deduction code, and set up the deduction processing rules and (2) use the General Deduction Table (GENL_DEDUCTION_TBL) component to enter the dollar amount and other deduction calculation parameters.

The plan type that you select is critical in the deduction process because it indicates to the system whether you are setting up a deduction code for a benefit deduction or a general deduction. It also indicates to the system from which component, the Benefit Program Table (BEN_PROG_DEFN) component or the General Deduction Table component, to retrieve the deduction calculation parameters.

This graphic illustrates the relationship between the Deduction Table component, benefit deductions, and general deductions:

Image: Relationship between the Deduction Table component, benefit deductions, and general deductions

This diagram illustrates the relationship between the Deduction Table component, benefit deductions, and general deductions.

Deduction Table - Setup Page

Use the Deduction Table - Setup page (DEDUCTION_TABLE1) to set up deduction parameters.

Navigation

Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table > Setup
Image: Deduction Table - Setup page

This example illustrates the fields and controls on the Deduction Table - Setup page.

**Deduction Code**
Set up deduction codes that mirror the deduction codes in the third-party payroll system.

**Deduction Priority**
Not used by Payroll Interface; however, you can set up deduction priorities that mirror the deduction priorities in the third-party payroll system.

**Note:** The Maximum Arrears Payback group box and Deduction Subset group box are not used by Payroll Interface.

**Deduction Table - Tax Class Page**
Use the Deduction Table - Tax Class page (DEDUCTION_TABLE2) to set up deduction tax classifications.

**Navigation**
Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table > Tax Class
This example illustrates the fields and controls on the Deduction Table - Tax Class page.

### Deduction Classification

Use this group box to select an appropriate tax classification for the deduction, including:

- **After-tax** or **before-tax** for employee deductions.
- **Nontaxable benefit** and **nontaxable before-tax benefit** for employer contributions.

A deduction can have more than one classification. However, it is still considered one deduction. For example, a benefit deduction plan, such as 401(k), can have both before-tax and after-tax classifications as well as a nontaxable classification for employer contributions.

**Note:** (USF) A retirement plan deduction, such as TSP benefit deductions, can have a before-tax and a nontaxable classification for any employer contributions. Certain benefits, such as FEGLI, will have an after-tax classification for the employee contribution. If your agency has a FEGLI plan that provides coverage in an amount equal to three times your base salary of 40,000 USD a year, you pay for the after-tax deduction.

#### After-Tax

Select to reduce net pay. An example is a monthly parking deduction.

#### Before-Tax

Select to reduce net pay and taxable gross. An example is an employee contribution to a retirement program, such as a 401(k) plan.

#### Nontaxable Benefit

Select to represent an employer contribution (not subject to federal tax) to an employee benefit plan, such as a health plan or retirement plan. The contribution has no payroll effect. The after-tax matching contribution for savings plans is a nontaxable benefit.
**Nontaxable Benefit**  (nontaxable before-tax benefit)  
Select to represent an employer contribution (not subject to federal tax) to an employee benefit plan. Currently used only for the before-tax matching contribution to savings plans.

**Taxable Benefit**  
Select to represent an employer contribution (subject to federal tax) to an employee benefit plan, such as life insurance. The contribution increases federal withholding taxable gross (for tax purposes) but does not increase total gross (for pay purposes).

---

**Deduction Table - Process Page**

Use the Deduction Table - Process page (DEDUCTION_TABLE4) to set up deduction processing.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table > Process

**Image: Deduction Table - Process page**

This example illustrates the fields and controls on the Deduction Table - Process page.

---

**Process Information**

Use this group box to define parameters for deductions during deduction processing.

- **Partial Deduction Allowed**  
  Not used by Payroll Interface.

- **Deduction Arrears Allowed**  
  Not used by Payroll Interface.

- **Deductions Taken From Sep Chk**  
  (deductions taken from separate check)  
  Not used by Payroll Interface.

- **Stop Deduction at Termination**  
  For each deduction classification, select this option to stop the deduction for a terminated employee. For example, most health
Setting Up Deduction Data

Chapter 5

insurance plans are prepaid; premiums deducted for the current month are used to provide coverage for the next month. If an employee is terminated and no longer has health benefits, the deduction should not be taken.

**Liability Accounts - Non Commitment Accounting**

Not used by Payroll Interface. However, you may enter general ledger account numbers for your own information.

### Deduction Table - Schedule Page

Use the Deduction Table - Schedule page (DEDUCTION_TABLE5) to set up deduction processing.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table > Schedule

**Image: Deduction Table - Schedule page**

This example illustrates the fields and controls on the Deduction Table - Schedule page.

---

**Deduction Schedule**

By default, deductions are taken out every pay period regardless of pay frequency. Use this group box if you want a deduction to be taken out on a schedule other than every pay period.

**Pay Frequency**

Select the pay frequency that you want to override for those deductions that are not deducted every pay period. Values prompt from the Frequency table: *Annual, Biweekly, Daily, Monthly, Quarterly, Semimonthly,* and *Weekly.*

If you select a weekly frequency, you can select the Fifth Pay Period option only if you have also selected the first, second,
third, and fourth pay period options. Likewise, if you select a biweekly frequency, you can select only the Third Pay Period option if you have also selected the first and second pay period options.

Because a deduction with a monthly frequency is always taken once a month, no override is available for a monthly frequency. Suppose you have a semimonthly payroll, but a health deduction should only come out of the last paycheck of the month. In this case, you would select a pay frequency of Semimonthly and take a deduction in the second pay period.

**Deduction Frequency**

Use this group box to specify the appropriate pay periods in which to take the deduction for the selected pay frequency. You must insert a new row for every pay frequency for which you have a pay group defined.

**First Pay Period through Fifth Pay Period**

Select the appropriate pay periods that you want the deduction to be taken in.

---

**Viewing Benefit Deductions**

To view benefit deductions, use the Benefit Program (BEN_PROG_DEFN) component.

**Pages Used to View Benefit Deductions**

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Benefit Program Page</td>
<td>BEN_PROG_DEFN1</td>
<td>View a benefit program.</td>
</tr>
<tr>
<td>Assign to Benefit Program Page</td>
<td>BEN_PROG_PARTICPTN</td>
<td>View the benefit programs in which an employee is enrolled.</td>
</tr>
</tbody>
</table>

**Understanding Benefit Deductions**

Benefit deductions are set up using Payroll Interface and the Manage Base Benefits business process. To set up benefit deductions:

1. Use the Deduction Table component in Payroll Interface to select the plan type (any plan type except General Deduction), enter a deduction code, and set up the deduction processing rules.

   See Setting Up the Deduction Table.

2. Use the Benefit Plan Table (BENEFIT_PLAN_TABLE) component and other components in the Manage Base Benefits business process to set up benefit plans.

3. Use the Benefit Program Table component and other components in the Manage Base Benefits business process to build the benefit program and to define the deduction calculation parameters.

See "Understanding Benefit Programs" (PeopleSoft HCM 9.2: Human Resources Manage Base Benefits).

Benefit plans and programs are set up using the Manage Base Benefits business process; however, as a convenience, two components are duplicated in Payroll Interface: the Benefit Program component and the Assign to Benefit Program component. You can use these components as quick references when testing the interface definitions or trouble shooting deduction-related issues.

Calculating Benefit Deductions

Payroll Interface calculates pay period benefit deductions. When you run the Calculate Deductions and Deduction Confirmation processes, the calculated benefit deduction amounts are written to the export file. The third-party payroll system performs all gross-to-net-calculations.

See Calculating Deductions.

Benefit Program Page

Use the Benefit Program page (BEN_PROG_DEFN1) to view a benefit program.

Navigation

Set Up HCM > Product Related > Payroll Interface > Benefit Program > Benefit Program

Image: Benefit Program page

This example illustrates the fields and controls on the Benefit Program page.

Assign to Benefit Program Page

Use the Assign to Benefit Program page (BEN_PROG_PARTICPTN) to view the benefit programs in which an employee is enrolled.
Setting Up and Maintaining General Deductions

To set up and maintain general deductions, use the Deduction Table (DEDUCTION_TABLE) and General Deduction Table (GENL_DEDUCTION_TBL) components.

Pages Used to Set Up and Maintain General Deductions

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deduction Table - Setup Page</td>
<td>DEDUCTION_TABLE1</td>
<td>Set up the plan type (00 — General Deduction) and deduction code.</td>
</tr>
<tr>
<td>General Deduction Table Page</td>
<td>GENL_DEDUCTION_TBL</td>
<td>Set up a general deduction and define the deduction calculation parameters. For the matching entry on the Deduction Table component, select the plan type (00 — General Deduction).</td>
</tr>
<tr>
<td>General Deduction Page</td>
<td>GENL_DED_DATA</td>
<td>Assign a general deduction to an employee.</td>
</tr>
<tr>
<td>Overriding General Deductions Page</td>
<td>GENL_DED_OVERRIDE</td>
<td>Override a general deduction that is assigned to an employee.</td>
</tr>
</tbody>
</table>
Understanding General Deductions

General deductions are set up using Payroll Interface. To set up general deductions:

1. Use the Deduction Table component to select the plan type (General Deduction), enter a deduction code, and set up the deduction processing rules.

   See Setting Up the Deduction Table.

2. Use the General Deduction Table component to set up the general deduction and to define the deduction calculation parameters.

3. Use the General Deduction component to assign a general deduction to an employee.

4. Use the Override General Deductions component to override a general deduction assignment.

Exporting General Deductions

Payroll Interface does not calculate general deductions. However, when you run the Calculate Deductions and Deduction Confirmation processes, general deductions are automatically processed and the general deduction flat amounts are written to the export file along with the calculated benefit deduction amounts. If you do not maintain benefit deductions (do not run the Calculate Deductions process), you can set up and export general deduction amounts separately through the interface definition.

See Understanding Deduction Processing.

Deduction Table - Setup Page

Use the Deduction Table - Setup page (DEDUCTION_TABLE1) to set up the plan type (00 — General Deduction) and deduction code.

Navigation

Set Up HCM > Product Related > Payroll Interface > Deductions > Deduction Table > Setup
This example illustrates the fields and controls on the Deduction Table - Setup page.

**General Deduction Table Page**

Use the General Deduction Table page (GENL_DEDUCTION_TBL) to set up a general deduction and define the deduction calculation parameters.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Deductions > General Deduction Table > General Deduction Table
Image: General Deduction Table page

This example illustrates the fields and controls on the General Deduction Table page.

### Deduction Calculation Routine
Select to enter the deduction calculation routine. For Payroll Interface, the only valid routines are *Flat Amount* and *Special Deduction Calculation*.

If you select *Flat Amount*, enter the amount in the Flat/Additional Amount field for each pay frequency that your company uses. If the amount varies from employee to employee, such as with United Way or other charitable contributions, leave the Flat/Additional Amount field blank. This information can be maintained at the employee level on the General Deduction page.

If you use a deduction rate, you can also enter an amount to be deducted. However, you need to indicate the amount here only if it is the same for all employees within a pay frequency. If it varies from employee to employee, you enter the amounts for each employee on the General Deduction page.

### Deduction Rate or %
Select to enter the deduction rate or percentage. This value can be overridden at the employee level.

### Pay Frequency
Select to add new rows as necessary. For example, to set up a 50 USD per month parking deduction, you could create two rows: one for a semimonthly pay frequency with 25.00 USD to be taken every pay period and the other for a monthly pay frequency with 50 USD. (Note that when you select this option, the Deduction Rate box is not available.)
For a deduction that varies by frequency, you must indicate the amount to be taken each pay period for each frequency. For the 50 USD per month parking deduction, you can set up the deduction for the semimonthly pay group, SM1, so that it applies only to the last pay period of the month. Rather than taking out 25 USD each pay frequency, you take the full 50 USD at the end of the month. To set this up, you need to indicate both the frequency and amount. Set the frequency as semimonthly and enter 50.00 USD. Indicate which semimonthly period to take the deduction for SM1 on the Deduction Table.

General Deduction Page

Use the General Deduction page (GENL_DED_DATA) to assign a general deduction to an employee.

Navigation

Payroll Interface > Update Payroll Information > General Deduction > General Deduction

Image: General Deduction page

This example illustrates the fields and controls on the General Deduction page.

General Deduction

Arthur Erickson

Deduction Code: KCPARK

Calculation Routine

Select how a deduction is calculated for an employee. If you do not make a selection, the deduction is calculated according to the Deduction Table. These routines are identical to the routines on the General Deduction Table. Choose from the following:

Default to Deduction Table: Uses the calculation routine that is specified on the Deduction Table. The Flat/Addl Amount field and Deduction Rate or % field on this page are not used. The system uses only values that are entered on the Deduction Table.

Flat Amount: Establishes the deduction as a flat amount. Enter the amount in the Flat/Addl Amount field, which is treated as...
an amount per pay period. The Deduction Rate or % field is not used.

**Ded stopped by Self Serv User**
(deduction stopped by self-service user)

Select when an employee has stopped a voluntary deduction through a self-service application.

**Deduction End Date**

Select to specify when a deduction should no longer be taken.

### Overriding General Deductions Page

Use the Override General Deductions page (GENL_DED OVERRIDE) to override a general deduction that is assigned to an employee.

### Navigation

Payroll Interface > Update Payroll Information > General Deduction Override > Override General Deductions

**Image: Override General Deductions page**

This example illustrates the fields and controls on the Override General Deductions page.
Chapter 6

Setting Up Tax Data

Understanding Tax Data

Payroll Interface does not calculate taxes. You use Payroll Interface to track and export changes to tax data (primarily W4 withholding information) that occur during a pay period. The third-party payroll system performs all gross-to-net calculations.

To set up tax information correctly, you must understand the data mappings between PeopleSoft HCM and the third-party payroll system. You generally want to export some type of code or numeric value. If an employee works for multiple companies, then you must set up tax data for each company.

Note: To simplify data entry, conversion, and maintenance issues, you may want to have the third-party payroll system manage all tax information.

Tax Location Data

The Tax Location Table (TAX_LOCATION_TBL) component enables you to establish a tax location ID and to identify the work states, provinces, and localities that are associated with each tax location.

Note: If you've selected the Automatic Employee Tax Data option on the Installation Table (INSTALLATION_TBL) component, Product Specific page, PeopleSoft automatically sets up tax data for each work and resident state and locality of each of your employees. Tax distribution records are created for the work state or locality if the tax location represents a single state or locality.

Tax Distribution Data

Every employee must have at least one Tax Distribution record. The system automatically populates the State, Province, and Locality fields from the Tax Location field on the employee's Job Data record. The state and locality codes come from the Tax Location table.

Employee Tax Data

You will use the Employee Tax Data pages to enter and maintain federal, state, and local tax data for each of your employees.

Note: If you've selected the Automatic Employee Tax Data option on the Installation Table component, Product Specific page, PeopleSoft automatically sets up employee tax and tax distribution data when an employee is hired, transfers to another company, or changes jobs.

You can run SQR TAX016, the Default Tax Data Report, to verify automatically created tax data. This report tells you, within the date range that you specify, which employees have default data on their tax records.
Setting Up Tax Location Data

To set up tax locations, use the Tax Location Table (TAX_LOCATION_TBL) component. Tax locations are discussed in the *PeopleSoft HCM Application Fundamentals* product documentation.

**Related Links**

"Defining Tax Locations" (PeopleSoft HCM 9.2: Application Fundamentals)

(CAN) (USA) Setting Up Company Tax Data

To set up company tax data, use the Company State Tax Table (CO_STATE_TAX_TBL), Company Local Tax Table (COMP_LOCAL_TAX_TBL), and Company Tax Table CAN (CO_CAN_TAX_TABLE) components.

Company tax data is discussed in the *PeopleSoft HCM Application Fundamentals* product documentation.

**Related Links**

"(USA) Setting Up the Company State Tax Table" (PeopleSoft HCM 9.2: Application Fundamentals)
"(USA) Setting Up the Company Local Tax Table" (PeopleSoft HCM 9.2: Application Fundamentals)
"(CAN) Setting Up the Canadian Company Tax Table" (PeopleSoft HCM 9.2: Application Fundamentals)

(CAN) (USA) Setting Up and Maintaining Tax Distribution Data

Use the Update Tax Distribution component in Payroll for North America to set up and maintain USA and CAN tax distribution data.

**Related Links**

"Entering Tax Distribution Information" (PeopleSoft HCM 9.2: Payroll for North America)

Pages Used to Set Up and Maintain Tax Distribution Data (USA and CAN)

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Tax Distribution Page</td>
<td>TAX_DISTRIBUTION</td>
<td>(USA) Set up and maintain, for salaried or exempt hourly employees only, a percentage for each U.S. state or locality in which an employee consistently works.</td>
</tr>
<tr>
<td>Page Name</td>
<td>Definition Name</td>
<td>Usage</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Tax Distribution Page</td>
<td>TAX_DIST_CAN</td>
<td>(CAN) Enter the tax distribution information for Canadian employees.</td>
</tr>
</tbody>
</table>

**Update Tax Distribution Page**

(USA, USF) Use the Update Tax Distribution page (TAX_DISTRIBUTION) to set up and maintain, for salaried or exempt hourly employees only, a percentage for each U.S. state or locality in which an employee consistently works.

**Navigation**

Payroll Interface > Update Payroll Information > Tax Distribution USA > Update Tax Distribution

Payroll for North America > Employee Pay Data USA > Tax Information > Update Tax Distribution

Payroll for North America > Employee Pay Data USF > Tax Information > Update Tax Distribution

See the "Update Tax Distribution Page" (PeopleSoft HCM 9.2: Payroll for North America) for USA in Payroll for North America product documentation.

**Update Tax Distribution Page**

(CAN) Use the Update Tax Distribution page (TAX_DIST_CAN) to enter the tax distribution information for Canadian employees.

**Navigation**

Payroll Interface > Update Payroll Information > Tax Distribution CAN > Update Tax Distribution

Payroll for North America > Employee Pay Data CAN > Tax Information > Update Tax Distribution

**Note:** All fields on this page have the same functionality as the fields on the U.S. version of the page except for the following fields.

See the "Update Tax Distribution Page" (PeopleSoft HCM 9.2: Payroll for North America) for CAN in Payroll for North America product documentation.

**Province**

Canada doesn't allow distribution to more than one province.

Select the province in which the employee works.

**Percent of Distribution**

Enter the tax distribution percentage for the province. For Canadian payroll, the distribution percent must be 100 for a single row. The default value is 100.
(USA) Setting Up and Maintaining U.S. Employee Tax Data

Pages Used to Set Up and Maintain U.S. Employee Tax Data

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal Tax Data Page</td>
<td>TAX_DATA1</td>
<td>Set up employee federal tax data.</td>
</tr>
<tr>
<td>State Tax Data Page</td>
<td>TAX_DATA3</td>
<td>Set up employee state tax data.</td>
</tr>
<tr>
<td>Local Tax Data Page</td>
<td>TAX_DATA5</td>
<td>Set up tax data for each locality where an employee works.</td>
</tr>
</tbody>
</table>

Federal Tax Data Page

Use the Federal Tax Data page (TAX_DATA1) to set up employee federal tax data.

Navigation

Payroll Interface > Update Payroll Information > Employee Tax Data USA > Federal Tax Data

Image: Federal Tax Data page (1 of 2)

This example illustrates the fields and controls on the Federal Tax Data page (1 of 2).
This example illustrates the fields and controls on the Federal Tax Data page (2 of 2).

Federal taxes include federal income tax, FICA, and FUT. If the employee works for multiple companies, the tax data is defined by company.

Specify employee status for FICA, FUT exemption and W-2 reporting. (E&G) Enter information for nonresident alien employees. The information in the Tax Treaty/NR Data Table assigns the employee to a tax treaty table and allows the eligible employee to be subject to a reduced tax treaty rate.

Federal, state, and local taxes are implemented as a set of chained pages. To add a new effective-dated row for state or local tax data, you must insert a row on the first page in the chain, the Federal Tax Data page.

Note: Federal, state, and local taxes are implemented as a set of chained pages. To add a new effective-dated row for state or local tax data, you must insert a row on the first page in the chain, the Federal Tax Data page.

Effective Date

Note that the effective date on the Federal Tax Data page is not used to calculate federal income tax withholding. For example, an employee submitted a state W-4 that added a new row to employee tax data in 2020, but did not fill out a new Form W-4 for 2020 (no changes on the Federal Tax Data page for the same row). In this scenario, the system uses the old formula for 2019 to calculate federal income tax withholding.

If you wish to use the W-4 version for 2020 or later, enter an effective date that is on or after January 1, 2020, and select the 2020 or Later version of Form W-4.

Updated By and Date Last Updated

Indicates whether the employee's federal tax data was last updated by an online system user or by the employee in
Employee Self-Service. The date of the most recent update appears.

**Federal Form W-4 Version**

Select the appropriate Form W-4 version. The system determines the federal tax calculation to use to calculate the employee’s federal income tax withholding based on the version you select.

Refer to the "Understanding Federal Form W-4 Versions" (PeopleSoft HCM 9.2: Payroll for North America) topic for more information about these W-4 versions.

**2020 or Later**

Select when creating or inserting an employee tax data record that will include new or changed federal tax data from Federal Form W-4. The system calculates tax based on the Form W-4 2020 elections.

This option applies only to effective dates on or after 01/01/2020.

**2019 or Earlier**

Select when creating or inserting an employee tax data record that will include only new or changed state tax data, local tax data, or both, for an employee who has not yet submitted Federal Form W-4 for tax year 2020 or later. The system calculates tax based on the prior Form W-4, in which allowances are part of the calculation.

**Federal Withholding Elements**

*Note:* For Guam (GU), Virgin Islands (VI), and American Samoa (AS): Although employees in these territories are not subject to federal withholding, they are subject to territory (state) withholding at the same rate as federal. In addition to state withholding elements, the system also uses information in the Federal Withholding Elements section to calculate territory taxes required by each of these territories, specifically:

If the W-4 version is **2019 or Earlier**, the Withholding Allowances field value is used.

If the W-4 version is **2020 or Later**, values of the Multiple Jobs or Spouse Works, Dependent Amount, Other Income, Deductions fields are used.

**Special Withholding Tax Status**

Use this field to indicate whether an employee's federal withholding tax status deviates from the norm. The default is *None*, which means that no special status exists and that federal withholding tax should be calculated based on the employee's gross income and tax status.

- *Maintain taxable gross:* This option is not used with Payroll Interface.

- *No taxable gross; no tax taken:* Select to indicate that the employee is exempt from FWT (Federal Withholding Tax). With this option, the system does not track federal taxable gross balance at all.
Note: For Guam (GU), Virgin Islands (VI), and American Samoa (AS): Be sure to use the No taxable gross; no tax taken special withholding tax status for territory employees; they do not pay federal taxes.

- **None**: Select to indicate that no special status exists and that federal withholding tax should be calculated based on the employee's gross income and tax status.
- **Nonresident alien**: Select this option if the employee is a non-resident alien as indicated on the Form W-4.

For nonresident alien (NRA) employees in commercial organizations (not E&G), the system calculates the withholding tax based on the taxable gross plus the additional amount required by the IRS to be added to the taxable gross for nonresident alien employees. This additional amount is stored on the Special Tax Amts page on the State Tax Table entry for State = $U (U.S. Federal).

(E&G) For nonresident alien employees in education and government organizations, the system determines the taxable gross for FWT based on earnings that exceed the treaty maximum amount defined on the Tax Treaty table. The system calculates FWT based on the taxable gross plus the additional amount required by the IRS to be added to the taxable gross for nonresident alien employees. This additional amount is stored on the Special Tax Amts page on the State Tax Table entry for State = $U (U.S. Federal).

### Tax Status

Select the appropriate tax status for federal withholding taxes as indicated on the employee's completed Form W-4 in line 1(c). Values are:

- **Head of Household**. This value appears when the 2020 or Later option is selected.
- **Married**
- **Single**

Note: For Guam (GU), Virgin Islands (VI), and American Samoa (AS): When you select a tax status on the Federal Tax Data page, the same update occurs on the State Tax Data page automatically.

These fields appear when the 2020 or Later option is selected.

### Multiple Jobs or Spouse Works

Select if the check box in line 2 (c) of the employee’s Form W-4 is selected.
This field becomes editable when the Special Withholding Tax Status field is set to None.

**Dependent Amount**

Enter the dependent amount in line 3 of the employee’s Form W-4. The line 3 amount may include other tax credits indicated by the employee.

This field becomes editable when the Special Withholding Tax Status field is set to None or Nonresident alien.

**Other Income**

Enter the other income amount in line 4(a) of the employee’s Form W-4.

This field becomes editable when the Special Withholding Tax Status field is set to None.

**Deductions**

Enter the deduction amount in line 4(b) of the employee’s Form W-4.

This field becomes editable when the Special Withholding Tax Status field is set to None.

**Extra Withholding**

Enter the extra withholding amount in line 4(c) of the employee’s Form W-4.

This field becomes editable when the Special Withholding Tax Status field is not set to No taxable gross; no tax taken.

These fields appear when the 2019 or Earlier option is selected.

**Check here and select Single status if married but withholding at single rate**

Select the appropriate tax status for federal withholding taxes as indicated on the employee's completed Form W-4.

If the employee has selected "Married but withhold at single rate" on the W-4 form, you must select both the Single option and the check box marked "Check here and select Single status if married but withholding at single rate." This setting results in the employee being reported with tax status W.

*Note:* If you select the check box, the system automatically selects the Single option when you save.

**Withholding Allowances**

Enter the number of allowances that the employee claims for federal withholding tax purposes. This number should match the number on the employee's Form W-4.

**Additional Amount and Additional Percentage**

Use these fields to indicate that additional federal withholding taxes are to be taken. You can specify both an amount and a percentage, if appropriate. When you enter an additional percentage, the additional withholding is calculated by taking a percentage of the taxable wages.

The effect of this field depends on the option that you select in the Special Withholding Tax Status field.

**Federal Unemployment Tax**

**Exempt from FUT**
Select this check box if the employee is exempt from FUT (Federal Unemployment tax).

**W-4 Processing Status**

**None**
Select to indicate no change.

**Notification Sent**
Select to indicate that the employee has been notified to submit a new Form W-4.

**New W-4 Received**
Select to indicate that a new Form W-4 has been received.

**Note:** An authorized user can manually change an employee's W-4 processing status to New W-4 Received when an employee submits an updated Form W-4. You can either do this on the current record or on a new effective-dated row. Note that the effective date of the new row must be earlier than or equal to February 15 of the new tax year. If future-dated records exist, the W-4 processing status of those records must also be set to New W-4 Received. You can change future-dated rows in Correction mode only.

**Lock-In Letter Details**

Use the Lock-In Letter Details group box to process lock-in letters from the IRS that limit employee withholding allowances.

**Letter Received**
Select this check box if a letter has been received from the Internal Revenue Service (IRS) specifying the allowances an employee is allowed to take.

**Limit On Allowances**
Enter the maximum number of allowances possible. The value that you enter in the Withholding Allowances field cannot exceed the value that you enter in this field.

**State Tax Options**

These fields and controls are not relevant to Payroll Interface processing.

**Tax Treaty/Non-Resident Data**

These fields and controls are not relevant to Payroll Interface processing.

**(E&G) Education and Government**

Use this group box to enter information that related to reduced tax treaty rates for eligible employees. To claim benefits of a treaty, an employee must have a visa and be a resident of one of the treaty countries. An employee can claim benefits for only one treaty at any particular time. Employees who want to claim benefits under a tax treaty must submit a written statement to their employer, along with applicable forms.
Use the Form 8233 Received and Form W8 Received options to indicate the employee's eligibility for reduced tax treaty rates.

**Treaty Expiration Date**

The treaty expiration date appears. The system calculates the date based on the date of entry and rules that are established on the Tax Treaty/NR Data table.

**Form 8233 Received**

If the NRA employee filed a Form 8233, select Yes and enter the appropriate dates in the Form 8233 Effective Date and From 8233 Expiration Date fields. Form 8233 is required for all income codes except 12 (royalties) and 15 (scholarships and fellowships).

**Form W8 Received**

If the NRA employee filed a Form W8 for scholarship and fellowship income or royalties, select Yes and enter the appropriate dates in the Form W8 Effective Date and Form W8 Expiration Date fields.

### State Tax Data Page

Use the State Tax Data page (TAX_DATA3) to set up employee state tax data.

**Navigation**

Payroll Interface > Update Payroll Information > Employee Tax Data USA > State Tax Data
Image: State Tax Data page

This example illustrates the fields and controls on the State Tax Data page.

**State Information**
Use the options in the State Information group box to indicate an employee's primary work state and residency status.

**State**
Enter the employee's primary work state. The work state is derived from the employee's tax location on the Job Data Table.

**Resident**
Select to indicate whether the employee is a resident of the primary work state. If the employee does not reside in the primary work state, create an additional state entry and select the Resident option.

**Non-Residency Statement Filed**
Not used with Payroll Interface.

**SDI Status** (state disability insurance status)
Select the employee's SDI status.
**UI Jurisdiction** (unemployment insurance jurisdiction)

Select to indicate the state of jurisdiction. If an employee has only one state (the resident state), that state will become the state of jurisdiction by default.

(DC, MA, and WA) The UI Jurisdiction check box must be selected for the Family Leave tax, Medical Leave tax, or both, to be calculated.

If an employee has two states (one resident, the other nonresident), the nonresident state will become the state of jurisdiction by default.

If an employee has multiple nonresident states and no state is indicated as the state of jurisdiction, you will get a message to select UI Jurisdiction on one record.

**Exempt from SUT** (exempt from state unemployment taxes)

Select to indicate whether the employee is exempt from SUT taxes.

**FLI Status** (family leave insurance status)


Select *Exempt* if the employee is exempted from participation in the state plan, and the employee's earnings are exempt from the FLI tax. In addition, if the employer already provides a paid leave benefit to the workforce, the employer may be eligible to receive an exemption from collecting, remitting, and paying contributions for paid family leave. This option is not valid for DC.

Select *Not Applicable* if the state plan does not apply to the employee. For example, WA employees who are covered under a collective bargaining agreement that was in existence on or before the state plan became effective do not participate in state plan until the agreement is reopened, renegotiated, or expires.

Select *Subject* if the employee is covered by the state plan, and employee's earnings are subject to FLI tax.

Select *Voluntary Plan* if the company has a voluntary family leave insurance plan that covers the employee. This option is not valid for DC and MA.

**FMLI Status** (family medical leave insurance status)

(CT) Indicate the employee's status for the Connecticut Paid Family Medical Leave insurance tax:

Select *Exempt* if the employee is exempted from participation in the state plan, and the employee's earnings are exempt from the FMLI tax.

Select *Not Applicable* if the state plan does not apply to the employee.
Select *Subject* if the employee is covered by the state plan administered by the CT Paid Leave Authority, and employee's earnings are subject to FMLI tax.

Select *Voluntary Plan* if the company has a voluntary family medical leave insurance plan that covers the employee.

**MLI Status** *(medical leave insurance status)*

(MA and WA) Indicate the employee's status for the Massachusetts Medical Leave or Washington Paid Medical Leave insurance tax:

Select *Exempt* if the employee is exempted from participation in the state plan (for example, federal employees), and the employee's earnings are exempt from the MLI tax. In addition, if the employer already provides a paid leave benefit to the workforce, the employer may be eligible to receive an exemption from collecting, remitting, and paying contributions for paid medical leave. This option is not valid for DC.

Select *Not Applicable* if the state plan does not apply to the employee. For example, employees who are covered under a collective bargaining agreement that was in existence on or before the state plan became effective are not subject to state plan coverage until the agreement is reopened, renegotiated, or expires. In this case, employers do not withhold premiums from employees, or pay the employer share of their premium.

Select *Subject* if the employee is covered by the state plan and the employee's earnings are subject to MLI tax.

Select *Voluntary Plan* if the company has a voluntary medical leave insurance plan that covers the employee. This option is not valid for DC and MA.

**Oregon-Specific Page Element**

**Do Not Withhold Transit Tax**

This check box appears only if the state is *OR*, and the tax report type selected for the company on the "(USA) Tax Details Page" (PeopleSoft HCM 9.2: Application Fundamentals) is *not* 1099R.

Select this checkbox if you do not wish to withhold Oregon Statewide Transit Tax from payments that are made to the employee. For example, if the employee is an Oregon resident who works outside of the state, the out-of-state employer can, as a courtesy, withhold transit tax for the employee but it is not required. If the withholding is disabled, it is the employee’s responsibility to pay the tax when he or she files for personal income tax return.
Note: Retirees are exempted from the Oregon Statewide Transit Tax. No tax will be withheld from payments to individuals who are paid in companies that have the 1099R tax report type selected on the "(USA) Tax Details Page" (PeopleSoft HCM 9.2: Application Fundamentals). See "Understanding the Oregon Statewide Transit Tax" (PeopleSoft HCM 9.2: Payroll for North America)

### State Withholding Elements

Use fields in this group box to enter state-specific withholding information.

<table>
<thead>
<tr>
<th><strong>Special Withholding Tax Status</strong></th>
<th>Specify the employee's special withholding tax status. The system calculates the withholding tax based on the value you select here and other factors.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintain taxable gross:</td>
<td>This option is not used with Payroll Interface.</td>
</tr>
<tr>
<td>No taxable gross; no tax taken:</td>
<td>Select to indicate that the employee is exempt from state withholding tax.</td>
</tr>
<tr>
<td>None:</td>
<td>Select to indicate that no special status exists and that state withholding tax should be calculated based on the employee's gross income, tax status, and withholding allowance.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Tax Status</strong></th>
<th>Select to indicate the employee's tax status. Repeat for each state where the employee pays taxes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Guam (GU), Virgin Islands (VI), and American Samoa (AS):</td>
<td>The tax status for the employee must be identical at the federal and state levels.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Withholding Allowances</strong></th>
<th>Enter the number of allowances that the employee claims for SWT purposes. This number should match the number on the employee's state withholding allowance certificate.</th>
</tr>
</thead>
<tbody>
<tr>
<td>For states that have their own withholding allowances form, the system displays informational text explaining where this information appears on the state form.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Additional Amount and Additional Percentage</strong></th>
<th>Use these fields to indicate an increase (or, for certain states, a decrease) in the amount of taxes to be deducted. You can specify both an amount and a percentage, if appropriate, provided that your payroll system accepts this information.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Additional Allowances</strong></th>
<th>If applicable, enter any additional allowances that the employee claims for SWT purposes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>For states that have their own withholding allowances form, the system displays informational text explaining where this information appears on the state form.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 6

**Arizona-Specific Page Element**

**AZ Withholding Percent**  
Enter the percentage of federal withholding that constitutes the Arizona state withholding.

**California-Specific Page Element**

The California Wage Plan Code group box appears only when the state is CA.

The California Wage Plan Code is used only by employees of the California Public Employees Retirement System (PERS).

**Disability/Unemployment Plan**  
Select State/State (State Disability Plan and State Unemployment) unless instructed otherwise by your company's tax advisors.

**Connecticut-Specific Page Element**

**CT Only**  
Indicate whether the withholding adjustment amount is an Increase or Decrease amount.

**Louisiana-Specific Page Element**

**LA Only**  
Indicate whether the withholding adjustment amount is an Increase or Decrease amount.

**Mississippi-Specific Page Element**

**MS Annual Exemption Amount**  
Used only for Mississippi. Select to enter the annual exemption amount.

**Puerto Rico-Specific Page Element**

**PR Retirement Plan**  
(E&G) This check box is visible only if Education and Government is selected on the Installation table - Products page. Select to indicate that the employee is a participant in a government pension or retirement plan of the Commonwealth of Puerto Rico.

**Lock-In Letter Details**

**Letter Received**  
Select this check box if a letter has been received from the state taxing authority that specifies the allowances an employee is allowed to take.

**Limit On Allowances**  
Enter the maximum number of allowances possible. The value that you enter in Withholding Allowances field cannot exceed the value that you enter in this field.
Local Tax Data Page

Use the Local Tax Data page (TAX_DATA5) to set up tax data for each locality where an employee works.

Navigation

Payroll Interface > Update Payroll Information > Employee Tax Data USA > Local Tax Data

Image: Local Tax Data page

This example illustrates the fields and controls on the Local Tax Data page.

Note: The Local Tax Data page has three scroll areas. The outer scroll area corresponds to the effective dates entered on the Federal Tax Data page, the middle scroll area corresponds to the states entered on the State Tax Data page, and the inner scroll area corresponds to the localities that you enter on this page.

Local Information

Use the options in the Location Information group box to identify each tax locality where an employee lives or works. Before assigning localities to employees, you must first establish localities on the Company Local Tax Table.
Note: If you are setting up local tax information for an employee who lives or works in more than one state, you must enter the appropriate local tax information for each state. An employee can also have more than one local residence. You will need multiple resident locality entries if two different taxes exist for the same locality.

Note: For Indiana Localities: In Indiana, the employee's county of residence is the first determining factor for tax withholding. If the county where an employee resides on January 1 of any year imposes a tax, you must withhold that tax. The employee is liable for the tax for the entire year, even if he or she moves to a nontaxing county. If the county of residence does not impose a tax, but the county in which the principal place of work is located does, withhold at the appropriate nonresident rate.

For employees moving from out of state into a taxing Indiana locality, withholding does not begin until January 1 of the next year, when residence determination is made.

Resident
Select to indicate that the locality is a resident locality.

Other Work Locality
Select to link multiple local work taxes together when you have more than one work tax for a given locality. This entry links to another local work tax code, which is then entered on another Locality row.

Note: When setting up Indiana localities at the employee level, you do not need to set up any localities that have an alpha suffix.

Local Withholding Elements

Special Withholding Tax Status
Use the options in the Special Tax Status group box to indicate whether an employee's local withholding tax status deviates from the norm.

- Maintain taxable gross: This option is not used with Payroll Interface.
- No taxable gross; no tax taken: Select to indicate that the employee is exempt from LWT. The taxable base for LWT will not reflect the pay that they receive.
- None: Select this option if no special tax status exists.

Tax Status
Select the appropriate tax status for local withholding taxes.

Withholding Allowances
Enter the number of allowances that the employee claims for local withholding tax purposes.

Additional Amount and Additional Percentage
Use these fields to indicate that additional local taxes are to be taken. You can specify both an amount and a percentage, if appropriate, provided that your payroll system accepts this information.
(CAN) Setting Up and Maintaining Canadian Employee Tax Data

Use the Update Employee Tax Data component in Payroll for North America to set up and maintain CAN employee tax data.

Related Links
"(CAN) Entering and Maintaining Canadian Income Tax Data" (PeopleSoft HCM 9.2: Payroll for North America)

Pages Used to Set Up and Maintain Canadian Employee Tax Data

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canadian Income Tax Data Page</td>
<td>TAX_DATA_CAN1</td>
<td>Set up Canadian income tax data.</td>
</tr>
<tr>
<td>Quebec Income Tax Data Page</td>
<td>TAX_DATA_CAN3</td>
<td>Set up Quebec income tax data.</td>
</tr>
<tr>
<td>Provincial Income Tax Data Page</td>
<td>TAX_DATA_CAN4</td>
<td>Set up provincial income tax data.</td>
</tr>
</tbody>
</table>

Canadian Income Tax Data Page

(CAN) Use the Canadian Income Tax Data page (TAX_DATA_CAN1) to set up Canadian Income Tax (CIT), including specifying special CIT withholding status, TD1 exemptions and adjustments, and other tax credits.

Navigation
Payroll Interface >Update Payroll Information >Employee Tax Data CAN >Canadian Income Tax Data

Payroll for North America > Employee Pay Data CAN > Tax Information > Update Employee Tax Data > Canadian Income Tax Data


Quebec Income Tax Data Page

(CAN) Use the Quebec Income Tax Data page (TAX_DATA_CAN3) to enter QIT withholding status, exemption, and tax credit information for employees based in Quebec.

Navigation
Payroll Interface >Update Payroll Information >Employee Tax Data CAN >Quebec Income Tax Data

Payroll for North America > Employee Pay Data CAN > Tax Information > Update Employee Tax Data > Quebec Income Tax Data

**Provincial Income Tax Data Page**

(CAN) Use the Provincial Income Tax Data page (TAX_DATA_CAN4) to enter provincial TD1 personal tax credit amounts.

**Navigation**

Payroll Interface > Update Payroll Information > Employee Tax Data CAN > Provincial Income Tax Data

Payroll for North America > Employee Pay Data CAN > Tax Information > Update Employee Tax Data > Provincial Income Tax Data

Chapter 7

Setting Up Payroll Schedules

Understanding Payroll Schedules

To track and export changes that occur to employee-level payroll data, you run the Payroll Interface processes at least once each pay period using the payroll schedules that you establish in PeopleSoft HCM.

Payroll schedules consist of pay groups and pay calendars. Pay groups tell the system which employees to process. Pay calendars tell the system when to process these employees.

To enable payroll scheduling, perform these tasks:

1. Set up the pay groups.
2. Set up a balance ID—required for pay calendars.
3. Set up a pay run ID—required for pay calendars.
4. Set up the pay calendars.

Note: Set up your pay groups and pay calendars following the requirements of the third-party payroll system. The payroll schedules that you use to run the Payroll Interface processes should coincide with the payroll schedules that are used by the third-party payroll system.

Setting Up Pay Groups

To set up pay groups, use the Pay Group Table (PAYGROUP_TABLE) component.

Pages Used to Set Up Pay Groups

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Group Table - Definition Page</td>
<td>PAYGROUP_TABLE1</td>
<td>Set up a pay group and its basic characteristics. Enter the PI configuration ID.</td>
</tr>
<tr>
<td>Process Control Page</td>
<td>PAYGROUP_TABLE2</td>
<td>Set up process controls and establish default employee types.</td>
</tr>
<tr>
<td>Calc Parameters Page</td>
<td>PAYGROUP_TABLE3</td>
<td>Set up other processing parameters for pay groups.</td>
</tr>
<tr>
<td>Page Name</td>
<td>Definition Name</td>
<td>Usage</td>
</tr>
<tr>
<td>-----------</td>
<td>----------------</td>
<td>-------</td>
</tr>
<tr>
<td>Paysheets Page</td>
<td>PAYGROUP_TABLE4</td>
<td>Set up the proration rules and paysheet options for each pay group that you establish. This page is used rarely by Payroll Interface.</td>
</tr>
<tr>
<td>Check Distribution Page</td>
<td>PAYGROUP_TABLE5</td>
<td>Set up the order in which you want to sort paychecks and to select address and delivery options. This page is used rarely by Payroll Interface.</td>
</tr>
<tr>
<td>Check Sequencing Page</td>
<td>PAYGROUP_TABLE6</td>
<td>Set up print sequence options. This page is used rarely by Payroll Interface.</td>
</tr>
<tr>
<td>Report Parameters Page</td>
<td>PAYGROUP_TABLE7</td>
<td>Define other report parameters for pay groups. This page is used rarely by Payroll Interface.</td>
</tr>
<tr>
<td>Bank/Tip Info Page (Bank/Tip Information)</td>
<td>PAYGROUP_TABLE8</td>
<td>Set up the bank from which employees are to be paid. Enter the source bank ID.</td>
</tr>
<tr>
<td>Time and Labor Page</td>
<td>PAYGROUP_TABLE9</td>
<td>This page is never used by Payroll Interface. Payroll Interface cannot process dynamic time and labor data.</td>
</tr>
</tbody>
</table>

**Understanding Pay Groups**

Pay groups are set up using the Pay Group Table component. The PI Configuration ID field on the Pay Group Table - Definition page is important for Payroll Interface. The PI Configuration ID links your PeopleSoft pay groups to the third-party payroll system.

*Warning!* If the PI Configuration ID is not set up correctly, the Payroll Interface processes will not function properly.

See Setting Up the Configuration Table.

Additional information about pay groups is discussed in *PeopleSoft HCM Application Fundamentals*:


**Pay Group Table - Definition Page**

Use the Pay Group Table - Definition page (PAYGROUP_TABLE1) to set up a pay group and its basic characteristics.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Payroll > Pay Group Table > Definition
Image: Pay Group Table - Definition page

This example illustrates the fields and controls on the Pay Group Table - Definition page.

### PI Configuration ID (Payroll Interface Configuration ID)

Select to enter the Payroll Interface configuration ID. **Warning!** If the PI configuration ID is not set up correctly, the Payroll Interface processes will not function properly.

### Process Control Page

Use the Process Control page (PAYGROUP_TABLE2) to set up process controls and establish default employee types.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Payroll > Pay Group Table > Process Control
Image: Process Control page

This example illustrates the fields and controls on the Process Control page.

<table>
<thead>
<tr>
<th>Definition</th>
<th>Process Control</th>
<th>Calc Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>GB1 Global Business Institute</td>
<td></td>
</tr>
<tr>
<td>Pay Group</td>
<td>KU4 US Monthly</td>
<td></td>
</tr>
</tbody>
</table>

Pay Group Information

<table>
<thead>
<tr>
<th>Effective Date</th>
<th>12/28/2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Active</td>
</tr>
</tbody>
</table>

Processing Control

<table>
<thead>
<tr>
<th>Industry</th>
<th>Core</th>
</tr>
</thead>
<tbody>
<tr>
<td>Industry Sector</td>
<td>Core</td>
</tr>
</tbody>
</table>

Employee Type(s) for Pay Group

<table>
<thead>
<tr>
<th>Employee Type</th>
<th>Exempt</th>
<th>Non-exempt</th>
</tr>
</thead>
</table>

Calc Parameters Page

Use the Calc Parameters (calculate parameters) page (PAYGROUP_TABLE3) to set up other processing parameters for pay groups.

Navigation

Set Up HCM > Product Related > Payroll Interface > Payroll > Pay Group Table > Calc Parameters

Image: Calc Parameters page

This example illustrates the fields and controls on the Calc Parameters page.

<table>
<thead>
<tr>
<th>Definition</th>
<th>Process Control</th>
<th>Calc Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>GB1 Global Business Institute</td>
<td></td>
</tr>
<tr>
<td>Pay Group</td>
<td>KU4 US Monthly</td>
<td></td>
</tr>
</tbody>
</table>

Pay Group Information

<table>
<thead>
<tr>
<th>Effective Date</th>
<th>12/28/2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Active</td>
</tr>
</tbody>
</table>

Earnings Program ID: KU1
US Earnings Program
Holiday Schedule: KU1
US Holiday Schedule

Earnings

<table>
<thead>
<tr>
<th>Regular Hours</th>
<th>Regular Earnings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overtime Hours</td>
<td>Holiday</td>
</tr>
</tbody>
</table>

Default Benefit Program: KU1
Retro Pay Program ID: KU1
Retro Pay Trigger Program ID: KU1
Final Check Program ID: KU1

FLSA Required

Pages 1 - 3  Pages 4 - 6  Pages 7 - 9
Bank/Tip Info Page

Use the Bank/Tip Info (Bank/Tip Information) page (PAYGROUP_TABLE8) to set up the bank from which employees are to be paid.

Navigation

Set Up HCM > Product Related > Payroll Interface > Payroll > Pay Group Table > Pages 7–9 > Bank/Tip Info

Image: Bank/Tip Info page

This example illustrates the fields and controls on the Bank/Tip Info page.

<table>
<thead>
<tr>
<th>Report Parameters</th>
<th>Bank/Tip Info</th>
<th>Time and Labor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company GBI Global Business Institute</td>
<td>Source Bank ID KU03 West America Bank</td>
<td>Direct Deposit Bank ID</td>
</tr>
<tr>
<td>Pay Group KU4 US Monthly</td>
<td>Minimum Net Pay</td>
<td>Maximum Net Pay $10,000</td>
</tr>
<tr>
<td>Pay Group Information</td>
<td>Find First 1 of 2 Last</td>
<td>Time and Labor</td>
</tr>
<tr>
<td>Effective Date 12/26/2004</td>
<td>Status Active</td>
<td>Minimum Net Pay</td>
</tr>
<tr>
<td>Delay Withholding of Taxes</td>
<td>Adjust to Minimum Wage</td>
<td>Source Bank ID KU03 West America Bank</td>
</tr>
<tr>
<td>Min Wage Adjustment Earnings Code</td>
<td>TPA</td>
<td>ST - Tip Adjustment</td>
</tr>
<tr>
<td>Tip Credit Earnings Code</td>
<td>TCR</td>
<td>Tip Credit</td>
</tr>
</tbody>
</table>

Source Bank ID

Select the bank from which employees in this pay group are to be paid.

Note: This field is not used by Payroll Interface. However, to save the pay group, you must enter a value.

Setting Up Balance IDs

To set up balance IDs, use the Balance ID Table (BALANCE_ID_TABLE) component.

Setting Up Pay Run IDs

To set up pay run IDs, use the Pay Run Table (PAY_RUN_TABLE) component.


Setting Up Pay Calendars

To set up pay calendars, use the Pay Calendar Table (PAY CALENDAR_TABLE) component.

Chapter 8

Cloning a Payroll Interface Definition

Understanding the Cloning Process

Rather than setting up an entirely new interface definition, it may be easier to begin an implementation by cloning (copying) an existing interface definition, either a definition that you set up previously or one of the sample data definitions that is delivered with Payroll Interface.

PI Cloning Utility

The Payroll Interface control tables, sometimes referred to as the setup tables, are a set of 10 components that you use to set up an interface definition.

To create a copy of an interface definition, you use the PI cloning Utility to clone five of these components: PS Tables (PS_TABLES), Field Definition Table (INTRFC_FIELD), Group Table (INTRFC_GROUP), Instance Table (INTRFC_INSTANCE), and Definition Table (INTRFC_DEFINITION).

It is not necessary to clone these five components: System Table (SYSTEM_TABLE), Employee Table (INTRFC_EMPLOYEE), Process Table (INTRFC_PROCESS), File Handle Table (INTRFC_FILEHANDLE), and Configuration Table (INTRFC_CONFIG).

The PI Cloning Utility has two sub-utilities, the System ID Cloning Utility and the Interface Definition Cloning Utility. This table lists which components and underlying tables each sub-utility clones:

<table>
<thead>
<tr>
<th>PI Cloning Utility</th>
<th>Component</th>
<th>Underlying Tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the PI Cloning Utility, System ID Cloning Utility option to clone these components and the underlying tables, which include the System ID field as a key field.</td>
<td>PS Tables</td>
<td>• PI_PS_RECORD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PI_PSREC_FLD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PI_PS_REC_LANG</td>
</tr>
<tr>
<td>Field Definition Table</td>
<td></td>
<td>• PI_FIELD_TBL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PI_FIELD_LANG</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PI_FIELD_XLAT</td>
</tr>
<tr>
<td>Group Table</td>
<td></td>
<td>• PI_GROUP_TBL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PI_GROUP_LANG</td>
</tr>
<tr>
<td>Instance Table</td>
<td></td>
<td>• PI_INSTANCE_TBL</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• PI_INSTANC_LANG</td>
</tr>
</tbody>
</table>
Cloning a Payroll Interface Definition

Chapter 8

PI Cloning Utility

<table>
<thead>
<tr>
<th>Component</th>
<th>Underlying Tables</th>
</tr>
</thead>
</table>
| Use the PI Cloning Utility, Interface Definition Cloning Utility option to clone this component and the underlying tables, which include the File ID as a key field. | • PI_DEFN_FILE
• PI_DEFN_F_LANG
• PI_DEFN_RECORD
• PI_DEFN_R_LANG
• PI_DEFN_FIELD |

Cloning Procedure

Use the P.I. Cloning Utility Application Engine process (PI_CLONE) to clone an existing interface definition. The steps that you must perform before and after running the utility are outlined here.

To clone an interface definition:

1. Set up a system ID for the new interface definition using the System Table component.
2. Set up the file handles using the File Handle Table component.
   For each file ID you will clone in step 3, create a file handle.
3. Clone the existing interface definition using the P.I. Cloning Utility process.
4. Update the file definitions using the Definition Table component.
   For each file ID that you cloned in step 3, enter the system ID that you created in step 1.
5. Set up a configuration ID using the Configuration Table component.
   Enter the system ID that you created in step 1, the file handles that you created in step 2, and the file IDs that the cloning process created in step 3.

See PeopleTools: Process Scheduler.

After you have performed these steps, you can manually configure the interface definition following the requirements of the third-party payroll system.

See:

- Understanding the Control Tables
- Working with Interface Definitions

Things to Consider

Verify the system ID after you have cloned the components. You may need to manually change the System ID field in the Definition Table component - Interface Definition File page (this is step 4 in the cloning procedure).

Verify the process IDs after you have cloned the components. Some processes may be specific to certain file types. For example, if you are cloning from a logical (LOG) file type to a comma-separated value (CSV) file type, then you don't want to retain Process ID = 00001 in the Deduction record definition.
Long description fields in the PS Tables component and in the Definition Table component - Interface Definition Record page become blank on the cloned records.

The PI_EMPLID_TBL table maps the PeopleSoft EMPLID to the third-party payroll system employee ID. When the Export process is run, every employee is assigned a row in this table. If the PI_EMPLID_TBL table contains data, you must delete it before running the Export process with the new (cloned) interface definition. If you do not delete the data, you will get a "duplicate rows" error message when you run the Export process.

**Note:** The PI_EMPLID_TBL table contains five fields: EMPLID, EMPL_RCD, EFFEDT, PI_SYSTEM_ID, and PI_EMPLID. To delete the data from this table, use this SQL statement: DELETE FROM PI_EMPLID_TBL.

See Deduction Processing

---

**Cloning an Interface Definition**

**Pages Used to Clone an Interface Definition**

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clone Payroll Interface Page</td>
<td>PI_RUNCTL_SID_PNL</td>
<td>Select the cloning options and run the PI Cloning Utility Application Engine process (PI_CLONE) to copy an interface definition.</td>
</tr>
</tbody>
</table>

**Clone Payroll Interface Page**

Use the Clone Payroll Interface page (PI_RUNCTL_SID_PNL) to select the cloning options and run the PI Cloning Utility Application Engine process (PI_CLONE) to copy an interface definition.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Clone Payroll Interface > Clone Payroll Interface
This example illustrates the fields and controls on the Clone Payroll Interface page.

**Clone Payroll Interface**

<table>
<thead>
<tr>
<th>Run Control ID</th>
<th>PS</th>
<th>Report Manager</th>
<th>Process Monitor</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>Run</td>
</tr>
</tbody>
</table>

**Clone System ID**

Use the System ID Cloning Utility to copy the PS Tables, Field Table, Group Table, and Instance Table components and system IDs.

- **Clone from Sys ID** (clone from system ID)
  - Select the system ID of the interface definition that you want to copy (the existing interface definition).

- **Clone to Sys ID** (clone to system ID)
  - Select the system ID of the interface definition that you want to create (the new interface definition).

  **Note:** You must set up the system ID using the System Table component before you can enter it here.

  See Setting Up the System Table.

- **PS Tables, Field Table, Group Table, and Instance Table**
  - Select the components that you want to copy.

**Clone Interface Definition**

Use the Interface Definition Cloning Utility to copy the Definition Table component and file IDs.

- **Clone from File ID**
  - Select the file ID of the export or import file that you want to copy.
Clone to File ID

Select the file ID of the export or import file that you want to create.

**Note:** If you are copying more than one file ID (for example, the CSV sample data set includes four export files), set up and run the Interface Definition Cloning Utility separately for each file ID.
Understanding the Control Tables

The Payroll Interface control tables, sometimes referred to as the setup tables, are a set of 10 components that you use to set up the export and import interface definitions. As shown in the following table, the components can be organized into four general usage groups. Although some dependencies exist, all 10 components work together and, for the most part, can be set up in any order.

<table>
<thead>
<tr>
<th>Usage</th>
<th>Component</th>
</tr>
</thead>
</table>
| Use these components to identify the third-party payroll system and the employees who will be processed each pay period. | • System Table (SYSTEM_TABLE) component  
• Employee Table (INTRFC_EMPLOYEE) component |
| Use these components to identify the PeopleSoft HCM tables and fields that store the payroll-related data, and to define the file and data formatting. | • PS Tables (PS_TABLES) component  
• Field Definition Table (INTRFC_FIELD) component  
• Definition Table (INTRFC_DEFINITION) component |
| Use these components to set up additional processing for the payroll-related data. The processing can be simple (grouping fields) or more complex (invoking special COBOL routines). | • Group Table (INTRFC_GROUP) component  
• Instance Table (INTRFC_INSTANCE) component  
• Process Table (INTRFC_PROCESS) component |
| Use these components to identify the export or import files and to connect the PeopleSoft HCM pay groups to the third-party payroll system for processing. | • File Handle Table (INTRFC_FILEHANDLE) component  
• Configuration Table (INTRFC_CONFIG) component |

Note: Beginning an implementation is often easier if you clone (copy) an existing interface definition. After you have created the clone, you can use the control tables to further configure the export or import interface definition.

Related Links
Cloning an Interface Definition

Common Elements Used in Working with Control Tables

Null Blank Character Flds (null blank character fields), and Null Zero
Select to indicate whether blank and zero PeopleSoft character fields should be written to the export file as null data. Null
**Setting Up the System Table**

To set up the System Table, use the System Table (SYSTEM_TABLE) component.

### Pages Used to Set Up the System Table

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface System Table 1 Page</td>
<td>PI_SYSTEM_PNL</td>
<td>Set up system IDs.</td>
</tr>
<tr>
<td>Interface System Table 2 Page</td>
<td>PI_SYSTEM1_PNL</td>
<td>Set up payroll statuses.</td>
</tr>
</tbody>
</table>

### Understanding the System Table

Use the System Table to set up a system ID that identifies the third-party payroll system.

Payroll Interface delivers several system IDs, including CSV, PHY, LOG, and NFC. These system IDs correspond to these delivered data formats: comma-separated-values, physical, logical, and National Finance Center. You can use the delivered system IDs or create your own.

You can use multiple system IDs to set up interface definitions for multiple third-party payroll providers. The system IDs separate the information required for each third-party implementation.

### Related Links

- [Sample Data Definitions](#)

### Interface System Table 1 Page

Use the Interface System Table 1 page (PI_SYSTEM_PNL) to set up system IDs.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > System Table > Interface System Table 1
This example illustrates the fields and controls on the Interface System Table 1 page.

### System ID
Select to enter a system ID that identifies the third-party payroll system. You can use one of the system IDs delivered with Payroll Interface *(CSV, LOG, NFC, PHY, and so on)* or you can define your own.

### System Code
Select the appropriate system code.

- **ADP Interface**: ADP third-party payroll system.
- **Other**: Third-party payroll system other than ADP.

### Version
For documentation only. Payroll Interface does not use this value.

### Export
Select to indicate how data changes are exported.

- **Field Change Only**: Export only fields with changed data.
- **Record With Field Changes**: Export entire records, but only those with fields that have changed.

**Note**: The physical file format (PHY) does not export field changes only. The entire row is exported if a defined field changes.

### Convert
Select to indicate how employees are identified by the third-party payroll system.

- **Using Interface Employee Table**: Converts the PeopleSoft EMPLID to the third-party payroll system employee ID (PI EmplID).
**Note:** If you select this option, you **must** map the PeopleSoft EMPLID to the third-party payroll system employee ID (populate the PI_EMPLID_TBL table) for *each* employee before you run the Export process. If you do not do this, the system will issue an error message. Perform the mapping by either (1) manually entering the third-party payroll system employee ID in the Employee Table - Interface Employee Table page, PI Emplid field or (2) using PeopleCode to automate the process, when possible. You must update the mapping when employee changes occur, for example, new hires or terminations.

- **Using PeopleSoft Employee ID:** Automatically inserts the PeopleSoft EmplID in the Employee Table - Interface Employee Table page, PI Emplid field (and populates PI_EMPLID_TBL) when you run the Export process.

- **Using National ID:** Automatically inserts an applicable national identification code (for example, the employee's Social Security Number or Social Insurance Number) in the Employee Table component - Interface Employee Table page, PI Emplid field (and populates the PI_EMPLID_TBL table) when you run the Export process.

**Employee Field ID**

Select to indicate which Payroll Interface field contains the employee ID. The value of the employee field ID is defined on the Field Definition Table component - Interface Field2 page. Because of the three convert options, the field that you select as the employee field ID does not need any PS Record/PS fields mapped to it on the Interface Field2 page.

**Effect Date Transaction Ind**

(Effective date transaction indicator)

Select *Current* to export only data that's current at the end of the pay period; select *All* to export both current and retroactive data.

**Note:** Be sure to verify that your payroll vendor's import utility accepts multiple effective-dated transactions.

The effective date indicator performs two main functions:

- **Selecting employees for processing:** If you choose *All*, all employees who have *ever* been in the pay group being processed are eligible for processing. If you choose *Current*, only those employees who were in the pay group *during* the pay period are eligible for processing.

- **Retrieving employee data:** If you select *All*, the meaning of the value *All Effdts* (all effective dates) in the Where Clause Type field on the PS Tables page literally means *all* effective dates. If you choose *Current*, then *All Effdts* on the PS Tables page refers to all effective dates that are effective during the pay period.
Process Filter

Select to indicate whether the system should process records with a company value that is different from the process company.

- **None:** All rows that are created by Payroll Interface for each company and pay group combination are inserted into the PI_PARTIC_EXPT table and are available for export. The last history rows that are created for the current system ID are retrieved for comparison.

- **Company:** If you define a key field of Company on the Definition Table component - Interface Definition Fields page, this field is compared to the process company. The system exports only records with a matching company. For comparison, the system retrieves the last history rows that were created for the current system ID and company.

See Working with Company Filtering.

Character Set

Select to enter the appropriate character set for the language that is used in the export or import file.

**Note:** The Import process recognizes only the ASCII character set.

See Working with Character Sets.

File Type

Select a file type:

- **CSV** (comma-separated value): Data is delimited, or separated, by commas.

- **Logical:** Data is defined using an identifier followed by its value, not fixed format. For example, the field identifier of 1X2 might always immediately precede a value of 1 or 2 to indicate tax status. The field identifier is defined by your third-party payroll system and must exactly match the field identifier that is defined in Payroll Interface. If you use a logical file, select *External Field ID Indicator* and enter the field length.

- **Other Delm** (other delimited): Data is delimited by the character that you specify in the *Data Delimiter* field.

**Note:** A delimited data file can contain only one Payroll Interface record definition of the data type. You can have two record definitions only for a Stop Transaction record. Common examples are deductions, savings plans, additional pay, and direct deposit.

Numeric values cannot contain the thousands edit characters. For example: 1,100,100 appears in both the import and export files as 1100100. The system does support...
a display character for the decimal place, for example, 100.50 or 100,50.

- **Physical**: Data is defined by its position in the file. For example, a value of 1 or 2 in the 30th character position in the file might represent tax status. In such files, blank characters are often inserted to maintain positional integrity when a data value is not available to take that position.

- **Tab Delm** (tab delimited): Data is delimited by the Tab character.

**Logical File Type and Delimiter File Types**

Use the options in the Logical File Type group box and Delimiter File Types group box to further define the export file.

**Literal String Character**

If the decimal character is the same as the delimiter character, it must be enclosed in the literal string character. This applies to both export and import files. For example, if the decimal character is a comma, and the file type is CSV, all numeric values that contain decimals must be enclosed by the literal string character: "100,50" for example.

In an export file, all character values must be enclosed by the literal string character. A sample record might be: 1235,"abcd", "ef gh", "Last Name, First Name".

When data values contain the literal string character, the single character is repeated within the data value when it is written to the export file. During the import process, the system examines the data value for two literal string characters together and changes them to just one. For example, a data value from the database is Suite 200, Unit "A" West. The data value is written to the export file as "Suite 200, Unit "A" West". The import process interprets the export data string and loads it into the database as: Suite 200, Unit "A" West.

**Remove Trailing Spaces**

You can override this selection at the field level.

**Include Header**

For delimited file types, select to indicate whether a header record is the first record. When this option is selected for export files, a header is written as the first record in the file. The header name is the external column name for each field on the record.

When this option is selected for input files, the header record is compared to the record definition. If they do not match, the system stops processing for that file.

**Interface System Table 2 Page**

Use the Interface System Table 2 page (PI_SYSTEM1_PNL) to set up payroll statuses.
Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > System Table > Interface System Table 2

Image: Interface System Table 2 page

This example illustrates the fields and controls on the Interface System Table 2 page.

<table>
<thead>
<tr>
<th>Interface System Table 1</th>
<th>Interface System Table 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System ID</strong></td>
<td>PHY</td>
</tr>
<tr>
<td><strong>Active Employees for Export</strong></td>
<td>Find</td>
</tr>
<tr>
<td><strong>Effective Date</strong></td>
<td>01/01/1990</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Physical File Format</td>
</tr>
<tr>
<td><strong>Payroll Statuses</strong></td>
<td>Personalize</td>
</tr>
<tr>
<td><strong>Payroll Status</strong></td>
<td></td>
</tr>
<tr>
<td>Active</td>
<td></td>
</tr>
</tbody>
</table>

Payroll Statuses

Payroll Status

Select the pay statuses of the employees to process. This setting directly corresponds to the Selecting Active Employees check box on the Payroll Interface Run Control page.

**Note:** Employee payroll status is assigned in Job data.

**Note:** Payroll Interface processes only the current row if more than one effective sequence exists for a particular date.

Setting Up the Employee Table

To set up the Employee Table, use the Employee Table (INTRFC_EMPLOYEE) component.
Page Used to Set Up the Employee Table

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Employee Table Page</td>
<td>PI_EMPLID_PNL</td>
<td>Set up employee IDs when the third-party payroll system employee IDs are independent of the PeopleSoft EMPLID.</td>
</tr>
</tbody>
</table>

Understanding the Employee Table

Use the Employee Table component to determine how your employees are identified in the third-party payroll system.

You can export data from any table or view in PeopleSoft HCM, as long as the record includes the PeopleSoft EmplID. To identify employees in a third-party payroll system, you can use the PeopleSoft and map the PeopleSoft EmplID to a third-party employee ID (PI EmplID) or some other unique identifier such as a Social Security Number.

Related Links
- Deduction Processing and Multiple Jobs
- Export Processing and Multiple Jobs

Interface Employee Table Page

Use the Interface Employee Table page (PI_EMPLID_PNL) to set up employee IDs when the third-party payroll system employee IDs are independent of the PeopleSoft EMPLID.

Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Employee Table > Interface Employee Table

Image: Interface Employee Table page

This example illustrates the fields and controls on the Interface Employee Table page.

System ID

Select the System ID for the third-party payroll system.

PI Emplid (Payroll Interface employee ID)

Enter the ID that uniquely identifies your employees to the third-party payroll system.
Setting Up the PS Tables

To set up the PS Tables, use the PS Tables (PS_TABLES) component.

Pages Used to Set Up the PS Tables

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>PS Tables Page</td>
<td>PI_PSREC_PNL</td>
<td>Select PeopleSoft tables and fields that contain employee payroll-related data. Data is extracted from these tables and fields during the Export process.</td>
</tr>
<tr>
<td>PeopleSoft Field Inquiry</td>
<td>PI_PSFLD_INQ</td>
<td>View attributes for a selected field.</td>
</tr>
</tbody>
</table>

Understanding the PS Tables

Use the PS Tables component to identify the PeopleSoft HCM tables and fields that contain the data that will be exported to the third-party payroll system or used during the Export process.

You can export data from any table or view in PeopleSoft HCM, as long as the record includes the PeopleSoft EMPLID field. The system uses the parameters on the PS Tables page to construct the SQL select statements.

Note: Any field that is identified in the PS Tables component can be added to the Field Definition component. Any field that is defined in the Field Definition Table component can be added to the Definition Table component.

PS Tables Page

Use the PS Tables (PeopleSoft Tables) page (PI_PSREC_PNL) to select PeopleSoft tables and fields that contain employee payroll-related data.

Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > PS Tables > PS Tables
This example illustrates the fields and controls on the PS Tables page.

**System ID**  
The system ID for the third-party payroll system.

**Process Type**  
Select to indicate which Payroll Interface process to perform with the table or view.

**Where Clause Type**  
Select to indicate which type of SQL Where clause to construct when retrieving the data from the database:

- **Empl ID**: Employee ID only.
- **ID and Active Effdt**: Employee ID and the active effective date as of the pay end date.
- **ID, Active Effdt, Active EffSeq**: Employee ID, the active effective date, and the latest effective sequence as of the pay end date.
- **ID, All Effdts, Active EffSeq**: Employee ID, all effective-dated rows that fall between the pay-begin date, the pay-end date (non-retroactive processing), and the latest effective sequence for each effective date.
- **ID, All Effdts**: Employee ID and all the effective-dated rows that fall between the pay-begin date and the pay-end date (non-retroactive processing).
- **ID, Effdt=Pay End Dt**: Employee ID and effective date equal the pay end date.

To become more familiar with the differences between these Where clause types, try them out using PeopleSoft Query.

**See PeopleTools: PeopleSoft Query**

---

**Note**: If you select **Import** in the Process Type field, this field is not available.

### Paygroup Company in Where
Select to indicate whether the Where clause for retrieving data from this PeopleSoft table should include a test on the Company field. When this check box is selected, the system compares the Company field in the record against the Company field in the employee's job data.

Select this check box when an employee could have more than one entry in the PeopleSoft table that could be uniquely identified by the Company field. An example of this is the employee's tax data.

### Paygroup Country in Where
Select to indicate whether the Where clause for retrieving data for this PeopleSoft table should include a test on the Country field. When this check box is selected, the system compares the Country field in the record against the Country field from the company/pay group to which the employee belongs. The company/pay group is based on the employee's job data.

Select this check box when an employee could have more than one entry in the PeopleSoft table that could be uniquely identified by the Country field. An example of this is the employee's national ID data.

### Ded Calc Data (deduction calculation data)
Select to indicate that one or more fields listed for this table or view comes from the PI_DED_CALC table. When you run the Export process with a run control defined to exclude DedCalc, the system excludes any record for which this check box is selected.

When the PS record table name is PI_DED_CALC, this check box is always selected.

### Data Required
Select to indicate that a row of data must be returned from the database for this table, but not that every field that is defined for this record must contain data.

If a row of data is not returned for this record, the system issues an error message, and no data for the employee is written to the export file.

### Job Data
Select if the record contains COMPANY, PAYGROUP, or ACTION.
If the PS record table name is JOB, this check box is always selected.

Field Details

Use the Field Details group box to define field attributes.

**Note:** You should enter Order by (sequence) values for all key fields. The EFFDT and EFFSEQ fields *must* be in descending order (Collate Order Desc). All other fields should be in ascending order (Collate Order Asc).

Order by

Select to indicate the sequence in which the field should be processed. A number from zero (blank) to 99 represents the sequence of the field in the ORDER BY clause of the SQL select statement.

Collate Order

This field is applicable only when the value for the Order by field is greater than zero. Select to indicate the sequence order of the field in the ORDER BY clause of the SQL select statement. (If the value of the Order by field is zero or not specified, the collate order is none by default.)

- **Asc:** Ascending order. Sequences data from lowest to highest. This is the default value for all fields.
- **Desc:** Descending order. Sequences data from highest to lowest.

**Note:** The EFFDT and EFFSEQ fields *must* be in descending order.

See Working with Key Fields.

Key Field

This check box is automatically selected if the field is defined in PeopleSoft Application Designer as a key for a PS record.

You must manually select this check box for views.

Effective Date

Only one field can be the Effective Date field. The system uses the Effective Date field name in constructing the Where clause of the SQL select statement when the SELECT_WHERE_TYPE includes the effective date.

The Effective Date field for the DED_CALC Table is Pay End Date.

Effective Sequence

Only one field can be marked as the Effective Date sequence number. The system uses the effective date sequence number in constructing the Where clause of the SQL select statement when the SELECT_WHERE_TYPE includes the Effective Date sequence field.
This field is used with the JOB record and any other records with both an effective date and effective sequence.

**Field Attribute**

Select to view the PeopleSoft Field Inquiry secondary page.

---

### Setting Up the Field Definition Table

To set up the Field Definition Table, use the Field Definition Table (INTRFC_FIELD) component.

#### Pages Used to Set Up the Field Definition Table

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Field1 Page</td>
<td>PI_FIELD1_PNL</td>
<td>Set up third-party payroll system fields.</td>
</tr>
<tr>
<td>Interface Field2 Page</td>
<td>PI_FIELD2_PNL</td>
<td>Set up corresponding PeopleSoft fields.</td>
</tr>
</tbody>
</table>

#### Understanding the Field Definition Table

Use the Field Definition Table component to define the data type and format of the fields that appear in the export file. Any field that is identified in the PS Tables component can be added to the Field Definition component.

**Note:** The Field Definition Table component and the Definition Table component contain effective-dated entries. You must keep these components synchronized. Be sure that future-dated rows in the Field Definition Table component are not referenced in the Definition Table component before their effective dates. Also, if you mark a field inactive in the Field Definition Table component, be sure that the field is no longer included in the Definition Table component.

See [Working with Key Fields](#).

### Interface Field1 Page

Use the Interface Field1 page (PI_FIELD1_PNL) to set up third-party payroll system fields.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition Table > Interface Field1
Image: Interface Field1 page

This example illustrates the fields and controls on the Interface Field1 page.

Field Definition

Process Type

Select the Payroll Interface process.

Note: Exp/Imp (export/import) can be used as the process type only if the characteristics of the field are the same for both import and export. Otherwise, you need to set up records for each process type. The Employee ID field is the only field that is mapped as both an export and import type; you do not need to define a PS record or field name for it.

External Field ID

If the System Table - Interface System Table 1 page, External Field ID Indicator option is selected, the external field ID becomes by default the value that you enter here. The external field ID can be up to 10 characters.

Type

Select from the following options:

- **Character**
  
  Use the Justification field to specify whether characters are left or right justified.
  
  Note: When you are mapping from a large field to a smaller field, the results are truncated. For example, if you map '0123456789' from a 10-character field to a 7-character field, the result is '0123456'.

- **Date**
  
  Use the Date Format field to specify the third-party payroll system's date format.

- **Number**
Use the Display Decimal and Decimal Char (decimal character) fields to specify a decimal separator.

- **Signed**

  Use the Sign Position field to select the placement of the sign for signed numerical fields.

- **Value**

  Select to specify a predefined data item for the Text field. For example, with the Pay Run ID field, enter Pay Run ID as the text. (Including Pay Run ID in the header record may help ensure that the correct file is processed.)

  If using the company filtering feature, use the Processing Company or Processing Pay Group values for the Text field.

  See Working with Company Filtering.

  **Text**

  Select to enter a translate value.

  **Note:** This field is active only if you have selected Value in the Type field.

  See Working with Text Translate Values.

  **External Column Name**

  Select to enter a name of up to 50 characters if the Interface field is used in a delimited data file structure with a header. The system uses this name to construct the header record.

  **Default Value**

  If you use constant in the Text field, the value that you enter here is used.

  You can also use a default value for the character type. For example, if the field is part of a header record, you can specify some fixed text as the default value.

**Field Format**

Use the options in the Field Format group box to define the file's field formats.

- **Field Length (in bytes)**

  For physical file formats, the length determines where the field will be positioned. When you are setting up the Interface Definition Fields page, you can view the exact character position of the field.

- **Integer Length**

  The system calculates the integer length to verify that you have set up a numeric field as intended.

  For a signed field type, the system subtracts one position from the integer length to allow for the sign. Use Sign Position to specify where the sign goes.
Blank if Zero

This field is active only for number or signed field types. Select if the payroll system uses blanks in place of zeros.

Interface Field2 Page

Use the Interface Field2 page (PI_FIELD2_PNL) to set up corresponding PeopleSoft fields.

Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition Table > Interface Field2

Image: Interface Field2 page

This example illustrates the fields and controls on the Interface Field2 page.

Field Definition

PS Record Name and PS Field1 Name, PS Field2 Name, PS Field3 Name

Select the PeopleSoft record and field names that correspond to the third-party payroll system field. If the third-party payroll system field value is derived from multiple PeopleSoft fields, enter the additional field names as well.

Process ID

Select when a COBOL process is required to correctly translate or format a PeopleSoft value to a third-party payroll system value.

Note: Process IDs are defined on the Interface Process Table.

PI Translate Indicator (payroll interface translate indicator)

Select to specify how translate values are handled:

- No Translate Values
- Translate All
• **Translate or Use Default Value:** Translate if a translate value is found; if not, use the default value that is defined on the Interface Field1 page.

• **Translate or Use PS Value:** Translate if a translate value is found; if not, use the PeopleSoft value.

**Instance ID**
Select to control which values of a field should be mapped to the external payroll system.

**Translate Values**
Select to translate PeopleSoft field value PS Value 1 (and, if needed, PS Value 2 and PS Value 3) to the third-party payroll system value, PI Value. For example, if DEDCD (deduction code) is KUDEN9 and DED_CLASS (deduction class) is B (before tax), then the translated value is D1.

Translate values are available for all export fields and for the Currency Code field for import.

**Related Links**
Creating COBOL Routines

---

**Setting Up the Definition Table**

To set up the Definition Table, use the Definition Table (INTRFC_DEFINITION) component.

**Pages Used to Set Up the Definition Table**

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Definition File Page</td>
<td>PI_FILE1_PNL</td>
<td>Set up a file layout for the import or export file.</td>
</tr>
<tr>
<td>Interface Definition Record Page</td>
<td>PI_FILE2_PNL</td>
<td>Set up the records in a file.</td>
</tr>
<tr>
<td>Interface Definition Fields Page</td>
<td>PI_FILE3_PNL</td>
<td>Set up the fields in a record.</td>
</tr>
</tbody>
</table>

**Understanding the Definition Table**

Use the Definition Table component to define the physical structure of the export or import file, including the records in the file and the fields in the records. Any field defined in the Field Definition Table component can be added to the Definition Table component.

**Note:** Each record in the file must include the field that is defined as the EMPLID on the System Table component.
**Warning!** If you use PeopleSoft Application Designer to change any of the tables or fields set up using the PS Tables component, you must make sure that these changes are reflected in the PS Tables component as well. If you think that a change that you have made has not taken affect, delete the database cache file and log back into the system.

See PeopleTools: Application Designer Developer’s Guide

### Interface Definition File Page

Use the Interface Definition File page (PI_FILE1_PNL) to set up a file layout for the import or export file.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition File

**Image: Interface Definition File page**

This example illustrates the fields and controls on the Interface Definition File page.

#### File ID Definition

**System ID**

Select the system ID for the third-party payroll system.

**Convert Case**

Select this check box to have the system automatically select the Conv. Case check box for each new field that you enter on the Interface Definition Fields page of this component. If you need to update the value of the Conv. Case check box for existing fields, you must manually select or deselect that check box on the Interface Definition Fields page for each of those fields. Selecting or deselecting the check box on this page does not update existing values.

**Include Header**

Is on or off by default according to values that are set up on the System Table component for the selected system ID.
PI Record Length
Select to enter the record length for the file type. For comma-separated (CSV), tab-delimited, and other delimited file types, the value must be zero.

Max Fields Per Output Rec
(maximum fields per output record)
Used for logical records. Select the value that is defined by the third-party payroll system.

External Field ID Indicator
Used for logical records. When this check box is selected, the data records contain the external field ID as defined on the Interface Field1 page for all of the fields that are defined in the interface definition record.

Interface Definition Record Page
Use the Interface Definition Record page (PI_FILE2_PNL) to set up the records in a file.

Navigation
Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition Record

Image: Interface Definition Record page
This example illustrates the fields and controls on the Interface Definition Record page.

Rec Seq Nbr (record sequence number) Select to indicate the sequence of each record within the file.

Note: The system assigns sequence numbers as you add or delete records. If your external system requires a specific record sequence, make sure the sequence reflects that.

Record ID
Each record definition should have a unique ID. Record definitions are used for organizing data for the Export process and for defining the export file. So you are likely to have more record definitions on this table than are described by your payroll system documentation.
If the third-party payroll system has its own record IDs, you might want to use those.

**Record Type**

Select from the following:

- **Header**: Written out first to identify the beginning of a file. Multiple headers are allowed.

- **Trailer**: Written out last to identify the end of a file.

- **Data**: Imported or exported data. A data record must have a primary PS record.

- **Process**: Record definitions used by a COBOL process and associated with specific process events, such as stop deductions. Process records must also identify the Base Rec field (base record).

- **Not Proc (not processed)**: Used for import files only. This indicates a payroll system record within the import file that is not processed by Payroll Interface.

If you select any type other than *Process*, then the row builds a record type within the file.

If you have multiple data-type records, the first data record should have the Primary PS Record set to Job.

---

**Note: (for CSV files)** Each data-type record needs to be assigned to a separate, individual interface definition file. If you have multiple records (and interface definitions), assign each of them to the appropriate PI Configuration ID.

**PS Record**

Select to identify the PeopleSoft table that is selected from (for export) or inserted into (for import) as the primary PeopleSoft table for this interface record.

**Note**: Each data record must contain the field that is defined as the employee field ID on the System Table component.

**Base Rec (base record)**

Available for process record types.

The data value that is used in the Base Rec field is a record sequence number from another row on this table. The base record ties the indicated process to another sequence number row. For example, if the row that is labeled with sequence number 80 concerns deduction data and the row that is labeled 140 defines the process ID that is used to stop the deduction, then 80 is the base record for record sequence number 140.

**Occur Ind (occurrence indicator)**

Select to identify the correspondence between rows in the PS record and the records in the export file.
• **Multi Recs to Multi Defn Recs** (multiple records to multiple definition records)

Data is pulled from a PeopleSoft record that may have multiple records (or rows) of information to multiple definition payroll system records (or rows) of information. The Occurrence Key field is required to distinguish each occurrence.

Example: Ded Calc and Additional Pay may have more than one row of employee data that the system needs to read to determine whether data changed. You would pull all rows of data and write them to multiple rows on the payroll system data file.

Example:

(SSN, Ded Code, Ded Amount)

"354567980","401K",200.00
"354567980","HEALTH",150.00
"354567980","UWAY",50.00
"354567980","VISION",25.00

or

(SSN, Pay Code, Pay Amount)

"354567980","CAR",200.00
"354567980","DIEM",250.00
"354567980","FLEX",60.00

• **Multi Recs to Single Defn Rec** (multiple records to single definition record)

Data is pulled from a PeopleSoft record that may have multiple records (or rows) of information to a single payroll system record (or row) of information.

Example: Direct Deposit may have more than one row of employee data that the system needs to read in order to determine whether the data changed. You would want to pull all rows of data from PeopleSoft and write them to one row on the payroll system data file.

Example:

(SSN, Trans/ABA, Account #, Account Type, Amount)
• Single Rec to Single Defn Rec (single record to single definition record)

Data is pulled from a single PeopleSoft record (or row) and put in a single payroll system record (or row) of information.

Example:

(Name, Address, City, Country)

"Doe,Jane","854 Mill Rd","Anywhere","USA"

Instance ID
Defined on the Instance Table - Interface Instance Table page.

Process ID
Select when a special COBOL process is required to correctly translate or format PeopleSoft values for your payroll system.

Payroll Interface delivers process IDs for several special events. These events set an indicator that can be used later by another special process indicator:

See Reviewing Delivered COBOL Processes for Special Events.

Record Terminated Value and Record Terminated Length
Available for data entry only if the file type selected on the Interface Definition File page is Physical or Logical. Enter a value only if your external payroll system needs a specific value to identify the end of the record.

Interface Definition Fields Page

Use the Interface Definition Fields page (PI_FILE3_PNL) to set up the fields in a record.

Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition Fields
Chapter 9 Setting Up a Payroll Interface Definition (Part 1)

### Image: Interface Definition Fields page

This example illustrates the fields and controls on the Interface Definition Fields page.

<table>
<thead>
<tr>
<th>Field Sequence</th>
<th>Description</th>
<th>Start Position</th>
<th>Field Length</th>
<th>Field ID</th>
<th>Key Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COMPANY</td>
<td>1</td>
<td>6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>ROWNUM</td>
<td>7</td>
<td>6</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fields**

Use the options in the Fields group box to define, order, and group the individual fields in a record.

- **Field Sequence (field sequence number) and Field ID**
  - Select to enter a field and its position within the record (field IDs are defined on the Field Definition Table component).
  
  **Note:** When you set up a transaction and its corresponding stop transaction, the field sequences in both records must match.

- **Redefine (redefine)**
  - If the field's position in a record is also used by a subsequent field for a different purpose, use this check box to select the secondary field for later use. The secondary field must immediately follow the first definition with this position in the record.

- **Start Position, Field Length, and Field Name**
  - Calculated from the Interface Field Table.
  
  For physical files, the starting position and field length can be used to validate that the length of the fields has been set in the correct layout.

- **Convert Case**
  - Used for ASCII files only. Select to override the case default for a field.

- **Reverse Sign**
  - Select if the field is signed numeric type and the payroll system requires that the sign be reversed.

- **Key Field**
  - Select from the following values:
    - *None*: Indicates a data-only field.
      
      *Non Key*: Indicates a non-key field.
    - *Record*: Defines a field as a primary record key. The system formats only one record per employee.
Note: To make a field a record key, every key value in every row above the field must also be defined as a record key. The system delivers a COBOL error message if you order the key field in a manner such as Non Key, Record, and Non Key.

- **Occurrence**: Defines a field as an occurrence key. Occurrence key processing allows multiple records to be formatted.

  See [Working with Key Fields](#).

- **Effdt**: Defines a field as an effective-date key. An effective-date key is special type of occurrence key. In addition to occurrence key functionality, further processing eliminates redundant information.

  See [Working with Key Fields](#).

- **Company**: If a field is defined as *Company* and the value on the System Table, Interface System Table 1 page - Process Filter field is set to *Company*, the system activates a filtering mechanism. Only rows with a Company value matching the processing company (the company tied to the run ID) are formatted and passed to the interface.

  See [Working with Company Filtering](#).

**Group ID**

Select to indicate that the field belongs to a group of fields. All fields in the record with the same group ID are exported or imported together (if a data change occurs to one field in the group, all fields in the group are exported).

---

**Setting Up the Group Table**

To set up the Group Table, use the Group Table (INTRFC_GROUP) component.

**Page Used to Set Up the Group Table**

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Group Table Page</td>
<td>PI_GROUP_PNL</td>
<td>Set up group IDs that identify multiple fields to be imported or exported together.</td>
</tr>
</tbody>
</table>

**Understanding the Group Table**

Use the Group Table component to define a group ID. Group IDs are used to group two or more fields for export or import:
• For export processing, a group ID is used to identify multiple fields that must be exported together when data changes in any field in the group.

• For import processing, a group ID identifies multiple fields that correspond to one row in the PI Check Table or the PI Balance Table. The PI Check Table and PI Balance Table are populated when you import data by way of Payroll Interface from your third-party payroll service.

**Note:** The import group ID can associate an additional field and value for the PeopleSoft import table. This allows a record position in the import file to be translated to a key value in the PeopleSoft import table.

---

**Interface Group Table Page**

Use the Interface Group Table page (PI_GROUP_PNL) to set up group IDs that identify multiple fields to be imported or exported together.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Group Table > Interface Group Table

**Image: Interface Group Table page**

This example illustrates the fields and controls on the Interface Group Table page.

<table>
<thead>
<tr>
<th>System ID</th>
<th>PHY</th>
<th>Physical File Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>DED</td>
<td></td>
</tr>
<tr>
<td>Process Type</td>
<td>Export</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Deduction Code and Amount</td>
<td></td>
</tr>
<tr>
<td>Short Description</td>
<td>Dads</td>
<td></td>
</tr>
<tr>
<td>PeopleSoft Record Name</td>
<td>EMPLOYEES</td>
<td></td>
</tr>
<tr>
<td>PeopleSoft Field1 Name</td>
<td>EMPLID</td>
<td></td>
</tr>
<tr>
<td>PS Key Value</td>
<td>EMPLID</td>
<td></td>
</tr>
</tbody>
</table>

**Process Type**

Select to enter the Payroll Interface process, either export or import.

For export processing, a group ID is used to identify multiple fields that must be exported together when data changes in any field in the group.

For import processing, a group ID identifies multiple fields that correspond to one row in the PI Check Table or the PI Balance Table. The PI Check Table and PI Balance Table are populated...
when you import data by way of Payroll Interface from your third-party payroll service.

**Note:** The import group ID can associate an additional field and value for the PeopleSoft import table. This allows a record position in the import file to be translated to a key value in the PeopleSoft import table.

| PeopleSoft Record Name and PeopleSoft Field1 Name | Available for process type import. Select to define the PeopleSoft record and field where the import data is inserted. This allows translation of a record position in the import file to a key value in the PeopleSoft table. |

**Setting Up the Instance Table**

To set up the Instance Table, use the Instance Table (INTRFC_INSTANCE) component.

**Page Used to Set Up the Instance Table**

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Instance Table Page</td>
<td>PI_INSTANCE_PNL</td>
<td>Set up instance IDs to filter PeopleSoft data that is mapped to Payroll Interface fields or records.</td>
</tr>
</tbody>
</table>

**Understanding the Instance Table**

Use the Instance Table component to define instance IDs that act as filters and process records (row instances) or fields (field instances) based on specific data values.

Instance IDs work like a dynamic Where clause and can be assigned to:

- **Records:** Select when the data that is mapped to the record is valid for only a subset of data within the primary PeopleSoft record. If the condition is not met, the record is not formatted. You can define instances for a specific ordinal row from a table or rows based on a value in a table.

- **Fields:** Select when you need to control which PeopleSoft values to use for the field. When the condition is met, a specified PeopleSoft value is mapped to the field.

See Working with Transactions.

**Interface Instance Table Page**

Use the Interface Instance Table page (PI_INSTANCE_PNL) to set up instance IDs to filter PeopleSoft data that is mapped to Payroll Interface fields or records.
Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Instance Table > Interface Instance Table

Image: Interface Instance Table page

This example illustrates the fields and controls on the Interface Instance Table page.

**Interface Instance Table**

<table>
<thead>
<tr>
<th>System ID</th>
<th>CSV Sample Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>InstanceID</td>
<td>SALARY</td>
</tr>
</tbody>
</table>

**Definition**

**Instance Indicator**

Select either:

- **Value**: Controls selection according to the value in a field. *Deduction Class* is an example. The specified values indicate which condition must be met for the system to select data for processing.

  **Note**: Use the word ZERO to specify that the value should be compared to the number 0.

- **Ordinal**: Controls selection according to the occurrence of data or entry within a table. For example, in PeopleSoft, an employee can have several entries within the Direct Deposit Distribution Table. An ordinal instance type tells Payroll Interface which occurrence or row of data within the PeopleSoft record to select for export.

**PeopleSoft Record Name** and **PeopleSoft Field Name**

Select to identify the PeopleSoft record and PeopleSoft field that are tested against the specified values.

**Include Exclude Indicator**

Select to include or exclude the value when it matches the condition that you specified.

**Instance Information**

**Sequence**

Select to indicate which occurrence or entry in the PeopleSoft record to use for processing. The sequence order is dictated by
the select order on the primary PeopleSoft table used to define the interface ID field or record.

When using an ordinal instance type, Payroll Interface selects only the occurrence that corresponds to the row number from the PeopleSoft record defined for export.

**Field1 Value**

Select to indicate a value to use during processing.

To create an instance ID based on the value of zero, use the literal value ZERO instead of 0.

To create an instance ID based on the value of space, use the literal value SPACE instead of pressing the space bar.

---

**Setting Up the Process Table**

To set up the Process Table, use the Process Table (INTRFC_PROCESS) component.

**Page Used to Set Up the Process Table**

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Process Table Page</td>
<td>PI_PROCESS_PNL</td>
<td>Set up a COBOL process.</td>
</tr>
</tbody>
</table>

**Understanding the Process Table**

Use the Process Table component to access the COBOL processes that are delivered with Payroll Interface. These processes enable transaction processing or other types of processing such as data translation or data formatting.

You can add your own COBOL routines to the system. You can also document and control which user exit program is called for any process that you define and describe any changes that you make to the provided processes.

**Interface Process Table Page**

Use the Interface Process Table page (PI_PROCESS_PNL) to set up a COBOL process.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Process Table > Interface Process Table
Image: Interface Process Table page

This example illustrates the fields and controls on the Interface Process Table page.

### Interface Process Table

<table>
<thead>
<tr>
<th>Process Details</th>
<th>Find</th>
<th>View All</th>
<th>First</th>
<th>Last</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process ID 000000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PI Process Phase</td>
<td>Before Field Translation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Field</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Defined Process</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Short Description</td>
<td>City Code</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Process Details**

**Process ID**

Select the process ID for one of the delivered COBOL processes or enter a process ID for your own COBOL routine.

See Reviewing Delivered COBOL Processes.

If you create your own COBOL routine, you must set up a process ID for the routine using this page.

See Creating COBOL Routines.

**PI Process Phase**

Select to identify when the system runs the COBOL process. A process phase is hard-coded into each COBOL process that is delivered with Payroll Interface; if you change the process phase, you must also modify the COBOL process.

A process ID can have more than one PI process phase attached to it. The following are translate values for PI process phase:

- After Field Translation
- Before Field Translation
- Export File Creation
- Import Processing
- Record Processing

**Type**

Select to indicate whether the process applies to a record or a field.
User Defined Process
Select if the process is one that you have defined or it is delivered with this turned on.

User Exit Program
If User Defined Process is selected, select to specify the name of the user-defined program that will transfer the control to run the process. A value of space characters indicates a common routine (PIPSPRCS) that is delivered with the Payroll Interface system.

Returned Values
Returned Value
Applies only when the value for the PI Process Phase field is Before Field Translation.

Setting Up the File Handle Table
To set up the File Handle table, use the File Handle Table (INTRFC_FILEHANDLE) component.

Page Used to Set Up the File Handle Table

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface File Handle Table</td>
<td>PI_FLHANDLE_PNL</td>
<td>Assign a handle to each external file that is imported or exported.</td>
</tr>
</tbody>
</table>

Understanding the File Handle Table
Use the File Handle Table component to define file handles that identify the export or import files and their physical location on the computer system. File handles are connected to the file IDs, which are set up using the Definition Table component.

This diagram shows the relationship between file IDs and file handles:

Image: Relationship between file IDs and file handles
This diagram shows the relationship between file IDs and file handles.
Interface File Handle Table Page

Use the Interface File Handle Table page (PI_FLHANDLE_PNL) to assign a handle to each external file that is imported or exported.

Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > File Handle Table > Interface File Handle Table

Image: Interface File Handle Table page

This example illustrates the fields and controls on the Interface File Handle Table page.

<table>
<thead>
<tr>
<th>File Handle</th>
<th>'File Name'</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1</td>
<td>ExtempSEGOUT#1</td>
<td>PACT</td>
</tr>
<tr>
<td>E2</td>
<td>ExtempSEGOUT#2</td>
<td>PMBO</td>
</tr>
<tr>
<td>C1</td>
<td>ExtempMASTER.CSV</td>
<td>Sample CSV Master File</td>
</tr>
<tr>
<td>C2</td>
<td>ExtempDEDUCTION.CSV</td>
<td>Sample CSV Deduction File</td>
</tr>
<tr>
<td>C3</td>
<td>ExtempBEFORE-TAX-SAVINGS.CSV</td>
<td>Sample Before Tax Savings File</td>
</tr>
</tbody>
</table>

File Handle

Select to enter any combination of two-digit alphanumeric characters, regardless of the external file's format. Each file handle number should be assigned a unique process type (export or import).

File Name

Select to enter the exact path and file name that corresponds to the file handle's location. Be sure to use the appropriate syntax for your operating system (Windows-based, Unix-based, and so on).

Setting Up the Configuration Table

To set up the Configuration table, use the Configuration Table (INTRFC_CONFIG) component.

Page Used to Set Up the Configuration Table

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Configuration Table Page</td>
<td>PI_CONFIG_PNL</td>
<td>Set up configuration IDs and link file IDs to file handles.</td>
</tr>
</tbody>
</table>
**Understanding the Configuration Table**

Use the Configuration Table component to define a configuration ID. The configuration ID is the connection mechanism that joins PeopleSoft HCM to the third-party payroll system and enables the exchange of data.

This diagram shows that the configuration ID connects the file ID to the file handle:

**Image: Connecting to the export file**

This diagram shows that the configuration ID connects the file ID to the file handle.

```
Configuration Table
  Configuration ID
    (File ID)
    (File Handle)

Definition Table
  File ID

File Format
  (CSV, LOG, PHY, NFC)

File Handle Table
  File Handle

File Location
  (C:\temp)
```

This diagram shows that the configuration ID also connects the PeopleSoft HCM pay group to the third-party payroll system:

**Image: Connecting the pay group to the third-party payroll system**

This diagram shows that the configuration ID also connects the PeopleSoft HCM pay group to the third-party payroll system.

---

**Note:** The configuration ID is entered on the Pay Group Table - Definition page, PI Configuration ID field and is used to identify the payroll system and the interface files that apply to the pay groups.
Related Links
Understanding Payroll Schedules

Interface Configuration Table Page

Use the Interface Configuration Table page (PI_CONFIG_PNL) to set up configuration IDs and link file IDs to file handles.

Navigation
Set Up HCM > Product Related > Payroll Interface > Interface Controls > Configuration Table > Interface Configuration Table

Image: Interface Configuration Table page

This example illustrates the fields and controls on the Interface Configuration Table page.

| System ID | Select to identify the system ID for the third-party payroll system. |
| File IDs | Use the options in the File IDs group box to link file IDs to file handles. |
| **File ID** | **File Handle** | **File Name** |
| PHY | PI | C:ITEMP\PHYSICAL.TXT |
Chapter 10

Setting Up a Payroll Interface Definition (Part 2)

Working with Interface Definitions

This topic discusses how to:

• (USF) Set up an NFC export interface definition.
• Set up a DETI import interface definition.
• Set up a new import interface definition.

(USF) Setting Up an NFC Export Interface Definition

Use the National Finance Center (NFC) sample data definition to set up an export interface for federal agencies, who primarily use the National Finance Center as the third-party payroll system.

Note: Federal agencies generally do not import NFC data (the processed payroll results) back into PeopleSoft HCM. You can configure Payroll Interface to import the data, but most agencies do not take advantage of this feature.

Payroll Interface uses the NFC system ID as well as the Industry and Industry Sector codes set up in PeopleSoft HR to identify federal workers. Because the NFC sample data definition is configured to export position and job data, you should implement full position management within PeopleSoft HR.

The NFC sample data definition includes two export files: the Entry, Processing, Inquiry, Correction (EPIC) file contains employee data; the Position Management Data (PMSO) file contains position and job code data. Both files include the appropriate header information required by the NFC. When you export a full set of records, the NFC export sends only the last effective-dated row for both employee data and position and job code data.

The NFC sample data definition includes six additional tables (views):

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GVT_PI_AWD_VW</td>
<td>SF50/52 award information for the NFC's 110 record.</td>
</tr>
<tr>
<td>GVT_PI_DATA_VW</td>
<td>The personal, employment, and job data that is used to process SF50/52 forms for the NFC's EPIC 063 Data record.</td>
</tr>
<tr>
<td>GVT_PI_EDUC_VW</td>
<td>Education information for the NFC's EPIC 063 Data record.</td>
</tr>
<tr>
<td>GVT_PI_RMKS_VW</td>
<td>SF50/52 remarks information for the NFC's Remark (RMK) record.</td>
</tr>
</tbody>
</table>
### Setting Up a DETI Import Interface Definition

Use the Detail Interface (DETI) sample data definition to set up an import interface definition that loads the employee check detail information produced by the third-party payroll system.

To set up the import interface, obtain a copy of the data file from the third-party payroll vendor that matches the DETI sample data definition. Then, examine the Payroll Interface fields and records that are associated with it:

1. Ensure that the key values that you map using the PI_CHECK table are the same values that are mapped on the three DETAIL child records, plus one more to make it a unique child.
   
   You must also create a field definition for each data field that is present in the file, including a filler for unwanted data when the data is defined by its position in the record.

2. Define the import records.

3. Attach your file definition to the Payroll Interface configuration ID and define the external file handle to enable the COBOL program to find the input file.

For physical file types, some data fields may be defined according to type (such as OASDI tax type) by their position in the import record. As shown in this example, Payroll Interface reflects this tax type by creating a separate row for each occurrence and captures the tax type during import by attaching a group ID:
Image: Interface Group Table page, Group ID used for import

This example of the Interface Group Table page shows a sample Group ID used for import.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID</td>
<td>CSV</td>
</tr>
<tr>
<td>Group ID</td>
<td>D03</td>
</tr>
<tr>
<td>Process Type</td>
<td>Import</td>
</tr>
<tr>
<td>Description</td>
<td>Soc Security Tax (OASDI)</td>
</tr>
<tr>
<td>Short Description</td>
<td>OASDI</td>
</tr>
<tr>
<td>PeopleSoft Record Name</td>
<td>FL_TAX_DETAIL</td>
</tr>
<tr>
<td>PeopleSoft Field1 Name</td>
<td>FL_TAX_TYPE</td>
</tr>
<tr>
<td>PS Key Value</td>
<td>OASDI</td>
</tr>
</tbody>
</table>

As shown in this example of the Interface Group Table page (Set Up HCM >Product Related >Payroll Interface >Interface Controls > Group Table >Interface Group Table), Payroll Interface uses the entry in the PS Key Value (PeopleSoft key value) field to populate the field defined in PeopleSoft Field1 Name with OASDI, as it is builds the data for the record given by PeopleSoft Record Name from the import row being processed:

Image: Interface Definition Fields page, sample interface definition used for import

This example of the Interface Definition Fields page shows a sample interface definition used for import.

This example of the Interface Definition Fields page (Set Up HCM >Product Related >Payroll Interface >Interface Controls > Definition Table >Interface Definition Fields), shows a sample interface definition used for import.
Image: Interface Field1 page, sample field ID used for import

This example of the Interface Field1 page shows a sample field ID used for import.

As shown in this example of the Interface Field1 page (Set Up HCM >Product Related >Payroll Interface >Interface Controls > Field Definition Table >Interface Field1), group ID D03 is attached to the field ID DPD03.

Defining a New Import Interface Definition

This topic discusses how to set up a new import file definition. For this example, you use a physical, fixed-length data file to import pay period data into the PI_CHECK, PI_EARN_DETAIL, PI_DED_DETAIL, and PI_TAX_DETAIL import tables.

Basic File Layout

Header and footer records are optional. To use data that's not at the employee level, place it here. For examples, see the DETI sample data file header and footer.

Note: You can map fields that are derived from the PeopleSoft pay calendar or that are derived during the Payroll Interface process. At the field level, select value as the type, and view the text list.

Record Identifiers

For each physical record to be read, set up an interface field as a record flag. On the Interface Field 1 page, enter value in the Type field and External Record Code in the Text field. Then each record has a unique flag at the beginning of the input data record.

Sample Values

This table lists sample values:

<table>
<thead>
<tr>
<th>Default Value</th>
<th>Record Name</th>
<th>Field Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>PI_CHECK</td>
<td>CHK01</td>
</tr>
<tr>
<td>B</td>
<td>PI_EARN_DETAIL</td>
<td>ERN01</td>
</tr>
<tr>
<td>Default Value</td>
<td>Record Name</td>
<td>Field Name</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------</td>
<td>------------</td>
</tr>
<tr>
<td>C</td>
<td>PI_DED_DETAIL</td>
<td>DED01</td>
</tr>
<tr>
<td>D</td>
<td>PI_TAX_DETAIL</td>
<td>TAX01</td>
</tr>
</tbody>
</table>

**Record Key Fields**

Examine each PeopleSoft system record definition into which you want to import data. Examine the DETI sample data file and ensure that you map the same key fields from the data file into the Payroll Interface tables, as a minimum.

**Sample Data File Layout**

Each record is physical, with a fixed length, but the records do not have to be the same length. Enter the longest record length on the Definition Table component - Interface Definition File page, PI Record Length field.

*Record A:* Contains PI_EMPLID and all other data fields that are mapped to PI_CHECK. Key record fields are:
  - CHK01
  - Check Number
  - PI_EMPLID, as defined on the System Table component - Interface System Table 1, Employee Field ID field.

*Record B, C, D, and subsequent records:* These records do not need the PI_EMPLID field. The Import process uses the same Payroll Interface employee ID for these data records until it reads another record A with another Payroll Interface employee ID.

To process multiple records repeatedly, set the Definition Table component - Interface Definition Record page, Occur Ind field to *Multi Recs to Single Defn Rec.* For an example, see the DETI sample data file, Record ID DPE, Coded Hours.

**Record B (Earn Detail)**

ERN01 (RECORD)

Earn Type (NON KEY)

Earn Code (NON KEY)

Amount (NON KEY)
The data file might look like this:

A, Emplid, check nbr, data field, data field, etc.
B, earn type, code, amount
B, earn type, code, amount
B, earn type, code, amount
B, earn type, code, amount

Each subsequent record repeats many times as necessary (using Multi Recs to Single Defn Rec).

**Record C (Deduction Detail)**

DED01 (RECORD)

Ded Code (NON KEY)
Ded Amount (NON KEY)

The data file might look like this:

A, Emplid, check nbr, data field, data field, etc.
B, earn type, code, amount
B, earn type, code, amount
B, earn type, code, amount
B, earn type, code, amount
C, code, amount
C, code, amount
C, code, amount
C, code, amount
C, code, amount
C, code, amount

The PeopleSoft system imports subsequent records in the same way.

---

**Working with Character Sets**

Use the System Table component - Interface System Table 1 page, Character Set field to select a character set for export or import processing.

See Setting Up the System Table.

The following table lists the character sets that Payroll Interface supports.

For example, suppose your headquarters is in the U.S., but you have an office in Japan where the payroll system uses Kanji. When Payroll Interface is run for the U.S., the Character Set field is set to ISO 8859–1,
the Latin character set. When Payroll Interface is run for the Japanese site, the Character Set field must be set to *JIS X 0208*, the Kanji character set.

<table>
<thead>
<tr>
<th>Character Set</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ANSI</td>
<td>Current ANSI Code Page</td>
</tr>
<tr>
<td>ASCII</td>
<td>US 7-bit ASCII</td>
</tr>
<tr>
<td>Big5</td>
<td>Big5 (Traditional Chinese)</td>
</tr>
<tr>
<td>CCSID1027</td>
<td>IBM EBCDIC 1027 (Jap.-Latin)</td>
</tr>
<tr>
<td>CCSID1047</td>
<td>IBM EBCDIC 1047 (Latin1)</td>
</tr>
<tr>
<td>CCSID290</td>
<td>IBM EBCDIC 290 (Katakana)</td>
</tr>
<tr>
<td>CCSID300</td>
<td>IBM EBCDIC 300 (Kanji)</td>
</tr>
<tr>
<td>CCSID930</td>
<td>IBM EBCDIC 930 (Kana-Kanji)</td>
</tr>
<tr>
<td>CCSID935</td>
<td>IBM EBCDIC 935 (Simplified Chinese)</td>
</tr>
<tr>
<td>CCSID937</td>
<td>IBM EBCDIC 937 (Traditional Chinese)</td>
</tr>
<tr>
<td>CCSID939</td>
<td>IBM EBCDIC 939 (Latin-Kanji)</td>
</tr>
<tr>
<td>CCSID942</td>
<td>IBM EBCDIC 942 (Japanese PC)</td>
</tr>
<tr>
<td>CP1026</td>
<td>Windows 1026 (EBCDIC)</td>
</tr>
<tr>
<td>CP1250</td>
<td>Windows 1250 (Eastern Europe)</td>
</tr>
<tr>
<td>CP1251</td>
<td>Windows 1251 (Cyrillic)</td>
</tr>
<tr>
<td>CP1252</td>
<td>Windows 1252 (Latin1)</td>
</tr>
<tr>
<td>CP1253</td>
<td>Windows 1253 (Greek)</td>
</tr>
<tr>
<td>CP1254</td>
<td>Windows 1254 (Turkish)</td>
</tr>
<tr>
<td>CP1255</td>
<td>Windows 1255 (Hebrew)</td>
</tr>
<tr>
<td>CP1256</td>
<td>Windows 1256 (Arabic)</td>
</tr>
<tr>
<td>CP1257</td>
<td>Windows 1257 (Baltic)</td>
</tr>
<tr>
<td>CP1258</td>
<td>Windows 1258 (Vietnamese)</td>
</tr>
<tr>
<td>CP1361</td>
<td>Windows 1361 (Korean Johab)</td>
</tr>
<tr>
<td>CP437</td>
<td>MS-DOS 437 (US)</td>
</tr>
<tr>
<td>CP500</td>
<td>Windows 500 (EBCDIC 500V1)</td>
</tr>
<tr>
<td><strong>Character Set</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>CP708</td>
<td>Windows 708 (Arabic - ASMO708)</td>
</tr>
<tr>
<td>CP720</td>
<td>Windows 720 (Arabic - ASMO)</td>
</tr>
<tr>
<td>CP737</td>
<td>Windows 737 (Greek - 437G)</td>
</tr>
<tr>
<td>CP775</td>
<td>Windows 775 (Baltic)</td>
</tr>
<tr>
<td>CP850</td>
<td>MS-DOS 850 (Latin1)</td>
</tr>
<tr>
<td>CP852</td>
<td>MS-DOS 852 (Latin2)</td>
</tr>
<tr>
<td>CP855</td>
<td>MS-DOS 855 (IBM Cyrillic)</td>
</tr>
<tr>
<td>CP857</td>
<td>MS-DOS 857 (IBM Turkish)</td>
</tr>
<tr>
<td>CP860</td>
<td>MS-DOS 860 (IBM Portuguese)</td>
</tr>
<tr>
<td>CP861</td>
<td>MS-DOS 861 (Icelandic)</td>
</tr>
<tr>
<td>CP862</td>
<td>MS-DOS 862 (Hebrew)</td>
</tr>
<tr>
<td>CP863</td>
<td>MS-DOS 863 (Canadian French)</td>
</tr>
<tr>
<td>CP864</td>
<td>MS-DOS 864 (Arabic)</td>
</tr>
<tr>
<td>CP865</td>
<td>MS-DOS 864 (Nordic)</td>
</tr>
<tr>
<td>CP866</td>
<td>MS-DOS 866 (Russian)</td>
</tr>
<tr>
<td>CP869</td>
<td>MS-DOS 869 (Modern Greek)</td>
</tr>
<tr>
<td>CP870</td>
<td>Windows 870</td>
</tr>
<tr>
<td>CP874</td>
<td>Windows 864 (Thai)</td>
</tr>
<tr>
<td>CP875</td>
<td>Windows 875 (EBCDIC)</td>
</tr>
<tr>
<td>CP932</td>
<td>Windows 932 (Japanese)</td>
</tr>
<tr>
<td>CP936</td>
<td>Windows 936 (Simplified Chinese)</td>
</tr>
<tr>
<td>CP949</td>
<td>Windows 949 (Korean)</td>
</tr>
<tr>
<td>CP950</td>
<td>Windows 950 (Traditional Chinese)</td>
</tr>
<tr>
<td>EBCDIC</td>
<td>IBM EBCDIC CCSID37 (USA)</td>
</tr>
<tr>
<td>EUC-JP</td>
<td>Extended Unix Code (Japanese)</td>
</tr>
<tr>
<td>EUC-KR</td>
<td>Extended Unix Code (Korean)</td>
</tr>
<tr>
<td>EUC-TW</td>
<td>Extended Unix Code (Taiwan)</td>
</tr>
<tr>
<td><strong>Character Set</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>EUC-TW-1986</td>
<td>Extended Unix Code (TW-1986)</td>
</tr>
<tr>
<td>GB12345</td>
<td>GB 2312 (Simplified Chinese)</td>
</tr>
<tr>
<td>GB2312</td>
<td>GB 2312 (Simplified Chinese)</td>
</tr>
<tr>
<td>ISO_8859-1</td>
<td>ISO 8859-1 (Latin1)</td>
</tr>
<tr>
<td>ISO_8859-10</td>
<td>ISO 8859-10 (Latin6)</td>
</tr>
<tr>
<td>ISO_8859-11</td>
<td>ISO 8859-11 (Thai)</td>
</tr>
<tr>
<td>ISO_8859-14</td>
<td>ISO 8859-14 (Latin8)</td>
</tr>
<tr>
<td>ISO_8859-15</td>
<td>ISO 8859-15 (Latin9 / Latin0)</td>
</tr>
<tr>
<td>ISO_8859-2</td>
<td>ISO 8859-2 (Latin2)</td>
</tr>
<tr>
<td>ISO_8859-3</td>
<td>ISO 8859-3 (Latin3)</td>
</tr>
<tr>
<td>ISO_8859-4</td>
<td>ISO 8859-4 (Latin4)</td>
</tr>
<tr>
<td>ISO_8859-5</td>
<td>ISO 8859-5 (Cyrillic)</td>
</tr>
<tr>
<td>ISO_8859-6</td>
<td>ISO 8859-6 (Arabic)</td>
</tr>
<tr>
<td>ISO_8859-7</td>
<td>ISO 8859-7 (Greek)</td>
</tr>
<tr>
<td>ISO_8859-8</td>
<td>ISO 8859-8 (Hebrew)</td>
</tr>
<tr>
<td>ISO_8859-9</td>
<td>ISO 8859-9 (Latin5)</td>
</tr>
<tr>
<td>JIS_X0201</td>
<td>Japanese Half-width Katakana</td>
</tr>
<tr>
<td>JIS_X_0208</td>
<td>Japanese Kanji</td>
</tr>
<tr>
<td>Java</td>
<td>Java (Unicode encoding)</td>
</tr>
<tr>
<td>Johab</td>
<td>Johab (Korean)</td>
</tr>
<tr>
<td>Shift_JIS</td>
<td>Shift-JIS (Japanese)</td>
</tr>
<tr>
<td>UCS2</td>
<td>Unicode UCS-2</td>
</tr>
<tr>
<td>UTF7</td>
<td>Unicode UTF-7</td>
</tr>
<tr>
<td>UTF8</td>
<td>Unicode UTF-8</td>
</tr>
</tbody>
</table>
## Working with Text Translate Values

Use the Field Definition Table component - Interface Field1 page, Text field to select translate values.

See Setting Up the Field Definition Table.

Translate values correspond to data elements that are already available to the COBOL process. The following table lists the field values, their translate values, and where the data originates.

<table>
<thead>
<tr>
<th>Value</th>
<th>Translate Value</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Pay Period Begin Date</td>
<td>PAY.Calendar.PAY_BEGIN_DT</td>
</tr>
<tr>
<td>C</td>
<td>Constant</td>
<td>PI.Field_TBL.PI_DFLT_VALUE</td>
</tr>
<tr>
<td>D</td>
<td>Compare Date</td>
<td>PI.Run_PYGRP.COMpare_DTTM</td>
</tr>
<tr>
<td>E</td>
<td>Export Date</td>
<td>System date at runtime</td>
</tr>
<tr>
<td>F</td>
<td>PI Config ID</td>
<td>PAY.Group.PI_CONFIG_ID</td>
</tr>
<tr>
<td>G</td>
<td>Termination Count</td>
<td>Process Calculation</td>
</tr>
<tr>
<td>H</td>
<td>Hire count</td>
<td>Process Calculation = Hired this run</td>
</tr>
<tr>
<td>I</td>
<td>External Record Code</td>
<td>PI.DEFN_Record.PI_RECORD_ID</td>
</tr>
<tr>
<td>L</td>
<td>Logical Record Count</td>
<td>Process Calculation</td>
</tr>
<tr>
<td>M</td>
<td>Société de Traitement</td>
<td>(Processing Paygroup) Derived during Processing</td>
</tr>
<tr>
<td>N</td>
<td>Interface Run Number</td>
<td>PI.Run_TBL.PI_RUN_NUM</td>
</tr>
<tr>
<td>O</td>
<td>Process Option</td>
<td>PI.RunCTL.PI_RUN_OPT</td>
</tr>
<tr>
<td>P</td>
<td>Pay End Date</td>
<td>PAY.Calendar.PAY_END_DT</td>
</tr>
<tr>
<td>Q</td>
<td>Check Date</td>
<td>PAY.Calendar.PAY_CHECK_DT</td>
</tr>
<tr>
<td>R</td>
<td>Pay Run ID</td>
<td>PI.Run_CTL.RUN_ID</td>
</tr>
<tr>
<td>S</td>
<td>System ID</td>
<td>PI.CONFIG_TBL.PI_SYSTEM_ID</td>
</tr>
<tr>
<td>T</td>
<td>Compare Time</td>
<td>PI.Run_PYGRP.COMpare_DTTM</td>
</tr>
<tr>
<td>U</td>
<td>Lot de Paie de Traitement</td>
<td>(Processing Company) Derived during Processing</td>
</tr>
<tr>
<td>X</td>
<td>Export Time</td>
<td>System Date Time value at runtime</td>
</tr>
<tr>
<td>Y</td>
<td>Physical Record Count</td>
<td>Process Calculation</td>
</tr>
</tbody>
</table>
Working with Company Filtering

Use the Definition Table component - Interface Definition Fields page, Key Field field to select Company as the key field.

See Setting Up the Definition Table.

Company filtering restricts Payroll Interface processing to a single company. With company filtering, the Company value that is assigned to a particular row of data must be the same as the company that you are processing for the row to be formatted and passed to the interface. If company filtering is not used, all rows created by Payroll Interface for each company and pay group combination are available for export.

For example, in PeopleSoft, you indicate that an employee has transferred from one company to another by adding a new JOB row with the Transfer action. In some third-party payroll systems, however, the company is part of the employee key; therefore, when an employee transfers to another company, Payroll Interface creates a new employee dossier (pool of data). For the transferred employee, you issue a termination on the old company and a hire on the new company.

After a transfer occurs, the system creates two images within Payroll Interface, one for each company. With company filtering, a change in employee data may apply to both images (the case for personal data rows, which would not have Company as a key field). In other cases, it may apply to one image (such as JOB row data, which you would generally want to filter by company). You can track retroactive changes even if the changes pertain to a company that the employee has already left. If you had not used company filtering, the third-party payroll system would store one set of transactions, without creating separate dossiers and without redundant data (like personal data rows).

This graphic shows how company filtering maps an employee's company data into separate files:

**Image: Company filtering**

This diagram shows how company filtering maps an employee's company data into separate files.
This example shows a worker employed in multiple companies over a period of five years. Assume that only one pay group exists per company.

<table>
<thead>
<tr>
<th>Company</th>
<th>Effdt</th>
<th>Comprate</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCB</td>
<td>01-01-1999</td>
<td>500</td>
</tr>
<tr>
<td>CCB</td>
<td>01-01-1998</td>
<td>450</td>
</tr>
<tr>
<td>PST</td>
<td>01-01-1997</td>
<td>425</td>
</tr>
<tr>
<td>PST</td>
<td>01-01-1996</td>
<td>400</td>
</tr>
<tr>
<td>CCB</td>
<td>01-01-1995</td>
<td>325</td>
</tr>
</tbody>
</table>

If you change data in the 1995 row, you must send the data to company CCB. If you change the 1997 row, you send the data to company PST.

To implement company filtering:

1. Select *Company* for the System Table component, Interface System Table 1 page, Process Filter field.
2. Select *Company* for the Definition Table component - Interface Definition Fields page, Key Field field for those records that will be filtered by company.
3. For the company fields, use either a constant value equal to the processing company (used for personal data) or use the company from the Job Data component (or from a view based on the tables underlying the Job Data component).

**Note:** The system compares the field that is mapped as company to the processing company only after translation.

### Working with Key Fields

Use the Definition Table component - Interface Definition Fields page, Key Field field to define a field as an occurrence (*Occurrence*) key or and effective-date (*Effdt*) key.

See Setting Up the Definition Table.

When you define a field as an occurrence key, multiple records (rows) are formatted for export. When you define a field as an effective-date key, the retrieved data is put through an extra process to eliminate redundant records (rows) from the PI_PARTIC_EXPT table.

For example, suppose the Job Data table contains the data shown in this table:

<table>
<thead>
<tr>
<th>Effective Date</th>
<th>Effective Sequence</th>
<th>Comprate</th>
<th>Department ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999-01-15</td>
<td>0</td>
<td>100</td>
<td>00100</td>
</tr>
<tr>
<td>1998-12-12</td>
<td>0</td>
<td>100</td>
<td>00200</td>
</tr>
</tbody>
</table>
Chapter 10 Setting Up a Payroll Interface Definition (Part 2)

<table>
<thead>
<tr>
<th>Effective Date</th>
<th>Effective Sequence</th>
<th>Comprate</th>
<th>Department ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1998-12-10</td>
<td>0</td>
<td>85</td>
<td>00200</td>
</tr>
<tr>
<td>1997-06-10</td>
<td>0</td>
<td>85</td>
<td>00300</td>
</tr>
<tr>
<td>1997-05-31</td>
<td>0</td>
<td>75</td>
<td>00400</td>
</tr>
</tbody>
</table>

If you define the Effective Date field as an occurrence key, the following data is formatted for export:

<table>
<thead>
<tr>
<th>Effective Date</th>
<th>Comprate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1999-01-15</td>
<td>100</td>
</tr>
<tr>
<td>1998-12-12</td>
<td>100</td>
</tr>
<tr>
<td>1998-12-10</td>
<td>85</td>
</tr>
<tr>
<td>1997-06-10</td>
<td>85</td>
</tr>
<tr>
<td>1997-05-31</td>
<td>75</td>
</tr>
</tbody>
</table>

If you define the Effective Date field as an effective-date key, the following data is formatted for export:

<table>
<thead>
<tr>
<th>Effective Date</th>
<th>Comprate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1998-12-12</td>
<td>100</td>
</tr>
<tr>
<td>1997-06-10</td>
<td>85</td>
</tr>
<tr>
<td>1997-05-31</td>
<td>75</td>
</tr>
</tbody>
</table>

Warning! Accurate processing depends on the collate order that you specify for the effective-dated field. On the PS Tables component - PS Tables page, Collate Order field, you must select Asc (ascending). If you do not select the ascending collate order, you will eliminate all but the last row.

Working with COBOL Processes

This topic discusses how to:

• Review delivered COBOL processes.
• Review delivered COBOL processes for special events.
• Create COBOL routines.

Reviewing Delivered COBOL Processes

Use the Process Table component - Interface Process Table page, Process Description field to review descriptions of the COBOL processes that are delivered with Payroll Interface.
The delivered COBOL processes are either field or record processes (you can associate a process with either a field or a record) that perform processing tasks outside the normal scope of Payroll Interface.

See Setting Up the Process Table.

**Example: Process ID 000015**

This COBOL process performs a validation against some data values and sets the value of the field to which the process is attached to one of the values listed in the Interface Process Table page, Returned Value field. Because the timing is Before Field Translation, you can then use these values in the Field Translation list. The list of values in the Returned Value field documents the process so that you know which values can be used in the Field Translation list and what they represent. This technique enables you to leverage one COBOL routine for two fields.

This process is useful because the PeopleSoft system stores certain tax values in two separate fields: one field for percents and another field for flat amounts. For this type of field, some payroll systems have one field with a Type code to specify whether it is a percent or an amount. The COBOL process determines which PeopleSoft field contains the value and returns those fields that are equal to the one identified in the Returned Value field. The Payroll Interface process then converts or translates the value in the Returned Value field to another value based on the Field Translation list.

**Delivered Processes**

This table lists and describes the COBOL processes that are delivered with PeopleSoft Payroll Interface:

<table>
<thead>
<tr>
<th>Process ID</th>
<th>Process Phase</th>
<th>Description</th>
<th>Type</th>
<th>User Defined Process</th>
<th>User Exit Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>000001</td>
<td>Record Processing</td>
<td>Ded End Dt</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>When the primary PeopleSoft source for the transaction is additional earnings, matches the earnings end date against the pay end date to determine whether the additional earnings should be stopped.</td>
</tr>
<tr>
<td>000002</td>
<td>Before Field Translation</td>
<td>Area Code</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Extracts the U.S. area code from the phone number field if the field contains 10 characters. If the field contains fewer than 10 characters, spaces are returned.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Process Phase</td>
<td>Description</td>
<td>Type</td>
<td>User Defined Process</td>
<td>User Exit Program</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------</td>
<td>---------------</td>
<td>----------</td>
<td>-----------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>000003</td>
<td>Before Field Translation</td>
<td>City Code1</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Returns the locality code for the City 1 field. If the employee has more than one locality code defined, the code returned is where he or she works.</td>
</tr>
<tr>
<td>000004</td>
<td>Before Field Translation</td>
<td>City Code2</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Uses the City2 Code value only if resident state and work state are different. Uses the translate entries when needed.</td>
</tr>
<tr>
<td>000005</td>
<td>Before Field Translation</td>
<td>Cnt Deduct</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Adds 1 to a counter for deductions using fields that are mapped to the ON1 field. Issues a warning message when the employee has more than 24 deductions.</td>
</tr>
<tr>
<td>000005</td>
<td>Export File Creation</td>
<td>Tilde Chr</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>For delimited data file structures only. Inserts a Delete character as defined in the working storage of the COBOL program PIPXPRCS.CBL. A tilde (~) follows the value of the field to be deleted. Only works when invoked from a Process Control record definition.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Process Phase</td>
<td>Description</td>
<td>Type</td>
<td>User Defined Process</td>
<td>User Exit Program</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------</td>
<td>---------------</td>
<td>-------</td>
<td>----------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>000006</td>
<td>Record Processing</td>
<td>Co change</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Recognizes that the PeopleSoft company ID for this employee has changed. When using this process, the PeopleSoft company ID must be mapped to a field within the record. If the converted value for the PeopleSoft company ID changes, the record containing this process ID is formatted.</td>
</tr>
<tr>
<td>000008</td>
<td>After Field Translation</td>
<td>Excess</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Returns the translated deduction code for the direct deposit bank account identified to contain the &quot;excess&quot; within PeopleSoft.</td>
</tr>
<tr>
<td>000008</td>
<td>Export File Creation</td>
<td>Skip Blank</td>
<td>Field</td>
<td>Yes</td>
<td>PIPXPADP</td>
<td>Bypasses this field in the output file if the Export Full option is selected and the field is blank.</td>
</tr>
<tr>
<td>000009</td>
<td>Before Field Translation</td>
<td>Lcl recip</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Creates values to apply to the translate table. If Local 2 exists, then Field 1 will be resident local and Field 02 will be work local.</td>
</tr>
<tr>
<td>000010</td>
<td>Before Field Translation</td>
<td>First Name</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Extracts the first name from the PeopleSoft Name field on the Personal Data Table.</td>
</tr>
<tr>
<td>000011</td>
<td>Before Field Translation</td>
<td>Last Name</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Extracts the last name from the PeopleSoft Name field on the Personal Data Table.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Process Phase</td>
<td>Description</td>
<td>Type</td>
<td>User Defined Process</td>
<td>User Exit Program</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>----------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>000012</td>
<td>After Field Translation</td>
<td>New Hire</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Sets the new hire action to a lowercase N. This is set when no history records exist for the employee.</td>
</tr>
<tr>
<td>000013</td>
<td>Before Field Translation</td>
<td>Old PI ID</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Uses the employee's previous PI_EMPLID.</td>
</tr>
<tr>
<td>000014</td>
<td>Before Field Translation</td>
<td>Before Field Translation</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Maps the previous export value for this field into the current record.</td>
</tr>
<tr>
<td>000015</td>
<td>Before Field Translation</td>
<td>Pct or Amt</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Derives a type code from data in two related numeric fields. The first is the amount, the second is the percent. Both fields must be on the same table and row. The return values reflect non-zero entries in the fields. Examples include Federal Tax Data, Additional Amount, and Additional Percent.</td>
</tr>
<tr>
<td>000016</td>
<td>Export File Creation</td>
<td>Bypass Rec</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Bypasses the entire record on the output file.</td>
</tr>
<tr>
<td>000016</td>
<td>Import Processing</td>
<td>Bypass Rec</td>
<td>Record</td>
<td>Yes</td>
<td>PIPMPADP</td>
<td>Validates and bypasses the record during the import process.</td>
</tr>
<tr>
<td>000017</td>
<td>Before Field Translation</td>
<td>Phone No</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Extracts the 7-digit phone number from the free-form Phone field.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Process Phase</td>
<td>Description</td>
<td>Type</td>
<td>User Defined Process</td>
<td>User Exit Program</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------</td>
<td>-------------</td>
<td>------</td>
<td>----------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>000018</td>
<td>Record Processing</td>
<td>Pygrp chg</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Recognizes that the PeopleSoft pay group for this employee has changed. When using this process, the PeopleSoft pay group must be mapped to a field within the record. If the translated value for the PeopleSoft pay group changes, the record containing this process ID is formatted.</td>
</tr>
<tr>
<td>000019</td>
<td>After Field Translation</td>
<td>Rehire Cd</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>If the employee's status code was terminated the last time this employee's data was exported, but the current status code is Active, sets the Rehire code.</td>
</tr>
<tr>
<td>000020</td>
<td>Before Field Translation</td>
<td>RmSlsh/Dsh</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Returns the data value from the PeopleSoft database minus any embedded slashes or dashes. Use to return the U.S. ZIP code value without the separating dash and to return a phone number without dashes.</td>
</tr>
<tr>
<td>000021</td>
<td>Before Field Translation</td>
<td>State 2 Cd</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Uses the Resident State Code if resident state and work state are different. Uses the translate entries when needed.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Process Phase</td>
<td>Description</td>
<td>Type</td>
<td>User Defined Process</td>
<td>User Exit Program</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------</td>
<td>-------------</td>
<td>------</td>
<td>----------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>000022</td>
<td>Before Field Translation</td>
<td>Std Hours</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Calculates standard hours per pay period from standard weekly hours and pay frequency of the pay group.</td>
</tr>
<tr>
<td>000023</td>
<td>Record Processing</td>
<td>Stop DirDp</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Recognizes that the Direct Deposit code no longer applies for this employee. The record containing this process ID is formatted.</td>
</tr>
<tr>
<td>000024</td>
<td>Record Processing</td>
<td>Stop AdPay</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Recognizes that Additional Payment no longer applies for this employee. The record containing this process ID is formatted.</td>
</tr>
<tr>
<td>000025</td>
<td>Before Field Translation</td>
<td>Stop Code</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Returns a Yes indicator (a returned value of &quot;Y&quot;) when one of the following events occurs: Stop Deduction, Stop Direct Deposit, Stop Additional Pay, PI Employee ID change, Company change or Pay Group change.</td>
</tr>
<tr>
<td>000026</td>
<td>Record Processing</td>
<td>Stop Ded</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Recognizes that the deduction code no longer applies for this employee. The record containing this process ID is formatted.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Process Phase</td>
<td>Description</td>
<td>Type</td>
<td>User Defined Process</td>
<td>User Exit Program</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------</td>
<td>---------------</td>
<td>-----------</td>
<td>----------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>000027</td>
<td>Record Processing</td>
<td>Stop Goals</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Recognizes that deduction goals no longer apply for this employee. The record containing this process ID is formatted.</td>
</tr>
<tr>
<td>000028</td>
<td>Before Field Translation</td>
<td>Stop Date</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Returns a stop date when any of the following events occur: Stop Deduction, Stop Direct Deposit, Stop Additional Pay, PI Employee ID change, Company change and Pay Group change. The date supplied is the pay begin date minus one day. If the event does not occur, spaces are supplied for the stop data.</td>
</tr>
<tr>
<td>000029</td>
<td>Record Processing</td>
<td>Stop Save</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Recognizes that the savings plan deduction no longer applies for this employee. The record containing this process ID is formatted.</td>
</tr>
<tr>
<td>000030</td>
<td>Before Field Translation</td>
<td>ST Recip</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Creates values to apply to the translate table. If State 2 exists, then Field 1 is the resident state and Field 2 is the work state.</td>
</tr>
</tbody>
</table>
| 000031     | Record Processing      | Transfer      | Record    | Yes                  | PIPSPADP           | Detects when the transfer transaction should be formatted. }
<table>
<thead>
<tr>
<th>Process ID</th>
<th>Process Phase</th>
<th>Description</th>
<th>Type</th>
<th>User Defined Process</th>
<th>User Exit Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>000031</td>
<td>Export File Creation</td>
<td>Transfer</td>
<td>Record</td>
<td>Yes</td>
<td>PIPXPADP</td>
<td>Recognizes when the PI_EMPID for an employee has changed. The transfer transaction is generated to include the appropriate change indicators for the fields that have changed.</td>
</tr>
<tr>
<td>000032</td>
<td>Before Field Translation</td>
<td>MD Local %</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Calculates the Maryland locality percentage. Translate values apply only when State 1 is Maryland.</td>
</tr>
<tr>
<td>000033</td>
<td>After Field Translation</td>
<td>SUI/SDI</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Generates an error message and does not export the employee's data to ADP if a change is detected in this field and the employee has not been assigned a new PI_EMPLID. Use to validate a change to the SUI/SDI state tax code.</td>
</tr>
<tr>
<td>000034</td>
<td>Before Field Translation</td>
<td>&gt; 3 DirDep</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Edits the employee data for more than three direct deposit accounts.</td>
</tr>
<tr>
<td>000035</td>
<td>After Field Translation</td>
<td>New PI ID</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Uses the current or &quot;new&quot; PI-EMPLID when the old PI_EMPLID is not the same as the current PI_EMPLID assigned to the PeopleSoft employee ID.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Process Phase</td>
<td>Description</td>
<td>Type</td>
<td>User Defined Process</td>
<td>User Exit Program</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>-------------</td>
<td>------</td>
<td>----------------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>000036</td>
<td>Import</td>
<td>DPA09</td>
<td>Field</td>
<td>Yes</td>
<td>PIPMPADP</td>
<td>Saves pay date 1 from the Direct Pay header record for access by process 000040.</td>
</tr>
<tr>
<td>000037</td>
<td>Import</td>
<td>DPA10</td>
<td>Field</td>
<td>Yes</td>
<td>PIPMPADP</td>
<td>Saves the pay period end date 1 from the Direct Pay header record for access by process 000040.</td>
</tr>
<tr>
<td>000038</td>
<td>Import</td>
<td>DPA11</td>
<td>Field</td>
<td>Yes</td>
<td>PIPMPADP</td>
<td>Saves the pay date 2 from the Direct Pay header record for access by process 000040.</td>
</tr>
<tr>
<td>000039</td>
<td>Import</td>
<td>DPA12</td>
<td>Field</td>
<td>Yes</td>
<td>PIPMPADP</td>
<td>Saves pay period end date 2 from the Direct Pay header record for access by process 000040.</td>
</tr>
<tr>
<td>000040</td>
<td>Import</td>
<td>DPB11</td>
<td>Field</td>
<td>Yes</td>
<td>PIPMPADP</td>
<td>Selects pay dates 1 or 2 from the Direct Pay header record. PI_CHECK key fields are based upon the value of this field.</td>
</tr>
<tr>
<td>000041</td>
<td>Import</td>
<td>PCX 3E8</td>
<td>Field</td>
<td>Yes</td>
<td>PIPMPADP</td>
<td>Updates PI_BALANCE_YEAR, PI_BALANCE_PERIOD and PI_BALANCE_QTR based upon the as of date.</td>
</tr>
<tr>
<td>000042</td>
<td>Import</td>
<td>PCX 3E9</td>
<td>Field</td>
<td>Yes</td>
<td>PIPMPADP</td>
<td>Updates all of the current employee's balance entries before they are inserted in the database.</td>
</tr>
<tr>
<td>Process ID</td>
<td>Process Phase</td>
<td>Description</td>
<td>Type</td>
<td>User Defined Process</td>
<td>User Exit Program</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>--------------------</td>
<td>------</td>
<td>----------------------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>000043</td>
<td>After Field Translation</td>
<td>Goal Amts</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Paired with special process 000044. Does not send the goal limit amount if it is zero on setup. Formats the reset of a goal limit amount to zero when needed.</td>
</tr>
<tr>
<td>000044</td>
<td>After Field Translation</td>
<td>Goal Code</td>
<td>Field</td>
<td>Yes</td>
<td>PIPSPADP</td>
<td>Pairs the Goal Limit codes with the Goal Limit Amount.</td>
</tr>
<tr>
<td>000045</td>
<td>Before Field Translation</td>
<td>Middle Int</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Retrieves the person's middle initial from the Name field. Names are entered last name, first name, and middle name. This routine takes the first character following the space after the first name.</td>
</tr>
<tr>
<td>000046</td>
<td>Before Field Translation</td>
<td>Middle Nme</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Retrieves the person's middle name from the Name field.</td>
</tr>
<tr>
<td>000047</td>
<td>Export File Creation</td>
<td>Skip Field</td>
<td>Field</td>
<td>Yes</td>
<td>PIPXPADP</td>
<td>Causes the export process to bypass the field on the output file when the Export Full option is used and the field is blank.</td>
</tr>
<tr>
<td>000048</td>
<td>Export File Creation</td>
<td>Bypass Fld</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>Bypasses the field in the output transaction file.</td>
</tr>
<tr>
<td>000049</td>
<td>Record Processing</td>
<td>Eff Status</td>
<td>Record</td>
<td>No</td>
<td>None</td>
<td>Checks the effective status field. If it is not active, the data will not be formatted for export.</td>
</tr>
</tbody>
</table>
### Setting Up a Payroll Interface Definition (Part 2)

#### Chapter 10

<table>
<thead>
<tr>
<th>Process ID</th>
<th>Process Phase</th>
<th>Description</th>
<th>Type</th>
<th>User Defined Process</th>
<th>User Exit Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>000050</td>
<td>Record Processing</td>
<td>CSV</td>
<td>Record</td>
<td>Yes</td>
<td>PIPSPRCS</td>
<td>Marks records with a stop deduction as having a stop on the PI Partic Export.</td>
</tr>
<tr>
<td>000200</td>
<td>Before Field Translation</td>
<td>GVT Remark</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>(USF only) Creates an array of remarks codes from the SF50 remarks for inclusion in EPIC Record.</td>
</tr>
<tr>
<td>000201</td>
<td>Before Field Translation</td>
<td>Tang Amt</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>(USF only) If Tangible Benefits &gt; 0 sets to &quot;Y&quot; else blank.</td>
</tr>
<tr>
<td>000202</td>
<td>Before Field Translation</td>
<td>Intang Amt</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>(USF only) If Intangible Benefits &gt; 0 sets to &quot;Y&quot; else blank.</td>
</tr>
<tr>
<td>000203</td>
<td>Export File Creation</td>
<td>Geo Code</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>(USF only) Process GVT_GEOLOC_CD Code.</td>
</tr>
<tr>
<td>000204</td>
<td>Before Field Translation</td>
<td>Hire Date</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>(USF only) Hire Date evaluation.</td>
</tr>
<tr>
<td>000205</td>
<td>Before Field Translation</td>
<td>Posn Title</td>
<td>Field</td>
<td>No</td>
<td>None</td>
<td>(USF only) Position Title Code/ Description.</td>
</tr>
</tbody>
</table>

### Reviewing Delivered COBOL Processes for Special Events

The Definition Table component - Interface Definition Record page, Process ID field enables you to access COBOL processes that signal special events (transactions) such as a Stop Deduction. These events set an indicator that can be used later by another special process indicator. The following table lists the processes that PeopleSoft Payroll Interface delivers for special events.

See Setting Up the Definition Table.

**Note:** The processes listed in this topic are a subset of the COBOL processes that are delivered with Payroll Interface.

See Reviewing Delivered COBOL Processes.

See Working with Transactions.
<table>
<thead>
<tr>
<th><strong>Process ID</strong></th>
<th><strong>Description</strong></th>
<th><strong>Record Type</strong></th>
<th><strong>Special Event</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>00001</td>
<td>0N1 Change</td>
<td>Data</td>
<td>Used for logical file types. Assigned to data records for DED_CALC and savings.</td>
</tr>
<tr>
<td>000023</td>
<td>Stop DirDP</td>
<td>Process</td>
<td>Stops direct deposit.</td>
</tr>
<tr>
<td>000024</td>
<td>Stop AdPay</td>
<td>Process</td>
<td>Stops additional payment. Assigned the stop record.</td>
</tr>
<tr>
<td>000026</td>
<td>Stop Ded</td>
<td>Process</td>
<td>Stop deduction. Assigned the stop record.</td>
</tr>
<tr>
<td>000027</td>
<td>Stop Goals</td>
<td>Process</td>
<td>Stop deduction goal. Assigned the stop record.</td>
</tr>
<tr>
<td>000029</td>
<td>Stop Save</td>
<td>Process</td>
<td>Stop savings plan deduction. Assigned the stop record.</td>
</tr>
<tr>
<td>000050</td>
<td>Savings, Additional Pay</td>
<td>Data</td>
<td>Assigned to the data records for non-logical file formats (such as CSV) for additional pay and savings plan before and after tax. These record IDs must be named: &quot;SAVE&quot; for before-tax savings, &quot;SPAT&quot; for after-tax savings, &quot;APAY&quot; for additional pay</td>
</tr>
</tbody>
</table>

**Creating COBOL Routines**

You can create your own COBOL routines for use with Payroll Interface. The system isolates your COBOL routines from the delivered Payroll Interface COBOL processes and calls them by retrieving the name specified on the Process Table component - Interface Process Table page, User Exit Program field.

Shell programs for three user exit invocation points are provided with Payroll Interface. You can use these programs as templates for your COBOL routines:

- **PIPMPOTh**: For routines performed during the Import process.
- **PIPSPOTH**: For routines performed during the Export process select/compare phases.
- **PIPXPOTh**: For routines performed during the Export process create export file phase.

To define your own COBOL routine:

1. Make a copy of the shell program that is associated with the Payroll Interface process phase in which your special process routine will be performed.
Do not modify the shell programs. These programs are set up with all the necessary working storage and linkage section data elements already defined and should be preserved as modules for future development.

2. Change all references to the shell program name to the name of your new routine.

Follow the PeopleSoft naming convention to make it easier to identify the timing of your own routines. You should change the last three characters of the program name to the system ID for which the routine is written. For example, the ADP system ID has three routines: \textit{PIPMPADP}, \textit{PIPSPADP}, and \textit{PIPXPADP}.

3. Select a process ID for your new routine.

Review copy member \textit{PICPRCSW.CBL} and select an unassigned number between 80000 and 899999. These numbers will not be used by PeopleSoft development. Add an 88 level description for your new routine in the copy member. Code your program logic and compile your program.

4. Define your new routine to Payroll Interface by setting up a process ID using the Process Table component.

\textbf{Note:} For AS400 and Oracle/VMS platforms, you must specify the calls to your user exit programs in copy member \textit{PICUEXIT.CBL}. Edit this copy member to add your new program in the appropriate place.

\textbf{Related Links}

- Setting Up the System Table
- Setting Up the Process Table

\section*{Working with Smart Select}

The Select Type field on the Import/Export Payroll Data component - Import/Export Payroll Data page has three options: \textit{All Employees in Group}, \textit{Manually Select}, and \textit{Smart Select}. The Smart Select option provides substantial performance benefits by enabling you to process only those employees who have had online changes since the last time the Export process was run.

When deciding whether to use Smart Select, consider the following:

- Smart Select is recommended for use with very large companies.

- To activate Smart Select, you must add a PeopleCode function, \texttt{UPDATE_SMARTSELECT}, to each EMPLID-keyed table that is set up in the PS Tables component—including those EMPLID-keyed tables that are referenced indirectly through views.

  When data changes in these tables, a record that includes the EMPLID and EMPL_RCD key fields, as well as the data change, is written to the \texttt{PS_PI_PRESELECT} table. When you run the Export process using the \textit{Smart Select} option, Payroll Interface processes only those records in the \texttt{PS_PI_PRESELECT} table.

- Smart Select detects online changes only.
At least once per payroll cycle you should run the Export process with the All Employees in Group option selected to process records that have changes but do not have the PeopleCode function attached, or to process records that have changes that were made outside of the online system (for example, deduction calculations or a batch update to your employees).

**Note:** If you update employees other than online, but they represent only a small percentage of all employees, you can manually update the PS_PI_PRESELECT table for these employees and then run the Export process with the Smart Select option selected.

- Smart Select detects changes to EMPLID-keyed tables only. You should run the Export process with the All Employees in Group option selected whenever you change the Payroll Interface definition, change any tables referenced in the PS Tables component that is not keyed on the EMPLID field, or are processing a group of employees for the first time.

### Activating Smart Select

Payroll Interface provides a PeopleCode function, UPDATE_SMARTSELECT, which tracks online changes and makes the information available to the Export process. To activate Smart Select, you must add this function to each EMPLID-keyed table that is referenced by the PS Tables component—including those EMPLID-keyed tables that are referenced indirectly through views. The example in this topic shows how to activate Smart Select for the Citizenship table (record). Follow these same steps to activate Smart Select for other EMPLID-keyed tables.

To activate the Smart Select code for the Citizenship table:

1. Start PeopleSoft Application Designer.
2. Select File, Open.
   
   The Open Definition dialog box appears.

3. From the Open Definition dialog box, do the following:
   
   - For the Definition field, select Record.
   - For the Name field, enter CITIZENSHIP.
   - Select Open.

   The CITIZENSHIP (Record) dialog box appears.

4. Select View, PeopleCode Display.

   The CITIZENSHIP (Record) dialog box displays a grid.

5. For the EMPLID field, locate the SPo (SavePostChange) cell in the grid.

   PeopleCode may or may not be indicated for the EMPLID field in the SPo cell.

6. Double-click the SPo cell to open the PeopleCode editor.

   The CITIZENSHIP.EMPLID.SavePostChange (Record PeopleCode) dialog box appears.

7. For the EMPLID field, add the following PeopleCode:
Declare Function UPDATE_SMARTSELECT PeopleCode
PI_PRESELECT.PI_SELECT_TYPE FieldFormula;

8. For the EMPLID field, add the following PeopleCode:

- If EMPL_RCD is a field in the CITIZENSHIP table, add:
  
  UPDATE_SMARTSELECT (EMPLID, EMPL_RCD, 'Y');

- If EMPL_RCD is not a field in the CITIZENSHIP table, add:
  
  UPDATE_SMARTSELECT (EMPLID, 0, 'N');

Note: The 'Y' or 'N' at the end of the parameter list indicates whether EMPL_RCD exists in the record. If it does not exist, then all jobs for a multijob employee will be processed in the next Smart Select export.

9. Save the PeopleCode and the table (record).

This example shows the Citizenship table (record):

**Image: CITIZENSHIP table (record)**

This example illustrates the fields and controls on the CITIZENSHIP table (record).

This example shows the PeopleCode that is required to activate Smart Select:

**Image: PeopleCode function UPDATE_SMARTSELECT**

This example illustrates the fields and controls on the PeopleCode function UPDATE_SMARTSELECT.
PeopleCode Function UPDATE_SMARTSELECT

The PeopleCode function UPDATE_SMARTSELECT tracks and records online data changes using the PS_PI_PRESELECT table.

Function UPDATE_SMARTSELECT(&EMPLID, &EMPL_RCD, &EMPL_RCDN_FLAG)
&COUNT = 0; SQLExec("SELECT COUNT(*) FROM PS_PI_PRESELECT
WHERE EMPLID=:1 AND EMPL_RCD = :2 AND PI_SELECT_TYPE='C' AND
PI_RUN_NUM= 0", &EMPLID, &EMPL_RCD, &COUNT); If &COUNT > 0 Then
SQLExec("UPDATE PS_PI_PRESELECT SET DATETIME_STAMP=%CurrentDateTimeIn
WHERE EMPLID=:1 AND EMPL_RCD = :2 AND PI_SELECT_TYPE='C' AND
PI_RUN_NUM= 0", &EMPLID, &EMPL_RCD); Else SQLExec("INSERT INTO
PS_PI_PRESELECT (PI_SELECT_TYPE,EMPLID,EMPL_RCD,DATETIME_STAMP,
EMPL_RCDN_FLAG,PI_RUN_NUM) VALUES ('C',:1,:2,
%CurrentDateTimeIn,:3,0)", &EMPLID, &EMPL_RCD, &EMPL_RCDN_FLAG); End-If; End-Function;

Working with Transactions

This topic provides an overview of transactions and discusses how to:

- Set up a transaction.
- Set up a stop transaction.
- Verify a transaction.
- Verify a stop transaction.

Understanding Transactions

The LOG sample data that is delivered with Payroll Interface includes transactions and corresponding stop transactions for deductions, savings plans, and additional pay. This topic describes how to set up the transaction and the stop transaction for deductions using the LOGEXP export file.

When setting up transactions, the implementation details will vary depending on the type of transaction and the requirements of the third-party payroll system. The following procedures, however, show which Payroll Interface components need to be defined.

To set up a transaction:
1. Set up the PS Tables component—identify the tables and fields that are required for the transaction.
2. Set up the Field Definition Table component—define the fields that will be included in the export file.
3. (Optional) Set up the Instance Table component—create an instance ID if you want to restrict or modify the data that is sent to the third-party payroll system.
4. Set up the Definition Table component—define the transaction record and field sequences.

To set up a stop transaction:
1. Set up the Field Definition Table component—define the fields that will be included in the export file.
2. Review the Process Table component—identify the COBOL process that will perform the stop transaction.

3. Set up the Definition Table component—define the stop transaction record and field sequences.

**Setting Up a Transaction**

Follow these steps to set up a deduction transaction using the LOGEXP export file.

**Step 1: Set Up the PS Tables Component**

Identify the PeopleSoft tables and fields that store the data that is required for the transaction:

- **Table**: DED_CALC.
- **Fields**: DEDCD (deduction code), DED_CLASS (deduction class), and DED_CUR (deduction amount).

Use the PS Table (PI_PSREC_PNL) page to set up the PeopleSoft table and fields:

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > PS Tables > PS Table

**Image: PS Tables page for Step 1: Set Up the PS Tables Component**

This example illustrates the fields and controls on the PS Tables page for Step 1: Set Up the PS Tables Component.
**Step 2a: Set Up the Field Definition Table Component, Export File Fields**

Define the fields for the deduction transaction: DEDAMT (shown in the following example) and DEDCD (not shown).

The default value for DEDAMT is the calculated deduction amount. The default value for DEDCD is the deduction code.

---

**Note:** The DED_CLASS field, identified in the PS Tables component, is not included in the export file. However, an instance ID for this field is set up in step 3.

Use the Interface Field1 page to set up the field definition for the DEDAMT field.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition Table > Interface Field1

**Image: Interface Field1 page for Step 2a: Set Up the Field Definition Table Component, Export File Fields**

This example illustrates the fields and controls on the Interface Field1 page for Step 2a: Set Up the Field Definition Table Component, Export File Fields.

---

**Step 2b: Set Up the Field Definition Table Component, PeopleSoft Table and Fields**

Identify the corresponding PeopleSoft table and field for the DEDAMT field:

- Table: DED_CALC
- Field: DED_CUR

---

**Note:** You must set up the DED_CALC table and DED_CUR field in the PS Tables component before you can access them through the Field Definition component.

Use the Field Definition Table - Interface Field2 page to identify the PeopleSoft record (table) and fields:
Step 3: (Optional) Set Up the Instance Table Component

Instance IDs enable you to restrict or modify the data that is sent to the third-party payroll system.

Deduction class values are A (after tax), B (before tax), N (non-taxable or employer paid), and T (taxable or imputed income). The Calculate Deductions process calculates deductions for all classes (A, B, N, T). In this example, the third-party payroll system wants to receive deductions only for class values A and B. Therefore, set up an instance ID DEDCLS for the DED_CLASS field to export calculated deductions for class values A and B. (Alternatively, you can set up the instance ID to exclude class values N and T.)

Note: When setting up an instance ID, you can either include the values that you want to export or exclude values that you don't want to export. You may need to experiment to determine which set up works best. Alternatively, you can create a view to retrieve a restricted data set.

Use the Interface Instance Table page to set up instance IDs.

Navigation
Set Up HCM > Product Related > Payroll Interface > Interface Controls > Instance Table > Interface Instance Table
Image: Interface Instance Table page for Step 3: (Optional) Set Up the Instance Table Component

This example illustrates the fields and controls on the Interface Instance Table page for Step 3: (Optional) Set Up the Instance Table Component.

### Interface Instance Table

<table>
<thead>
<tr>
<th>System ID</th>
<th>LOO</th>
<th>Logical File Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instance ID</td>
<td>DEOCLS</td>
<td></td>
</tr>
</tbody>
</table>

**Definition**

- **Effective Date**: 01/01/1980
- **Description**: Include Deduction Types
- **Instance Indicator**: Value
- **PeopleSoft Record Name**: DEO_CALC
- **PeopleSoft Field Name**: DEO_CLASS
- **Include Excluded Indicator**: Yes

**Instance Information**

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Field Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
</tr>
<tr>
<td>3</td>
<td>T</td>
</tr>
</tbody>
</table>

---

**Step 4a: Set Up the Definition Table Component, File**

Define the file, record, and field sequences for the export file.

**Note**: If you change any of the records or fields for a transaction, be sure to make the same changes to the records or fields for the corresponding stop transaction.

Use the Interface Definition File page to access the LOGEXP export file.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition File

Image: Interface Definition File page for Step 4a: Set Up the Definition Table Component, File

This example illustrates the fields and controls on the Interface Definition File page for Step 4a: Set Up the Definition Table Component, File.
Step 4b: Set Up the Definition Table Component, Record

The LOGEXP export file includes nine record sequences. Record 40 is the deduction transaction. Record 50 is the deduction stop transactions.

<table>
<thead>
<tr>
<th>Record Sequence</th>
<th>Record ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>PERS</td>
<td>Personal Data</td>
</tr>
<tr>
<td>20</td>
<td>EMPL</td>
<td>Employment Data</td>
</tr>
<tr>
<td>30</td>
<td>JOB</td>
<td>Job Data</td>
</tr>
<tr>
<td>40</td>
<td>DED</td>
<td>Deductions</td>
</tr>
<tr>
<td>50</td>
<td>SDED</td>
<td>Stop Deductions</td>
</tr>
<tr>
<td>60</td>
<td>SAVE</td>
<td>Savings</td>
</tr>
<tr>
<td>70</td>
<td>SSAV</td>
<td>Stop Savings</td>
</tr>
<tr>
<td>80</td>
<td>APAY</td>
<td>Additional Pay</td>
</tr>
<tr>
<td>90</td>
<td>SPAY</td>
<td>Stop Additional Pay</td>
</tr>
</tbody>
</table>

Record 40, the deduction transaction (DED), includes:

- Record type: Data
- Instance ID: DEDCLS—the instance ID created in step 3.
- Process ID: 000001 ON1 Change—a process required for the deduction transaction.

Use the Interface Definition Record page to set up the record sequences for the export file.

Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition Record
Image: Interface Definition Record page for Step 4b: Set Up the Definition Table Component, Record

This example illustrates the fields and controls on the Interface Definition Record page for Step 4b: Set Up the Definition Table Component, Record.

<table>
<thead>
<tr>
<th>Interface Definition File</th>
<th>Interface Definition Record</th>
<th>Interface Definition Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>File ID LOGEXP</td>
<td>Find</td>
<td>View All</td>
</tr>
</tbody>
</table>

- **Effective Date**: 01/01/1980
- **Description**: Logical Export Sample
- **System ID**: LOG
- **Process Type**: Export
- **File Type**: Logical
- **PL Record Length**: 80
- **Data Definition**: Y
- **Status**: Active
- **Short Desc**: Logical
- **Convert Case**: Y
- **Include Header**: N
- **Max Fields Per Output Rec**: 5

**Step 4c: Set Up the Definition Table Component, Fields**

Record 40, the deduction transaction, includes five field sequences:

- **Field Seq#: 10–50.**
- **Field Seq 40 and 50 are a grouped field (Group ID 001).**
- **Field Seq 50 is DEDAMT, the actual deduction amount.**

**Note:** The field sequences (10–50) for transaction record 40 must be identical to the field sequences for stop transaction record 50. The *value* of field sequence 50 changes from DEDAMT to ZAMT.

Use the Interface Definition Fields page to set up the field sequences for the record:

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition Fields
Setting Up a Payroll Interface Definition (Part 2)  
Chapter 10

Image: Interface Definition Fields page for Step 4c: Set Up the Definition Table Component, Fields

This example illustrates the fields and controls on the Interface Definition Fields page for Step 4c: Set Up the Definition Table Component, Fields.

<table>
<thead>
<tr>
<th>File ID</th>
<th>Logical Export Sample</th>
<th>Effective Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOGEXP</td>
<td>01/01/1980</td>
<td></td>
</tr>
</tbody>
</table>

**Field Definition Table Component, Export File Fields**

PeopleSoft code moves the pay period end date (of the pay calendar entry being used with the run control) to the DATE_VAL field in the PI_PARTIC_EXTBL table when a stop process is identified. Along with the date, you'll see the corresponding field ID and CHAR_VAL (for example, for a deduction code).

See Export Processing.

Define the field for the deduction stop transaction: ZAMT. When the stop transaction is processed, the ZAMT default value, rather than the DEDAMT default value, is written to the export file.

The default value is determined by the requirements of the third-party payroll system (refer to the vendor documentation). For LOG systems, the default value may be 000.00 or zero. For CSV systems, the default value may be probably ~, the tilde character.

Use the Interface Field1 page to set up a field definition for the ZAMT field:

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition Table > Interface Field1

---

**Setting Up a Stop Transaction**

Follow these steps to set up a stop transaction for deductions using the LOGEXP export file.

**Step 1: Set Up the Field Definition Table Component, Export File Fields**

For Payroll Interface to recognize a stop transaction, the delivered record-level process IDs must be used. PeopleSoft code moves the pay period end date (of the pay calendar entry being used with the run control) to the DATE_VAL field in the PI_PARTIC_EXTBL table when a stop process is identified. Along with the date, you'll see the corresponding field ID and CHAR_VAL (for example, for a deduction code).

See Export Processing.

Define the field for the deduction stop transaction: ZAMT. When the stop transaction is processed, the ZAMT default value, rather than the DEDAMT default value, is written to the export file.

The default value is determined by the requirements of the third-party payroll system (refer to the vendor documentation). For LOG systems, the default value may be 000.00 or zero. For CSV systems, the default value may be probably ~, the tilde character.

Use the Interface Field1 page to set up a field definition for the ZAMT field:

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Field Definition Table > Interface Field1
Image: Interface Field1 page for Step 1: Set Up the Field Definition Table Component, Export File Fields

This example illustrates the fields and controls on the Interface Field1 page for Step 1: Set Up the Field Definition Table Component, Export File Fields.

Note: Because the ZAMT field does not correspond to a PeopleSoft table or field, the Interface Field2 page does not need to be set up.

Step 2: Review the Process Table

Identify the COBOL process that will perform the stop transaction. This can be one of the processes delivered with Payroll Interface or a user-defined process. In this example, use Payroll Interface Process ID 000026.

See Working with COBOL Processes.

After the process is attached to the stop transaction record (see step 3), it runs in the background during the Export process. If the process determines that a deduction code is missing, the ZAMT default value (rather than the DEDAMT default value) is written to the export file and a flag on the PI_PARTIC_EXPT table is set to P.

See Export Processing.

Use the Interface Process Table page to view the processes that are delivered with Payroll Interface.

Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Process Table > Interface Process Table
**Image: Interface Process Table page for Step 2: Review the Process Table**

This example illustrates the fields and controls on the Interface Process Table page for Step 2: Review the Process Table.

**Step 3a: Set Up the Definition Table Component, File**

Define the file, record, and field sequences for the export file.

Use the Interface Definition File page to access the LOGEXP export file.

**Navigation**

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition File

**Image: Interface Definition File page for Step 3a: Set Up the Definition Table Component, File**

This example illustrates the fields and controls on the Interface Definition File page for Step 3a: Set Up the Definition Table Component, File.
Step 3b: Set Up the Definition Table Component, Record

Record 50, the deduction stop transaction (SDED), includes:

- Record Type: Process
- Base Rec: 40—the corresponding record for the deduction transaction.
- Process ID: 000026—the process that stops the deduction.

Note: The Base Rec field joins the transaction to the stop transaction: record 40 is joined to record 50.

Use the Interface Definition Record page to set up the record sequences for the export file.

Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition Record

Image: Interface Definition Record page for Step 3b: Set Up the Definition Table Component, Record

This example illustrates the fields and controls on the Interface Definition Record page for Step 3b: Set Up the Definition Table Component, Record.

Step 3c: Set Up the Definition Table Component, Fields

Record 50, the deduction stop transaction, includes five field sequences:

- Field Seq#: 10–50.
- Field Seq 40 and 50 are a grouped field (Group ID 001).
- Field Seq 50 is now ZAMT, the zero amount that is sent when the deduction is stopped.

Note: The field sequences (10–50) for stop transaction record 50 must be identical to the field sequences for transaction record 40. The value of field sequence 50 changes from DEDAMT to ZAMT.

Use the Interface Definition Fields page to set up the field sequences for the record:
Navigation

Set Up HCM > Product Related > Payroll Interface > Interface Controls > Definition Table > Interface Definition Fields

**Image: Interface Definition Fields page for Step 3c: Set Up the Definition Table Component, Fields**

This example illustrates the fields and controls on the Interface Definition Fields page for Step 3c: Set Up the Definition Table Component, Fields.

---

Verifying a Transaction

To verify the transaction:

1. Run the Calculate Deductions and Confirmation processes.
2. Run the Export process.

**Step 1: Run the Calculate Deductions and Confirmation Processes**

Calculate and confirm the deductions for the employee.

Use the Calculate Deductions page to calculate the deductions:

Navigation

Payroll Interface > Pay Period Deductions > Calculate Deductions > Calculate Deductions
Image: Calculate Deductions page for Step 1: Run the Calculate Deductions and Confirmation Processes

This example illustrates the fields and controls on the Calculate Deductions page for Step 1: Run the Calculate Deductions and Confirmation Processes.

Review the results. The employee has medical and dental before-tax and nontaxable deductions. However, because the DEDCLS instance ID is set up, only the before-tax deductions will appear in the export file.

Use the Review Deductions page to review deductions.

Navigation

Payroll Interface > Pay Period Deductions > Review Deductions > Review Deductions

Image: Review Deductions page for Step 1: Run the Calculate Deductions and Confirmation Processes

This example illustrates the fields and controls on the Review Deductions page for Step 1: Run the Calculate Deductions and Confirmation Processes.
Step 2: Run the Export Process

Use the Import/Export Payroll Data page to run the Export process:

Navigation

Payroll Interface > Payroll Data Exchanges > Import/Export Payroll Data > Import/Export Payroll Data

Image: Import/Export Payroll Data page for Step 2: Run the Export Process

This example illustrates the fields and controls on the Import/Export Payroll Data page for Step 2: Run the Export Process.

Review the export file. Because the instance ID DEDCLS is set up, only the before-tax deductions appear in the export file. Notice, however, that the transaction has worked. The DEDAMT or 59.77 value appears in the export file for deduction code KUHMOK:
Image: Export file showing the transaction for deduction KUHMOK (amount 59.77)

This example illustrates the fields and controls on the Export file showing the transaction for deduction KUHMOK is the amount of 59.77.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>LAST</td>
<td>FRAAS</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>FIRST</td>
<td>WILLIAM</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>ADDRESS</td>
<td>310 DONTELL ST.</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>ADDRESS2</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>CITY</td>
<td>KERNVILLE</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>STATE</td>
<td>CA</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>ZIP</td>
<td>932238</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>PHONE</td>
<td>9256947911</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>SSNUM</td>
<td>550555001</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>HIREDATE</td>
<td>03/15/1990</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>RETIREDT</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>SERVDT</td>
<td>03/15/1990</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>BIRTHDATE</td>
<td>01/08/1951</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>LAST_DAY</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>ORIGHIRE</td>
<td>03/15/1990</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>SEX</td>
<td>M</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>TITLE</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>HDEPT</td>
<td>63000</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>JOBTITLE</td>
<td>820010</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>HC_CODE</td>
<td>820010</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>EMP_TYPE</td>
<td>S</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>STATUS</td>
<td>A</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>ST_CLASS</td>
<td>RFT</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>CYCLE</td>
<td>W</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>SAL_HR</td>
<td>S</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>STDHRS</td>
<td>000040.00</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>RATE1</td>
<td>000000080000.0000</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>LASTRAISE</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>SHIFT1</td>
<td>N</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>PAYBYEX</td>
<td>Y</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>OTEXEMPT</td>
<td>Y</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>FLSA</td>
<td>E</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>SUPERNAME</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>PAYGROUP</td>
<td>KUB</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>DEDUCTION</td>
<td>KUHMOK</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>AMOUNT</td>
<td>000059.77</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>DEDUCTION</td>
<td>KUDEN9</td>
</tr>
<tr>
<td>GBI</td>
<td></td>
</tr>
<tr>
<td>KUI011</td>
<td></td>
</tr>
<tr>
<td>AMOUNT</td>
<td>000007.79</td>
</tr>
</tbody>
</table>

Verifying a Stop Transaction

To verify the stop transaction:

1. Terminate one of the benefits for the employee.
2. Run the Calculate Deductions and Deduction Confirmation processes.
3. Run the Export process.

**Step 1: Terminate a Benefit**

Terminate the medical benefits for the employee, deduction code KUHMOK.

Use the Health Benefits page to terminate the medical benefits.
Navigation

Workforce Administration > Benefit Information NLD > Enroll in Benefits > Health Benefits > Health Benefits

Image: Health Benefits page for Step 1: Terminate a Benefit

This example illustrates the fields and controls on the Health Benefits page for Step 1: Terminate a Benefit.

Step 2: Run the Calculate Deductions and Confirmation Processes

Calculate and confirm the deductions for the employee. The terminated medical benefits no longer appear.

Use the Review Deductions page to review the deductions.

Navigation

Payroll Interface > Pay Period Deductions > Review Deductions > Review Deductions
Image: Review Deductions page for Step 2: Run the Calculate Deductions and Confirmation Processes

This example illustrates the fields and controls on the Review Deductions page for Step 2: Run the Calculate Deductions and Confirmation Processes.

<table>
<thead>
<tr>
<th>Deductions</th>
<th>Plan Type</th>
<th>Benefit Plan</th>
<th>Deduction Class</th>
<th>Deduction Code</th>
<th>Description</th>
<th>Current Deduction</th>
<th>Coverage Base</th>
<th>Current Deduction Payback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical</td>
<td>KUHM01</td>
<td>Before-Tax</td>
<td>KUHMOK</td>
<td>Kaiser HMO</td>
<td>59.77</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Medical</td>
<td>KUHM01</td>
<td>Nontaxable</td>
<td>KUHMOK</td>
<td>Kaiser HMO</td>
<td>60.00</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dental</td>
<td>KUDEN2</td>
<td>Before-Tax</td>
<td>KUDEN9</td>
<td>Dental Plan</td>
<td>7.79</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dental</td>
<td>KUDEN2</td>
<td>Nontaxable</td>
<td>KUDEN9</td>
<td>Dental Plan</td>
<td>1.95</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 3: Run the Export Process

Run the Export process and review the export file. Notice that the stop transaction succeeded. The ZAMT or 000.00 value appears in the export file for deduction code KUHMOK, the terminated medical benefit.
Image: Export file showing the stop transaction for deduction KUHMOK (amount 00.00)

This example illustrates the export file showing the stop transaction for deduction KUHMOK is the amount of 00.00.

<table>
<thead>
<tr>
<th>GBI</th>
<th>KUI011</th>
<th>ID</th>
<th>KUI011</th>
</tr>
</thead>
<tbody>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>LAST</td>
<td>PRUE</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>FIRST</td>
<td>WILLIAM</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>ADDRESS</td>
<td>310 DONTELL ST.</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>ADDRESS2</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>CITY</td>
<td>KERNVILLE</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>STATE</td>
<td>CA</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>ZIP</td>
<td>932238</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>PHONE</td>
<td>9256947911</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>SSNUM</td>
<td>5505555001</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>HIREDATE</td>
<td>03/15/1990</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>REHIREDT</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>SERVDT</td>
<td>03/15/1990</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>BIRTHDATE</td>
<td>01/08/1951</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>LAST_DAY</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>TERMDATE</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>ORIGHIRE</td>
<td>03/15/1990</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>SEX</td>
<td>M</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>TITLE</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>DEPT</td>
<td>63000</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>JOBTITLE</td>
<td>820050</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>HCCODE</td>
<td>820050</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>EMTYPE</td>
<td>S</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>STATUS</td>
<td>A</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>ST_CLASS</td>
<td>RFT</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>CYCLE</td>
<td>W</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>SAL_HR</td>
<td>S</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>STDHRS</td>
<td>000040.00</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>RATE1</td>
<td>000000080000.0000</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>LASTRAISE</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>SHIFT1</td>
<td>N</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>PAYBYEX</td>
<td>Y</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>CTXEXMT</td>
<td>Y</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>FLSE</td>
<td>E</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>SUPERNAME</td>
<td></td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>PAYGROUP</td>
<td>KU8</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>DEDUCTION KUDENG</td>
<td>AMOUNT</td>
</tr>
<tr>
<td>GBI</td>
<td>KUI011</td>
<td>DEDUCTION KUHMOK</td>
<td>AMOUNT</td>
</tr>
</tbody>
</table>
Chapter 11
Maintaining Payroll Data

Understanding Payroll Data

After the interface definitions are set up and payroll processing has commenced, Payroll Interface enables you to maintain certain payroll data, including additional pay, general deductions, employee tax withholding information, direct deposits, and information for employees with multiple jobs.

Maintenance tasks include the initial setup of the component pages followed by the additions, changes, or deletions that normally occur to payroll-related data over time. Because most of the payroll data works in conjunction with other information that you are required to set up for Payroll Interface, the maintenance tasks are discussed in this topic as well as other related setup topics in this product documentation.

Note: Depending on the requirements of the third-party payroll system, you may not need to maintain all of the data that is discussed in this topic. Or if the data is required, to simplify data entry, conversion, and maintenance issues, it may be easier to have the third-party payroll system manage the data.

This diagram illustrates the types of payroll data that you may need to maintain:

Image: Maintaining payroll data

This diagram illustrates the types of payroll data that you may need to maintain.
Maintaining Additional Pay

To maintain additional pay, use the Additional Pay (ADDITIONAL_PAY) component.

Related Links
Setting Up and Maintaining Additional Pay

Maintaining General Deductions

To maintain general deductions, use the General Deduction (GENL_DED_DATA) and Override General Deductions (GENL_DED_OVERRIDE) components.

Related Links
Setting Up and Maintaining General Deductions

Maintaining Tax Distribution Data

To maintain tax distribution data, use the Tax Distribution Data USA (TAX_DISTRIBUTION) and Tax Distribution Data CAN (TAX_DISTRIBUTION) components.

Related Links
(CAN) (USA) Setting Up and Maintaining Tax Distribution Data

Maintaining Employee Tax Data

To maintain employee tax data, use the Employee Tax Data USA (TAX_DATA) and Employee Tax Data CAN (TAX_DATA_CAN) components.

Related Links
(USA) Setting Up and Maintaining U.S. Employee Tax Data
(CAN) Setting Up and Maintaining Canadian Employee Tax Data

(CAN) (USA) Setting Up and Maintaining Direct Deposit

For information on setting up direct deposits of employee pay, see:

- Payroll for North America, "Setting Up Banks and Direct Deposit" (PeopleSoft HCM 9.2: Payroll for North America)
Setting Up and Maintaining Optional Payroll Data

To set up and maintain optional payroll data, use the Payroll Options (PAYROLL_DATA) component.

Pages Used to Set Up and Maintain Optional Payroll Data

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll Options 1 Page</td>
<td>PAYROLL_DATA1</td>
<td>Set up paycheck delivery and distribution options.</td>
</tr>
<tr>
<td>Payroll Options 2 Page</td>
<td>PAYROLL_DATA2</td>
<td>Set up paycheck location and payroll deduction subset options.</td>
</tr>
</tbody>
</table>

Understanding Optional Payroll Data

Optional payroll processing information, such as check distribution and deduction subset options, is often necessary when employees have multiple jobs or have multiple jobs and need to be paid through more than one payroll system.

If you are setting up multiple jobs:

- Calculate Deductions — Follow guidelines in your PeopleSoft Benefits Administration product documentation.
- Benefit Deductions — Follow guidelines in your PeopleSoft Benefits Administration product documentation.
- General Deductions — Set up and maintain the Payroll Options component, Payroll Options 2 page.

See Payroll Options 2 Page.
Payroll Options 1 Page

This example illustrates the fields and controls on the Payroll Options 1 page.

Paycheck Delivery Option

Company Distribution
Select to indicate that the check should be handed out as part of a regular company distribution.

Postal Service
Select to indicate that the check should be mailed using the Postal Service.

Distribution Mail Option

Use the options in the Distribution Mail Option group box to indicate how an employee's check should be distributed.

Home Address
Select to send checks to the employee's home address. The system automatically displays the home address from the employee's personal data in PeopleSoft HCM.

Mailing Address
Select to send checks to the employee's mailing address. The system automatically displays the mailing address from the employee's personal data in PeopleSoft HCM.

Check Address
Select to send checks to the employee's check address. The system automatically displays the check address from the employee's personal data in PeopleSoft HCM.

Update Check Address
Select to update the employee's check address here, rather than on the Personal Data component.
Payroll Options 2 Page

Use the Payroll Options 2 page (PAYROLL_DATA2) to set up paycheck location and payroll deduction subset options.

Navigation

Payroll Interface > Update Payroll Information > Payroll Options > Payroll Options 2

Image: Payroll Options 2 page

This example illustrates the fields and controls on the Payroll Options 2 page.

Primary PayGroup

Select to identify the pay group for which a consolidated paysheet will be created when an employee is being paid in different pay groups during the same pay run. The primary pay group also controls whether deductions or additional pay should be taken for the pay period.

For employees with multiple jobs, PeopleSoft recommends that you select, as the primary pay group, the one in which the employee is paid most often. If you leave this field blank, the system uses the default pay group that is associated with the first job into which the employee was hired.

Note: You are responsible for verifying that this value is correct for each employee.

Paycheck Location Option

Use the options in the Paycheck Location Option group box to specify which location code to use as a sort option for printing paychecks for this pay group. These options are used only if:

- The Company Distribution Order option is selected as the paycheck sequence option on the Pay Group Table - Check Distribution page.
• The Select on Payroll Data Panel option is selected as the paycheck location option on the Pay Group Table - Check Distribution page.

• The location is entered as a check print sequence on the Pay Group Table - Check Sequencing page.

See Understanding Payroll Schedules.

**Note:** You must create location codes in the Location table before you can use them here or elsewhere in the system.

<table>
<thead>
<tr>
<th>Home Department Location</th>
<th>Select the location code (in the Department table) that is associated with the department ID on the employee's Job record that is used as a sort option for printing checks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Location</td>
<td>Select the location on the employee's Job record that is used as a sort option for printing checks.</td>
</tr>
<tr>
<td>Other Location</td>
<td>Select to enter a different location code to use as a sort option for printing checks. In this case, the system uses the designated agent address and transmits the check for office delivery. If you select the Other Location option, you also must select a setID and a location code.</td>
</tr>
<tr>
<td>SetID</td>
<td>Select the setID for the location code.</td>
</tr>
<tr>
<td>Location CD (location code)</td>
<td>Select a location code to indicate this location as a sort option for printing checks. Use this option only if the Select on Payroll Data Panel option is selected as the paycheck location option on the Pay Group Table - Check Distribution page.</td>
</tr>
<tr>
<td>Mail Drop ID</td>
<td>Select to enter the employee's mail drop ID.</td>
</tr>
<tr>
<td>Paycheck Name</td>
<td>Select to enter a name, other than the employee name that is entered on the Personal Data record, to whom the paycheck should be made out. This field is not formatted, so enter the name exactly as you want it to appear on the paycheck.</td>
</tr>
</tbody>
</table>

**Deductions Taken**

Use the options in the Deductions Taken group box to indicate how to take deductions for an employee. Selections made on this page override the values that are entered for the pay run in the General Deductions Taken field on the Pay Calendar table. Values include:

| Deductions Taken | • *NoOverride:* This is the default value. If this is unchanged, the deductions that are specified on the Pay Calendar table are not overridden on the paysheet at this stage in deduction override evaluation processing. |
|------------------|• *Deduction:* Select this value to process the standard general deductions for this employee as set up on the Deduction table. |
• *None:* Select this value if no general deductions should be taken out of the paycheck.

• *Subset:* Select this value to take only those general deductions that are included in the deduction subset that you specify in the Deduction Subset ID field.

**Deduction Subset ID**

You must specify the subset ID if you select *Subset* in the Deductions Taken field.

---

(CAN) Setting Up and Maintaining Source Deductions

To set up and maintain source deductions, use the Update Source Deductions CAN (RUN_TAX103CN) component.

**Page Used to Set Up and Maintain Source Deductions**

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update Source Deductions Page</td>
<td>RUN_TAX103CN</td>
<td>Run the Update Source Deductions SQR Report process (TAX103CN).</td>
</tr>
</tbody>
</table>

**Understanding Source Deduction Processing**

Use the Update Source Deductions SQR Report process (TAX103CN) to calculate and update federal, Quebec, and provincial basic source deductions for employees by generating a new Canadian Income Tax Data record for each employee who is active as of the effective date specified.

Set up and run this process at predefined intervals in preparation for the new year's payroll processing. The corresponding report (TAX103CN) provides a list of all records created.

**Update Source Deductions Page**

Use the Update Source Deductions page (RUN_TAX103CN) to run the Update Source Deductions SQR Report process (TAX103CN).

**Navigation**

Payroll Interface > Update Payroll Information > Update Source Deductions CAN > Update Source Deductions
Image: Update Source Deductions page

This example illustrates the fields and controls on the Update Source Deductions page.

**Federal Increase By**
Use this group box to perform updates to employees' federal basic claim amounts. Use percent or amount only; specifying the value of the increase.

**Quebec Increase By**
Use this group box to perform updates to employees' Quebec basic claim amounts. Use percent or amount only; specifying the value of the increase.

**Provincial Increase By**
Use this group box to perform updates to employees' provincial basic personal amounts. Add rows to enter multiple provinces. Use percent or amount only; specifying the value of the increase.

**Reset Special Letters**
Enter Y (yes) to reset the special letters amount to zero.

**Reset Special Letters (Quebec)**
Enter Y to reset the Quebec special letters amount to zero.

**Reset CPP Subject Months** (reset Canada Pension Plan subject months)
- **Y**: Reset the employee's CPP subject months to 12.
- **N** (no): Reset the employee's CPP subject months to zero when the employee's original CPP subject months are fewer than 12 (for example, to reset CPP subject months to zero for employees who no longer contribute to CPP). If the employee's original CPP subject months are 12, they remain 12.

**Reset Federal Commission**
Enter Y to reset the federal commission amounts to zero.

**Reset Quebec Commission**
Enter Y to reset the Quebec commission amounts to zero.

**Reset Cross Province**
- **Y**: The Cross Province check box on the Canadian Income Tax Data 2 page is deselected when the new record is created.
- **N**: The Reset Cross Province check box and associated field values are copied to the newly created record.
Chapter 12

Running Deductions

Understanding Deduction Processing

If you maintain deduction information using Payroll Interface and the Manage Base Benefits business process in PeopleSoft HR, then you must run the Calculate Deductions and Confirm Deductions processes before running the Export process.

The deduction processes use the information that you set up through the Manage Base Benefit business process to calculate and confirm per pay period deduction amounts. When the Export process is run, these amounts are exported, along with the other payroll data, to the third-party payroll system. The third-party payroll system performs the gross to net calculations.

Note: If you do not maintain deductions (that is, if the third-party payroll system manages all deduction information), then you do not need to run the Calculate Deductions or Confirm Deductions processes.

See Understanding Data Exchanges.

See PeopleTools: Process Scheduler

Calculating Deductions

Use the Calculate Deductions COBOL SQL process (PSPDCRUN ) to calculate pay period deduction amounts. If an error occurs, correct the problem and then run the process again. You can run the Calculate Deductions process as many times as necessary to correct errors. After you have resolved all of the errors, you can run the Confirm Deductions process.

Note: To determine whether errors occurred during the Calculate Deductions process, examine both the deduction run (Review Deductions component) and the deduction messages (Review Error Messages component). You cannot run the Confirm Deductions process until all deduction calculation errors have been resolved.

To calculate deductions:

1. Run the Calculate Deductions process to calculate deductions.
   
   See Calculating Deductions.

2. Review the results of the deduction calculation run.

   See Reviewing Deductions.

Confirming Deductions

Use the Confirm Deductions COBOL SQL process (PSPDCCNF) to signify that the pay period deduction amounts have been calculated and are error free; that is, you have run the Calculate Deductions process, checked the results, rerun the process if necessary, and verified that the results are accurate. When you run
the Confirm Deductions process, the system stores the results in the DED_CALC and DED_MESSAGE tables, and flags the pay calendar as confirmed (F flag). The deductions are now ready for the Export process.

**Note:** Again, to determine whether errors occurred during the Confirm Deductions process, examine *both* the deduction run (Review Deductions component) and the deduction messages (Review Error Messages component).

To confirm deductions:

1. Run the Confirm Deductions process to confirm the calculated deductions.
   
   See Confirming or Unconfirming Deductions.

2. Review the results of the deductions confirmation run.
   
   See Reviewing Deductions.

### Reprocessing Deductions

Use the Deductions Unconfirm COBOL SQL process (PSPDCUNC) to unconfirm and reprocess deductions that have already been calculated and confirmed.

To process deductions, you run (and review) the Calculate Deductions and Confirm Deductions processes. After the Confirm Deductions process is run, no further changes can be made to deduction data for the pay period unless you reprocess the deductions.

To reprocess deductions:

1. Update or make the necessary changes to the deduction data.

2. Run the Deductions Unconfirm process to unconfirm the calculated deductions.
   
   See Confirming or Unconfirming Deductions.

3. Run the Calculate Deductions process to recalculate deductions.

4. Run the Confirm Deductions process to reconfirm the calculated deductions.

### Calculating Deductions

To calculate deductions, use the Calculate Deductions (RUNCTL_DED_CALC) component.

### Pages Used to Calculate Deductions

<table>
<thead>
<tr>
<th><strong>Page Name</strong></th>
<th><strong>Definition Name</strong></th>
<th><strong>Usage</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculate Deductions Page</td>
<td>RUNCTL_DED_CALC</td>
<td>Select the deduction calculation options and run the Calculate Deductions COBOL SQL process (PSPDCRUN) to calculate deductions.</td>
</tr>
</tbody>
</table>
Chapter 12  Running Deductions

Calculate Deductions Page

Use the Calculate Deductions page (RUNCTL_DED_CALC) to select the deduction calculation options and run the Calculate Deductions COBOL SQL process (PSPDCRUN) to calculate deductions.

Navigation

Payroll Interface  > Pay Period Deductions  > Calculate Deductions  > Calculate Deductions

Image: Calculate Deductions page

This example illustrates the fields and controls on the Calculate Deductions page.

<table>
<thead>
<tr>
<th>Run ControlID</th>
<th>P#</th>
<th>Report Manager</th>
<th>Process Monitor</th>
<th>Run</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Pay Run ID</th>
<th>Pay Run ID</th>
<th>Pay Run ID</th>
<th>Pay Run ID</th>
<th>Pay Run ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Run ID</td>
<td>Pay Run ID</td>
<td>Pay Run ID</td>
<td>Pay Run ID</td>
<td>Pay Run ID</td>
</tr>
</tbody>
</table>

Select Deductions to Calculate

Select:

- Only Calculate Where Needed when employee-level changes occur. The system calculates deductions for employees who:
  - Were not yet calculated this pay period.
  - Were calculated, but errors occurred during the calculation process.
  - Had benefit or job changes since the last deduction calculation for the pay period.

- (Re)Calculate All Checks when benefit-table-level changes occur that will affect deduction calculation, such as benefit premium adjustments.

**Note:** This option processes both benefit-table-level changes and employee-level changes.

Copyright © 1988, 2021, Oracle and/or its affiliates.
Confirming or Unconfirming Deductions

To confirm or unconfirm deductions, use the Confirm Deductions (RUNCTL_DED_CONF) component.

Pages Used to Confirm or Unconfirm Deductions

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm Deductions Page</td>
<td>RUNCTL_DED_CONF</td>
<td>Enter parameters to run the Confirm Deductions COBOL SQL process (PSPDCCNF) to confirm the calculated deductions. Enter parameters to run the Deductions Unconfirm COBOL SQL process (PSPDCUNC) to unconfirm the calculated deductions.</td>
</tr>
</tbody>
</table>

Confirm Deductions Page

Use the Confirm Deductions page (RUNCTL_DED_CONF) to enter parameters to run Confirm Deductions COBOL SQL process (PSPDCCNF) to confirm the calculated deductions.

Also use the page to enter parameters to run the Deductions Unconfirm COBOL SQL process (PSPDCUNC) to unconfirm the calculated deductions.

Navigation

Payroll Interface > Pay Period Deductions > Confirm Deductions > Confirm Deductions

Image: Confirm Deductions page

This example illustrates the fields and controls on the Confirm Deductions page.

**Confirm Deductions**

Run Control ID  
Report Manager  
Process Monitor

Run Parameters

Pay Run ID KJU-01-04  
US KJU Weekly Pay 01, Jan 04

Pay Run ID  
Select the pay run ID of the deduction calculation run that you want to confirm or unconfirm.

See Calculate Deductions Page.
Reviewing Deductions

To review deductions, use the Review Error Messages (DED_MESSAGE) and Review Deductions (DED_CALCULATIONS) components.

Pages Used to Review Deductions

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Messages Page</td>
<td>DED_MESSAGE</td>
<td>Review error messages after running a deduction process.</td>
</tr>
<tr>
<td>Review Deductions Page</td>
<td>DED_CALCULATIONS</td>
<td>Review deduction amounts after running a deduction process.</td>
</tr>
</tbody>
</table>

Review Deductions Page

Use the Review Deductions page (DED_CALCULATIONS) to review deduction amounts after running a deduction process.

Navigation

Payroll Interface > Pay Period Deductions > Review Deductions > Review Deductions

Image: Review Deductions page

This example illustrates the fields and controls on the Review Deductions page.

Review Deductions

To access the Review Deductions page, you must first make selections on the Review Deductions search page. The Payline Calculation Status field has several options.

Payline Calculation Status

Always select and review the information for the Calculation Error, Pay in Progress, and Updated by User options.
**Note:** Calculation errors (E) are automatically displayed, but the pay in progress (P) and updated by user (U) errors are not. If pay in progress or updated by user errors exist and are not corrected during the Calculate Deductions process, the Confirm Deductions process will fail.

The Payline Calculation Status option is:

- Set to *Calculated* if no errors occur during the Calculate Deductions run.
- Set to *Confirmed* if no errors occur during the Confirm Deductions run.
- Reset to *Calculated* after the Deduction Unconfirm process is run.
Chapter 13

Running Exports and Imports

Understanding Data Exchanges

Payroll Interface enables you to exchange data between PeopleSoft HCM and a third-party payroll system. Data is exported from PeopleSoft HCM to the third-party payroll system using either a file or table. Data is imported from the third-party payroll system back into PeopleSoft HCM using only an ASCII formatted file. You use the same run-control process to export or import data.

*Note:* If you maintain deduction information, you must run the Calculate Deductions and Confirm Deductions processes before running the Export process.

See [Understanding Deduction Processing](#).

See [PeopleTools: Process Scheduler](#).

Exporting Data

Use the Export Application Engine process (PI_INRUN) to export data. The Export process retrieves, maps, and exports data using the definitions and processing routines that are set up through the export interface. When the Export process is complete (the export file or the export table is created), the third-party payroll vendor uses the appropriate software to load the data and process the payroll.

The export process includes three phases: select, compare, and export.

- During the select phase, employee payroll data is retrieved from the PeopleSoft HCM tables.
- During the compare phase, the selected data is compared against the data from the previous export run. The comparison phase identifies any data changes that have occurred since the last export.
- During the export phase, the data is exported to either a flat file or a table.

A full-records export performs the select and export phases; all employee data is exported. A changes-only export performs the select, compare, and export phases; only employee data that has changed is exported.

To export data:

1. Set up and run the Export process.
   - See [Exporting or Importing Data](#).
2. Review the results of the Export process run.
   - See [Reviewing Exports or Imports](#).
Importing Data

Use the Import Application Engine process (PI_INRUN) to import data. The Import process loads the processed payroll information (check detail and balance data) generated by the third-party payroll system into seven Payroll Interface import tables for online viewing and reporting. Further processing or technical configuration may be required to check the validity of the data or to ensure that employee-level data can be accessed in a secure manner.

To import data:

1. Obtain a copy of the ASCII import file from the third-party payroll vendor.
2. (Optional) If the file is tab-delimited, convert it to comma-delimited.
   See Converting Tab-Delimited Import Files.
3. Store the import file in the location that is defined in the File Handle Table component.
4. Set up and run the Import process.
   See Exporting or Importing Data.
5. Review the results of the Import process run.
   See Exporting or Importing Data.

Exporting or Importing Data

To export or import data, use the Import/Export Payroll Data (PI_RUNCTL_PNL) component.

Pages Used to Export and Import Data

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import/Export Payroll Data Page</td>
<td>PI_RUNCTL_PNL</td>
<td>Select the export or import process options and run the P.I. Export/Import Driver Application Engine process (PI_INRUN) to export or import data.</td>
</tr>
</tbody>
</table>

Import/Export Payroll Data Page

Use the Import/Export Payroll Data page (PI_RUNCTL_PNL) to select the export or import process options and run the P.I. Export/Import Driver Application Engine process (PI_INRUN) to export or import data.

Navigation

Payroll Interface > Payroll Data Exchanges > Import/Export Payroll Data > Import/Export Payroll Data
This example illustrates the fields and controls on the Import/Export Payroll Data page.

### Run Parameters

**Run Type**
Select which process to run, either *Export* or *Import*.

**PI Run Option** (Payroll Interface run option)
Select a run option:

- **New**: Increments the payroll interface run number and runs a new Export process.
- **Reprocess**: Reruns an existing Export process. You must select the payroll interface run number of the process that you want to reprocess.
- **Restart**: Restarts the most recent Export process (the most recently selected payroll interface run number).

**PI Run Number**
Each time that you run a new Export process, the system increments the run number. During the compare phase, the Export process uses the run numbers to compare the results of the current export with the results of the previous export.

**Check Point Interval** (check point interval in minutes)
Select to specify how often, in minutes, the system should commit during a process run.

---

**Note**: To determine the interval using number of employees rather than number of minutes — that is, to use the Installation Table - Third Party/System page, Commit After Empl Processed (commit after employee processed) field value — leave the Check Point Interval field blank or enter 0.
Export Options

Use this group box to select options for the Export process. (These options do not apply to the Import process).

Select Type

Select which employees to process:

- **All Employees in Group**: Process all employees in the pay group.
- **Manually Select**: Process those employees that are specified in the Selected Employees group box.
- **SmartSelect**: Process those employees that are in the pay group for whom online changes have been made since the last export run. If the selection process finds that all employees in the group have not yet been run for this company and pay group combination, SmartSelect is overridden at the pay group level and changed to *All Employees in Group*.

**Note:** Before selecting this option, you *must* activate SmartSelect by attaching a PeopleCode function to all EMPLID-keyed tables that are defined in the PS Tables component.

See Working with Smart Select.

**Note:** *(USF)* For National Finance Center (NFC) interface definitions, the Select Type field does not appear. The Output Files (s) field appears instead. You can output all files or just the EPIC file or PMSO file.

See Working with Smart Select.

Export Change or Full

Select to identify which employee records to process:

- **Chgs Only** *(changes only)*: Process only employee records with changed data.
- **Full Recs** *(full records)*: Process all employee records.

**Note:** If you attempt to run a changes-only export (select, compare, export) before running a full-records export (select, export), processing becomes Full Recs by default. To perform a changes-only export, data from a previous run must be in place.

Run Select and Compare Only

Select this option to run the Export process but not create the export file.

This option enables you to review the export data before creating the export file. It also enables you to run the Export process at one location and create the export file at another location.
Chapter 13 Running Exports and Imports

Note: If you select this option, use the Complete Export to File (complete export to external file) component to create the export file.

Exclude Calculated Deductions
Select if you do not want to process deductions.

Note: Always select this option if you do not maintain deductions (if you never run the Calculate Deductions and Confirm Deductions processes).

See Understanding Deduction Processing.

Active Employees
Select to process only employees whose employee status is defined as active (on the System Table - Interface System Table 2 page, Employee Status field).

Note: Do not select this option if you want to process all employees, regardless of their status (for example, for year-end processing).

Reprocess

Reprocess
Select to rerun a previously completed Export process.

• Compare: Rerun the Export process compare and export phases.

This option deletes the data from the PS_PI_PARTIC, PS_PI_PARTIC_EXPT, and PS_PI_MESSAGE tables where the PI_RUN_NUMBER matches the reprocess PI_RUN_NUMBER. The Export process performs the select, compare, and export phases.

• Export: Rerun the Export process export phase.

This option uses the data that is currently stored in the PS_PI_PARTIC, PS_PI_PARTIC_EXPT, and PS_PI_MESSAGE tables where the PI_RUN_NUMBER matches the reprocess PI_RUN_NUMBER. The Export process performs the export phase only.

Note: To reprocess an Export run, you usually select the Compare option.

Selected Employees
This group box appears only when you select Select Type, Manually Select. Manually enter each employee that you want to include in the Export process.
Employee ID and Empl Record (employee record)

Enter the employee identifiers as defined on the Employee Table - Interface Employee Table page.

Creating the Export File Separately

To create the export file separately, use the Complete Export to File (PI_RUNCTL_AE) component.

Pages Used to Create the Export File Separately

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complete Export to File Page</td>
<td>PI_RUNCTL_AE_PNL</td>
<td>Select the export file run options and run the P.I. External File I/O Application Engine process (PI_EXTFL) to create the export file separately. Use this page only if you have already run the Export process using the Import/Export Payroll Data page with the Run Select and Compare Only option selected.</td>
</tr>
</tbody>
</table>

Complete Export to File Page

Use the Complete Export to File page (PI_RUNCTL_AE_PNL) to select the export file run options and run the P.I. External File I/O Application Engine process (PI_EXTFL) to create the export file separately.

Navigation

Payroll Interface > Payroll Data Exchanges > Complete Export to File > Complete Export to File

Image: Complete Export to File page

This example illustrates the fields and controls on the Complete Export to File page.
Chapter 13 Running Exports and Imports

Note: Use this page only if you have already run the Export process using the Import/Export Payroll Data page with the Run Select and Compare Only option selected.

<table>
<thead>
<tr>
<th>Pay Run ID</th>
<th>Select the pay run ID of the export run that you want to complete.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Type</td>
<td>Select and enter Export.</td>
</tr>
<tr>
<td>PI Run Option</td>
<td>Select to enter a run option.</td>
</tr>
<tr>
<td>Payroll Interface Run Number</td>
<td>Select to enter the run number that corresponds to the pay run ID.</td>
</tr>
</tbody>
</table>

Converting Tab-Delimited Import Files

To convert tab-delimited import files, use the Convert Tab Delimiter (RUNCTL_PICNVT_TAB) component.

Pages Used to Convert Tab-Delimited Import Files

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Convert Tab Delimiter Page</td>
<td>RUNCTL_PICNVT_TAB</td>
<td>Select the tab-delimited import file options to run the Convert Tab Delimited Files SQR Report process (PI002) to convert a tab-delimited import file.</td>
</tr>
</tbody>
</table>

Convert Tab Delimiter Page

Use the Convert Tab Delimiter page (RUNCTL_PICNVT_TAB) to select the tab-delimited import file options to run the Convert Tab Delimited Files SQR Report process (PI002) to convert a tab-delimited import file.

Navigation

Payroll Interface > Payroll Data Exchanges > Convert Tab Delimiter > Convert Tab Delimiter

Copyright © 1988, 2021, Oracle and/or its affiliates.
Convert Tab Delimiter

Run Control ID  P3  Report Manager  Process Monitor

**Run Parameters**

- **System ID**
  - CSV
- **Configuration ID**
  - CSV

**Note:** Use this page to convert tab-delimited import files. Because COBOL automatically changes a tab to a space when reading a file, you must convert tab-delimited files into comma-delimited files before importing them.

**System ID**
Select the system ID that identifies the third-party payroll system.

**Configuration ID**
Select the configuration ID that identifies the import files to be converted.

### Reviewing Exports or Imports

To review exports and imports, use the Error Messages (PI_MESSAGES), Run Table (INTERFACE_RUN_TBL), Export Details (INTERFACE_PARTIC), Table Export (PI_PARTIC_EXTBL), Check Summary (PI_CHECK_SUMM), Earnings Balances (INTERFACE_EARN_BAL), Deduction Balances (INTERFACE_DED_BAL), and Tax Balances (INTERFACE_TAX_BAL) components.

### Pages Used to Review Exports or Imports

<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
</table>
| Interface Messages Page | PI_MESSAGES     | Export/Import Process
Review error messages generated by Payroll Interface.
The Error Key field indicates the Payroll Interface field that has the problem. Refer to PSCPYMSG.CBL (COBOL) for technical troubleshooting. |
| Run Table Page         | PI_RUNTBL_PNL   | Export/Import Process
Review information about import and export runs. |
<table>
<thead>
<tr>
<th>Page Name</th>
<th>Definition Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Details Page</td>
<td>PI_PARTIC_PNL</td>
<td>Export Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Review the results of the Export process.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The data shown here represents the contents of the PI_PARTIC_EXPT table.</td>
</tr>
<tr>
<td>Table Export Page</td>
<td>PI_PARTIC_EXTBL</td>
<td>Export Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Review the results of the Export process when writing data to a table.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The data shown here represents the contents of the PI_PARTIC_EXTBL table (the export table).</td>
</tr>
<tr>
<td>Check Summary Page</td>
<td>PI_CHECK_SUMM</td>
<td>Import Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Review check data that is imported from your third-party payroll system.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Select the Tax Detail link to view a page with tax details for the check summary that you're reviewing.</td>
</tr>
<tr>
<td>Check Tax Detail Page</td>
<td>PI_CHECK_SUMM_S1</td>
<td>Import Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Review tax details for a check summary.</td>
</tr>
<tr>
<td>Earnings Balances Page</td>
<td>PI_ERNBAL_PNL</td>
<td>Import Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Review earnings balances that are imported from your payroll system.</td>
</tr>
<tr>
<td>Deduction Balances Page</td>
<td>PI_DEDBAL_PNL</td>
<td>Import Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Review deduction balances that are imported from your payroll system.</td>
</tr>
<tr>
<td>Tax Balances Page</td>
<td>PI_TAXBAL_PNL</td>
<td>Import Process</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Review tax balances that are imported from your payroll system.</td>
</tr>
</tbody>
</table>
Appendix A

PeopleSoft Payroll Interface Reports

PeopleSoft Payroll Interface Reports: A to Z

Tables in this topic list PeopleSoft Payroll Interface reports, sorted by report ID.

For more information about running the reports, refer to:

- The corresponding topic in this product documentation.
- PeopleTools: Process Scheduler
- PeopleTools: BI Publisher for PeopleSoft
- PeopleTools: SQR Language Reference for PeopleSoft

For samples of the reports, see the Report Samples that are published with this online documentation.

Data Reports

This table lists and describes the data reports that are included in PeopleSoft Payroll Interface, listed alphanumerically.

<table>
<thead>
<tr>
<th>Report ID and Report Name</th>
<th>Description</th>
<th>Navigation</th>
<th>Run Control Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay031 Benefit Deductions Register</td>
<td>For each company/pay group, lists the deduction type and calculated deduction amount for each employee. This report can be run only after the Calculate Deductions process is run.</td>
<td>Payroll Interface &gt; Reports &gt; Benefit Deductions Register &gt; Benefit Deductions Register</td>
<td>RUNCTL_PAYINIT2</td>
</tr>
<tr>
<td>PI001 Export Changes Report</td>
<td>Lists detailed information for employees who will be included in the export file, including both old and new values for fields that changed since the last export file was created.</td>
<td>Payroll Interface &gt; Reports &gt; Export Changes &gt; Export Changes Report</td>
<td>RUNCTL_PIEXPT</td>
</tr>
<tr>
<td>TAX016 Default Tax Data Report (USA)</td>
<td>Lists employees with default data in their Tax records.</td>
<td>Payroll Interface &gt; Reports &gt; Default Tax Data USA &gt; Default Tax Data Report</td>
<td>RUNCTL_FRMTHRU_PAY</td>
</tr>
<tr>
<td>Report ID and Report Name</td>
<td>Description</td>
<td>Navigation</td>
<td>Run Control Page</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>TAX016CN</td>
<td>(CAN) Provides the data that is auto-generated by the system, such as the employee's hire date, default net claim amount from the Canadian Tax Tables, and province. This report also includes the provincial tax credit amounts from the Canadian Income Tax Data record.</td>
<td>Payroll Interface &gt; Reports &gt; Default Tax Data CAN &gt; Default Tax Data Report</td>
<td>RUNCTL_FRMTHRU_PAY</td>
</tr>
<tr>
<td>TAX019</td>
<td>(USA) Provides an individual listing of the employee's tax withholding information.</td>
<td>Payroll Interface &gt; Reports &gt; Employee Tax Information USA &gt; Employee Tax Information Report</td>
<td>RUNCTL_TAX019</td>
</tr>
<tr>
<td>TAX019</td>
<td>(CAN) Provides an individual listing of the employee's tax withholding information.</td>
<td>Payroll Interface &gt; Reports &gt; Employee Tax Information CAN &gt; Employee Tax Information Report</td>
<td>RUNCTL_TAX019</td>
</tr>
<tr>
<td>TAX100</td>
<td>(USA) Lists all employees in each company who are exempt from federal income tax withholding.</td>
<td>Payroll Interface &gt; Reports &gt; W-4 Exemption &gt; W-4 Exemptions Report</td>
<td>RUNCTL_TAX100</td>
</tr>
<tr>
<td>TAX100CN</td>
<td>(CAN) Lists all employees whose Canadian or Quebec Tax Data records indicate that they are exempt from income tax withholding, are exempt from unemployment insurance payments, or have fewer than 12 months subject to Canada or Quebec pension plan contributions.</td>
<td>Payroll Interface &gt; Reports &gt; Exemption CAN &gt; Exemption Report</td>
<td>RUNCTL_TAX100CN</td>
</tr>
<tr>
<td>TAX103</td>
<td>(USA) Identifies employees who have not yet filed a new Form W-4 by the due date to continue their exemption status, and inserts a new Tax Record to reset the special withholding tax status and tax status of each of those employees. The report also updates future-dated records that currently specify exempt status.</td>
<td>Payroll Interface &gt; Reports &gt; Reset W-4 Exempt List &gt; Reset W-4 Exempt List</td>
<td>RUNCTL_TAX103</td>
</tr>
<tr>
<td>TAX107</td>
<td>(USA) Lists all employees who either created or updated their W4 information on the web.</td>
<td>Payroll Interface &gt; Reports &gt; W-4 Audit &gt; W-4 Audit Report</td>
<td>RUNCTL_TAX107</td>
</tr>
</tbody>
</table>
## Payroll Reports

This table lists and describes the payroll reports that are included in PeopleSoft Payroll Interface, listed alphanumerically.

<table>
<thead>
<tr>
<th>Report ID and Report Name</th>
<th>Description</th>
<th>Navigation</th>
<th>Run Control Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAY703</td>
<td>General Ded/Frequency Report (general deduction/frequency report)</td>
<td>Lists information from the General Deduction/Deduction Frequency Table, which contains payroll deductions that do not fit into a category covered by a benefit table, such as United Way, union dues, or parking fees.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; General Deduction/Frequency &gt; General Ded/Frequency Report</td>
</tr>
<tr>
<td>PAY704</td>
<td>Deduction/Frequency Report</td>
<td>Lists information from the Deduction/Deduction Frequency Table, which contains deduction priority, tax effect, and frequency for benefit deductions and general deductions.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Deduction/Frequency &gt; Deduction/Frequency Report</td>
</tr>
<tr>
<td>PAY705A/B</td>
<td>Deduction Class Report</td>
<td>Lists deduction classification codes from the Deduction Table.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Deduction Class &gt; Deduction Class Report</td>
</tr>
<tr>
<td>PAY708</td>
<td>Shift Report</td>
<td>Lists information from the Shift table, where you identify the work shifts to which you can assign an employee. Because it contains the rate or factor that the system uses to calculate the shift differential, this table works with the Earnings and Special Accumulator Tables to calculate earnings.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Shift Table &gt; Shift Report</td>
</tr>
<tr>
<td>PAY711</td>
<td>Pay Group Report</td>
<td>Lists pay groups, effective dates, and processing characteristics from the Pay Group Table.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Pay Group Table &gt; Pay Group Report</td>
</tr>
<tr>
<td>PAY712A/B/C</td>
<td>Earnings Report</td>
<td>Lists earnings types and their payroll characteristics.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Earnings Table &gt; Earnings Report</td>
</tr>
<tr>
<td>Report ID and Report Name</td>
<td>Description</td>
<td>Navigation</td>
<td>Run Control Page</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------</td>
<td>------------</td>
<td>------------------</td>
</tr>
<tr>
<td>PAY714 Pay Calendar Report</td>
<td>Lists information from the Pay Calendar Table, which contains the cycles that you create for payroll processing by pay group. Each entry in the table corresponds to a pay period for a pay group.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Pay Calendar &gt; Pay Calendar Report</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PAY717 Earnings Program Report</td>
<td>Lists information from the Earnings Program Table.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Earnings Program &gt; Earnings Program Report</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>TAX702 Federal/State Tax Report</td>
<td>(USA) Prints information from the State Tax Table and the State Other Tax Table, which store the most current tax rates and other parameters that are used in calculating state and federal withholding, disability, and unemployment taxes.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Federal/State Tax &gt; Federal/State Tax Report</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>TAX703 Local Tax Report</td>
<td>(USA) Lists information from the Local Tax Table, which contains calculations for local income taxes.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Local Tax &gt; Local Tax Report</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>TAX705 Company Local Tax Report</td>
<td>(USA) Lists information from the Company Local Tax Table, which identifies the localities for which your company collects and pays taxes.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; Agency Local Tax USF &gt; Company Local Tax Report</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>TAX707 State Tax Rate Report</td>
<td>(USA) Lists information from the State Tax Rate Table, which contains bracket rates that are needed for calculating state and federal taxes.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Payroll Reports &gt; State Tax Rate &gt; State Tax Rate Report</td>
<td>PRCSRUNCNTL</td>
</tr>
</tbody>
</table>

**Interface Definition Reports**

This table lists and describes the interface definition reports that are included in PeopleSoft Payroll Interface, listed alphanumerically.
<table>
<thead>
<tr>
<th>Report ID and Report Name</th>
<th>Description</th>
<th>Navigation</th>
<th>Run Control Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI701 System Table Listing</td>
<td>Shows each system ID, its description, and its effective date, along with other data on the System Interface Table.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; System Table Listing &gt; System Table Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI702 PS Record Listing</td>
<td>Lists PeopleSoft tables and views that you can use in PeopleSoft Payroll Interface.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; PS Record Listing &gt; PS Record Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI703 PS Record-Field Listing</td>
<td>Lists each field on the PeopleSoft tables and views that you can use in PeopleSoft Payroll Interface.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; PS Record-Field Listing &gt; PS Record-Field Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI704 Field Listing</td>
<td>Shows fields that are defined for the third-party payroll system and how PeopleSoft fields are mapped to them for both import and export processing.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Field Listing &gt; Field Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI705 Field-Translation Listing</td>
<td>For each defined system ID, lists the third-party payroll system's fields along with the PeopleSoft source fields. Also lists translate values.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Field-Translation Listing &gt; Field-Translation Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI706 Instance Listing</td>
<td>Displays each instance of a PeopleSoft record to be exported to the third-party payroll system.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Instance Listing &gt; Instance Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI707 Process Listing</td>
<td>Displays descriptions for each defined COBOL process that filters data before creating the export file.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Process Listing &gt; Process Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI708 Process Values</td>
<td>Displays values that are returned from a special COBOL process. These values are used in the field translation process.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Process Values &gt; Process Values</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td><strong>Report ID and Report Name</strong></td>
<td><strong>Description</strong></td>
<td><strong>Navigation</strong></td>
<td><strong>Run Control Page</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------</td>
<td>---------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>PI709 Definition Table-File</td>
<td>Lists each file that is used in PeopleSoft Payroll Interface.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Definition Table-File &gt; Definition Table-File</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI710 Definition Table-Record</td>
<td>Lists the layout of each record that is used to format import and export files.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Definition Table-Record &gt; Definition Table-Record</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI711 Definition Table-Field</td>
<td>Lists the layout and content of each field for every record on each file that is used in PeopleSoft Payroll Interface.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Definition Table-Field &gt; Definition Table-Field</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI712 Configuration Listing</td>
<td>Displays processing groups, file names, and descriptions that are needed for the third-party payroll system.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Configuration Listing &gt; Configuration Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI713 Group Listing</td>
<td>Lists group IDs that represent fields to be processed together in the export file.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Group Listing &gt; Group Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI714 Employee Listing</td>
<td>Where they differ, lists each PeopleSoft employee ID along with the third-party payroll system's employee ID.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; Employee Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
<tr>
<td>PI715 File Handle Listing</td>
<td>Displays each file handle, file name, and description.</td>
<td>Set Up HCM &gt; Product Related &gt; Payroll Interface &gt; Interface Definition Reports &gt; File Handle Listing &gt; File Handle Listing</td>
<td>PRCSRUNCNTL</td>
</tr>
</tbody>
</table>